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About this manual

About this manual

This manual complies to SBP 27 software version 1.7.1.

The purpose of this operator manual is to describe how to use the SBP 27 Sub-bottom
Profiler system in a safe and efficient manner.

WARNING

Keep in mind that the SBP 27 generates signals in the audible range.
At maximum power, the SBP 27 has a very high source level. Out of
consideration to human beings (divers) and animals living in the sea,
we recommend to gradually increase the source power.

Never start pinging in dry dock!
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SBP 27

Topics
• System overview on page 10
• System description on page 12
• System diagram on page 15

System overview

Introduction
The SBP 27 is the upgraded version of the SBP 120 and SBP 300 which has been
upgraded by exchanging the transceiver unit and the TX/RX junction box.

The SBP 27 Sub-bottom profiler is an optional extension to the highly acclaimed EM
122/302 Multibeam echo sounder. The receive transducer hydrophone array used by the
EM 122/302 is wideband, and by adding a separate low frequency transmit transducer
and appurtenant electronic cabinets and operator stations, the EM 122/302 can be
extended to include the sub-bottom profiling capability provided by the SBP 27.

Refer to System diagram on page 15

Note

The SBP 27 can be used in combination with different multibeam echo sounder systems,
EM 122/302. This implies that the SBP 27 can be interfaced to different receiver
electronics and receiver arrays.
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Purpose
The primary application of the SBP 27 is to do imaging of sediment layers and buried
objects. Image quality is influenced by:
• The spatial resolution of the system; its ability to distinguish objects separated in

angle and/or range. The spatial resolution is given by two separate system properties:
1 The angular resolution given by the array geometry and dimensions.
2 The range/time resolution given by the signal bandwidth.

• The ping rate relative vessel speed. Dense probing alongtrack makes it easier to
identify weak layers in sediments with high volume reverberation.

• The angle of incidence of the transmit beam. The echoes received are essentially
caused by specular reflections at interfaces between layers of different acoustic
impedance. These specular echoes are only strong close to normal incidence.

Key specifications
The SBP 27 has significantly reduced beam widths compared to conventional sub-bottom
profilers. This is obtained by one linear transmitter array mounted along the vessel keel,
and one linear hydrophone array (shared with the EM 122/302) mounted orthogonal to
the keel. The footprint of the transmitter array is wide acrosstrack and narrow alongtrack,
whereas the opposite is the case for the receiver array. The combined beam pattern of
the two arrays is a narrow beam.
Some of the consequences of using large arrays are:
• The larger the transmitter array, the more power can be injected (without risking

cavitation). This implies an increased source level.
• The directivity of the transmitter also increases with the size of the transmitter, which

implies a further increase of the source level.
• The reverberation volume is greatly reduced with reduced beam widths. (The

reverberation volume roughly increases with the square of the beamwidth.)
• The increased directivity of the SBP 27 receiver array compared to smaller receivers

improves the suppression of acoustic noise.
Because the transmit beam is wide acrosstrack and all hydrophones are sampled
individually, the SBP 27 can make a fan of narrow beams acrosstrack per ping. This
multibeam capability of the SBP 27 is useful for:
• Finding the specular return(s) in rough terrain in spite of the narrow beams.
• Resolving lateral specular returns in rough terrain
• Detecting buried objects
• Obtaining information about the sloping angle of sediments (which sometimes

changes with range and may be completely different from that of the sea floor)
The normal transmit waveform is a linear chirp. The outer limits for the start and stop
frequencies of the chirp are 2 to 9 kHz, providing a maximum vertical resolution of
approximately 0.2 milliseconds. In addition to linear chirps, the transmitter offers CW
pulses, hyperbolic chirps and Ricker pulses. The transmit array of the SBP 27 is offered
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in three, six or twelve degree versions. The frequency dependent source level of a three
degree transmitter is typically above 220 dB re 1 µPa @ 1 m. The peak electrical power
consumption is less than 10 kW for the largest system.
Normally the SBP 27 transmit antenna is matched with a receive antenna of similar
physical size, but it is possible to combine any SBP 27 transmit antenna with any
EM EM 122/302 receive antenna. Various combinations of EM 122/302 and SBP 27
antennas are given in EM 122/302 and SBP 27 on page 13.

Beam stabilisation
The beams are electronically stabilized for roll and pitch. They can also be steered to take
into account bottom slope, and the generation of several athwartship beams is possible.

Ping rate
In the transmit mode “normal”, the SBP 27 pings once and then waits to collect the
return signal. Maximum ping rate is 20 Hz. In the transmit mode “burst”, the system
allows a number of pulses to be launched into the water before the first return signal.
In the “unsynchronized burst” mode the system is set to ping at a constant rate: The
transmit and receive periods are interlaced so that a high constant ping rate can be
maintained even in deep waters.
The SBP 27 can be synchronized to the EM 122/302 or other external equipment by
selecting external trigger. During synchronized operation the rule is that the SBP 27
can only ping while waiting for the first bottom return. In transmit mode “burst”, this
means we will achieve a piecewise dense sampling of the bottom which sometimes
can be very useful.

Data logging and real-time processing
The data produced by the SBP 27 are logged in the Topas raw format or in a SEG Y
format allowing post-processing by some seismic processing software.

System description

Main units
The SBP 27 Sub-bottom Profiler consists of these main units:
• TX Transducer Array
• TX/RX Junction Box
• Transceiver Unit
• Operator Station
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• Ethernet switch
• Remote Control Unit (K-Rem)

Transducer arrays
The SBP 27 transmit transducer has a physical width of 80 cm, a depth of 35 cm and
a length depending on the requested beamwidth. The 3º, 6º, and 12º SBP 27 transmit
arrays are 7.5, 3.8 and 1.9 meters long, respectively.

The transmit array is mounted in parallel with the vessel’s keel, normally side by side
with the multibeam echo sounder’s transmit array. For a “best performance” SBP 27
system one should always select a three degree transmitter, but normally it will be
inconvenient to have an SBP transmitter much longer than the EM transmitter.

The lengths of the 0.5º, 1º and 2º EM 122 transmitter are 15.2, 7.8 and 4 meters,
respectively.

The lengths of the 0.5º, 1º and 2º EM 302 transmitter are 6.0, 3.0 and 1.5 meters,
respectively.

The rows of the following table show what is expected to be the most common
combinations of EM 122/302 and SBP 27 system sizes. Since the two systems share
receiver array there is a fixed relation between RX opening angles. In the table are listed
combinations of “best match” for the lengths of the EM and SBP transmitters .

Table 1 EM 122/302 and SBP 27

EM SBP 27
TX x RX TX x RX
0.5º x 1º 3º x 3º

1º x 1º 3º x 3º

1º x 2º 3º x 6º

2º x 2º 6º x 6º
EM 122

2º x 4º 6º x 12º

0.5º x 1º 3º x 7º

1º x 1º 6º x 7º

1º x 2º 6º x 14º
EM 302

2º x 2º 12º x 14º

Cabinets and Operator Station
The transmitter and receiver electronic circuitry required for the SBP 27 Sub-bottom
profiler is housed in a separate cabinet. The EM 122/302 Preamplifier Unit contains
preamplifiers for the common receiver array and frequency splitting circuitry. The
operator interface and display system is implemented on a dedicated Operator Station.
The system drawing shows the relation between EM 122/302 and SBP 27
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The Operator Station is a work station whose shape and dimensions will depend upon
the actual model delivered. It will usually consist of a rack mountable chassis, an LCD
monitor, a mouse and a keyboard. Additional peripherals may be included.

The Remote Control Unit is called K-Rem. It is prepared for remote control and
interface to an external synchronization system for four Kongsberg echo sounders:
• One Sub-bottom profiler (SBP)
• Two EM multibeam echo sounders
• One EA single beam echo sounder

It has been designed to provide remote on/off switches with light indication and interface
to a remote synchronizing system. K-Rem contains a terminal block and four switches
with lamps mounted in the front.
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System diagram
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Operational procedures

This chapter presents the most important operational procedures required to operate
the SBP 27 Sub-bottom Profiler.

Tip

When your system is satisfactory configured, make a copy of the configuration files for
easy reload in case of troubleshooting. It is recommended to store at least one good
configuration file and make this read-only.

Topics
• Operational modes on page 17
• Operational principles on page 17
• How to start the SBP 27 on page 19
• Preparing the system for use on page 22
• Check/configure the real-time processing on page 26
• Check/configure display properties on page 28
• Check the external inputs on page 32
• Check the basic operation on page 33
• How to run the survey on page 34
• How to shutdown the SBP 27 on page 34
• Logging data on page 35
• Configuration files on page 36
• How to install the software updates on page 37
• Processing chain on page 37
• Built-In system tests (BIST) on page 39
• File conversion on page 47

16 442094/B



Operational procedures

Operational modes
The SBP 27 is operated in survey, replay, slave, or convert mode.

Survey mode

The survey mode is used during the survey. The application is used to control the SBP 27
Sub-bottom Profiler, to store the beams, and to present the data.

Replay mode

The replay mode is used after the survey has been completed, and the data has been
stored on disk. The replay mode is used for processing and presentation of stored data.
Data acquisition cannot take place during replay operation. In this mode it is possible to
adjust the replay speed so hardcopy devices are able to handle the processed data stream.

Slave mode

In slave mode the application can subscribe to the beams from a master system operating
in survey or replay mode. This is the way to obtain a helmsman display.

Convert mode

The convert mode is used for conversion of a single file or a directory of files from the
raw format to the SEG Y format or vice versa. In this mode it is also possible to extract a
new file with a single beam from a file with many beams.

Operational principles
Start-up parameters

Start-up parameters must be given depending on type of operation and water depth.

You may start by loading a predefined set of parameters stored in a configuration file.
While pinging, you can adjust parameters and observe the effect of the adjustments
on the displayed data. A new set of parameters can be stored in a configuration file
for later retrieval.

System interaction

All interactions with the SBP 27 Sub-bottom Profiler system take place via a windows
based program on the Operator Station. Before operation of the system starts, it is
assumed that all units are powered on.

For information about switching power on, refer to How to start the SBP 27 on page 19

Navigating in the menus and sub-menus is done by using the mouse. The keyboard is
used for entering numerical and character strings into the parameter fields.
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Application window

The SBP 27 application window is divided into several areas and menus - parts - that
show different type of information. You may show or hide some of these parts as desired.

Figure 1 Application window

Brief descriptions of the various areas and menus are given as follows:

• Title and info bar on page 62

• Property area on page 67

• Tool bar on page 62

• Echogram area 1, 2 & 3 on page 63

• Legend area 1, 2 & 3 on page 70

• Single trace area on page 71

• Ping number and file length on page 72

• Status area on page 72
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Survey mode procedures
To start the SBP 27 system, follow this procedure:
1 Power up the SBP 27 system, log in to the operator station and start the operator

software.
See How to start the SBP 27 on page 19

2 Run the system tests
See System Tests (Built-In System Tests) on page 22

3 Optionally: Load configuration file
See Load a configuration file on page 22

4 Check the installation parameters
See Check the installation parameters on page 23

5 Check/set the runtime parameters
See Check/set runtime parameters on page 23

6 Check/set the real-time processing
See Check/configure the real-time processing on page 26

7 Check/configure display properties
See Check/configure display properties on page 28

8 Check the external inputs
See Check the external inputs on page 32

9 Start pinging
See How to start the echo sounder (Start pinging) on page 33

10 Check the local depth and the main echo sounder functions
See Check the basic operation on page 34

11 Enter the survey parameters
See Run the survey on page 34

12 Move the vessel to the start of the first survey line
13 Start logging

See Logging data on page 35
14 Run the survey
15 Stop logging
16 Power down the SBP 27

See How to shutdown the SBP 27 on page 34

How to start the SBP 27
How to power up the SBP 27
1 Power up the SBP 27 Operator Station
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2 Initialize and log on to the SBP 27 software:

When the boot process of the operator station is finished, you must log on to the
operator station. In the default configuration, Online Monitor and the beamformer
application will be started automatically when you log into the computer.

Note

Shortcuts to the Online Monitor and the beamformer application are located in the
startup folder, causing these applications to start by default when the computer
is powered. If any of these programs are shut down, they can be restarted using
shortcuts on the desktop.

a If not already running, start the Online Monitor which can be accessed by an
icon on the Operator Station’s desktop
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b Open the KM SBP OPU program from the desktop icon.

3 Power up the SBP 27 Transceiver Unit
4 For older installations with a dedicated Beamformer Unit, power this up
5 Power up the any peripherals devices to be interfaced to the SBP 27

Consult the applicable manufacturer’s documentation for instructions.

User access level
There are three user levels of the SBP 27:
• User
• Root
• Super
You are automatically logged on as user User. After installation is completed included
successful interfacing to ship/sensor networks it should normally not be necessary to
enter a higher user level.
In the LogOn menu you can also log on as Root with the authority for instance to inspect
the configuration of the NMEA readers, to modify the behaviour of the pop-up windows
(System messages, Survey Warnings), and to add or remove items from the processing
chain. The Root user is password protected. The Root password is: root
An even higher level of accessibility becomes visible in the LogOnmenu when logged on
as Root. This is the Super user. When logged on as Super parameters that are normally
only entered during the installation process can be changed and stored to a configuration
file. Some of the menus et cetera appearing at this user level are not documented; they
are for use by Kongsberg Maritime only. When logged on as Super the File menu is
extended to include “Save/load installation. The Super user is password protected. The
Super password is: super.
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WARNING

Do not enter user mode Super unless there is a good reason to so.
Remember to leave Super mode when reconfiguration of the system
setup is completed and the changes are saved to the configuration
file.

System Tests (Built-In System Tests)
It is recommend that you routinely run the system tests located in the Built-in system tests
folder to verify that the system has started successfully.

1 Check that all units reply to the SW
versions request

2 Check that attitude is received by the
MRU Test, and that there is no loss
of attitude (the number of attitude
messages received per second is
displayed)

3 Check that the High Voltage Power
Test is successful

4 Check that the outcome of the
SIHD8 card test is All units OK

5 Check that the receiver noise levels
are acceptable in the Receiver Noise
Test.
If the noise level is extremely low
(<< 40 dB re 1 μPa), verify that the

EM preamplifier is switched on
Note

The EM 122/302 Preamplifier Unit power supply is not controlled by the remote
switch controlling the EM 122/302 Transceiver Unit. The EM 122/302 Preamplifer
Unit should always be switched on.

More information is found in Built-In system tests (BIST) on page 39.

Preparing the system for use
Load a configuration file
When started, the system will load the installation parameters stored in SBPInstall.xml
and the system configuration stored in SBPConfig.xml; both files are read from the
working directory of the software. You may wish to load a predefined configuration file
suitable for the planned operation. For more details, see Configuration files on page 36.
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Note

Check that the system is in survey mode.

Check the installation parameters
The installation parameters are:
• For EM receiver type specify the EM the SBP is integrated to.
• installation angles and positions of arrays, motion reference unit and GPS antenna

relative to the ship's coordinate system
• the water level relative to the ship's point of reference
• the number of transmitter and receiver channels
The installation parameters must not be tampered with. If they have been changed e.g.
for experimental purposes, or in case the configuration file is damaged, it is necessary to
restore the correct parameters. The easiest method is to load a configuration file with
the correct set of parameters. Alternatively, the installation parameters must be entered
manually, which can only be done if logged in as Super user.
If a backup of the valid SBPInstall.xml has been stored in a safe place as recommended,
the easiest way to restore the correct parameters is to log on as user Super, choose
File/Load installation and select this backup file. Next choose File/Save installation and
store the loaded parameters as SBPInstall.xml in the working directory which is the
default location when Save installation is selected.

Check/set runtime parameters
Check that the runtime parameters are set as expected from the selected configuration
file. The table Suggested Runtime parameters on page 23 contains a suggestion for how
to initialize the runtime parameters for a standard survey.

Note

The number of runtime parameters is large. In order to minimize the list, only the
parameters relevant to the current settings are displayed.

Table 2 Suggested Runtime parameters

Runtime parameters Symbol Value Unit Note

Transmit mode - Normal - -

Transmit cycle mode - - none -

Synchronization - Fixed rate - 13)

Ping interval PIV 500 ms 1)

Acquisition delay AWS - ms 2)

Acquisition window AWL 200 ms 3)

Pulse form - Linear chirp
up

- 4)

Sweep low frequency FL 2500 Hz 5)
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Table 2 Suggested Runtime parameters (cont'd.)

Runtime parameters Symbol Value Unit Note

Sweep high frequency FH 6500 Hz 5)

Minimum pulse shape Checked - 12)

Pulse shape - N/A %

Pulse length T 5 ms 15)

Source power - - dB 6)

Power ramping rate - - dB/min 7)

Beam widths TX - Full array - 14)

Beam widths RX - Full array - 14)

Number of RX beams - 3 - 8)

Beam spacing - 3 deg 8)

Acquire water column data - - unchecked -

Calculate delay from depth - - checked 9)

Delay hysteresis - 5 % 11)

Bottom screen pos. - 30 % -

Automatic slope
corrections

- off - 10)

Notes
1 The system may find that only a larger ping interval is possible (in which case this

larger ping interval will automatically be used)
2 Either:

• Specify the delay manually,
or

• Enable Calculate delay from depth (check box in the runtime parameter sheet)
and have the delay automatically calculated using:
a external depth D input to an NMEA reader

or
b depth D entered manually
Select between the two sources of depth in the depth selector (located in
System/Data selectors)

3 At startup: If the uncertainty is high regarding the actual depth D used to initiate
the AWS, use a large AWL until bottom is detected. In an area with no or little
penetration you may want to reduce the AWL in order to save disk space. In very
rough terrain it may be necessary to increase the AWL in order to acquire the
interesting signals.

4 A chirp with bandwidth B and duration T>> 1
B is a standard pulse used for

sediment profiling. Maximum bandwidth B ≈ FH − FL ensures maximum range
resolution, and the long pulse length T>> 1

B improves signal-to-noise ratio by
10 log 10 (BT ) dB compared to short pulses of duration T and bandwidth B ≈ 1

T .
As an example, B=4 kHz and T=40ms gives an increase in SNR of 22 dB.
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5 For best range resolution, choose the minimum and maximum allowed frequencies.
The actual allowed sweep range can vary for different SBP 27 installation.

6 The dB unit is relative maximum power. Entering 0 dB means maximum power, -3
dB means half power.

7 For mammal protection you may increase the source power from lowest level (-30
dB) up to selected source power by a number of dB per minute.
If pinging is stopped for more than two minutes the source power will go back to
minimum power level. When pinging resumes, the source power will increase by
the set power ramping rate until desired source power is reached.
When set to 0 the power ramping is disabled.

8 A higher number of beams can be used, but it may be desirable to keep the amount
of data collected at a moderate level. A high number of beams may also limit the
ping rate. The choice of three beams will provide qualitative information about the
across track sloping angle of the sediments (it can change through the sediments).
Using more than one beam will also be an advantage either on a rough bottom or if
the across track slope is unreliable/unknown because one is more likely to obtain
normal incidence to the sea floor in one of the beams.
The beam spacing can be set equal to beam width of the RX beams as this will ensure
some overlap. The nominal beam width of the SBP 27 systems is defined at 4 kHz,
but the beam width is frequency dependent and decreases with increasing frequency.
For example at 6 kHz the beam width is decreased by 4/6, so the beam width of a 3
degree antenna - which is defined at 4 kHz - is only 2 degrees at 6 kHz. Accordingly
the beam spacing should be 2 degrees to ensure good overlap between the beams at
the 6 kHz frequency. When half array is used, the beam spacing may be doubled.

9 This check box is checked to give an automatic calculation and adjustment of the
acquisition delay. If a reliable external depth is not available this feature must be
disabled until the internal bottom tracker is found to track bottom.

Note

Make sure that the internal bottom tracker is enabled. See information about the
processing chain.
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10 Automatic slope correction may be used if the SBP 27 receives bottom slope
estimates from an EM echo sounder. The bottom slope information is part of the
SRV datagram.
The slope estimates are good only if the seafloor topography varies slowly. In that
case the “quality factor” accompanying the slope estimates will be less than 0.2. It is
not recommended to use bottom slope correction unless the behaviour of the system
is monitored closely. To aid the operator a slope quality threshold can be set in the
NMEA readers to discard the slope information when this threshold is exceeded.
Note that even if the bottom slope correction works as intended and the center beam
is steered perpendicular to the sea floor, imaging of sediments may be unsuccessful.
Only when the sediment interfaces are close to parallel to the sea floor this feature
may be useful.
For details about the SRV datagram, see Depth – bottom – slope and sound velocity
data on page 196.

11 The delay hysteresis must be less than the “bottom screen position” in order to keep
the bottom within the acquisition window.

12 When Minimize pulse shape is enabled, the value of Pulse shape (the percentage of
the pulse length used for rise and fall time) is automatically adjusted to the minimum
value permitted by the electronics for the given pulse length.

13 If the system is run synchronised (EM trigger or External trigger), we recommend
checking the Reduce EM<>SBP crosstalk tick box that appears when EM or External
trigger is selected.

14 The beam widths should be adapted to the water depth to avoid strong near field
effects. Suggested thresholds:
• 3 degree antenna:

– Depth > 120 meters: Full array
– Depth 30-120 meters: Half array
– Depth < 30 meters: Quarter array

• 6 degree antenna:
– Depths > 30 meters: Full array
– Depths < 30 meters:: Half array

The option to cycle TX beam width should be useful to compare the results with the
different beam widths, see Transmit cycle modes on page 164.

15 Typical pulse lengths may be in the range of 20-40 milliseconds, but in shallow
water the pulse length must be reduced to allow transmission to complete before the
first bottom return. If acquisition delay is too large to collect the bottom return and
it cannot be reduced, it may be because the pulse length is too long.

Check/configure the real-time processing
The real-time processing and post-processing available in SBP 27 is located under the
Processing tab in the property area.
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Note

The processing will be carried out in order specified by the Processing chain.

The real-time processing does not directly affect the data logged by the raw data logger
because the data are stored before any processing is applied. Nevertheless the processing
is important because the output, displayed in the echogram area(s), is what tells the
operator if good data is acquired and if adjustments of runtime parameters need to be
done.

The list of objects in the processing chain contains more items than normally used during
standard operation.

The following table suggests suitable settings for an ordinary survey. Objects not listed
herein is recommended disabled, while those listed should be enabled. Enabled objects
are displayed in black in the processing chain, while disabled objects are dimmed (gray).

Note

The sequence is important, except for the data plotters. The data plotters do not affect the
final image. Their only purpose is to visualise the signal at various steps of the processing
chain. Thus they can freely be moved up and down in the processing chain. Disabling
both will cause the single trace area to be blank which may cause some confusion.

Table 3 Suggested processing chain (disabled items are not shown)

Processing chain Setting Note

Gain correction - 1)

Gain - 2)

Filters Matched (for chirp pulses) Select ”Auto” for corner frequencies 3)

Data plotter 1 Enable 4)

Attribute processing Instantaneous amplitude 5)

Bottom Tracker Internal tracker control 6)

Automatic gain control - or TVG

Data plotter 2 Enable 8)
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Notes
1 The gain correction compensates for spherical loss as the signal propagates. In

addition to this time variable gain, the object also corrects for change in the source
level due to changes in transmit power and/or transmit beam width.

2 Enable gain to add a fixed amount of gain to the data if necessary. Specify manually
a positive (or negative) gain value whenever the signal appears weak (or saturated)
in the echogram areas.

3 Chirp pulses require matched filter in order to get maximum resolution and an
increase in SNR by 10log10BT. For CW-pulses and Ricker: Apply bandpass filtering.

4 In this position, Data plotter 1 plots the signal after applied gain and matched filter.
5 Calculates the envelope of the signal.
6 Attempts to detect bottom. Check visually that it tracks the right echo.
7 This TVG is intended for application to sub-bottom echoes. Consequently, in TVG

mode ”Auto” the start of the TVG locks to the bottom tracker. The gain [dB/ms]
is always set manually.

8 In this position, Data plotter 2 plots the signal at the end of the processing chain.

Check/configure display properties
For each available display area a number of parameters must be set. Applicable
parameter sheets becomes available when display area is selected from the Display list.

The available displays are:
• Echogram 1
• Echogram 2
• Echogram 3
• Single trace
• Legend 1
• Legend 2
• Legend 3
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Note

In the Single trace area, the last beam received is displayed. Data plotter 1 and data
plotter 2 in the processing chain determine what will be shown. The grid is determined
by the depth tic spacing which is set from display→display list→single trace.

Note

In the echogram areas, the output from the processing chain is shown. The layout of an
echogram image is determined by its echogram and legend parameters available in the
display property sheet.

The following suggestions are intended as guidelines for inexperienced users. Potential
pitfalls are marked with Warning

Displaying an alongtrack profile in Echogram 1

Note

Any of the Echograms can be used for this purpose.

Table 4 Suggested settings for echogram image (Echogram 1)

Echogram image (Echogram 1)

Recommended setting Note

Copy screen - 10)

Trace width 1 1)

Checkbox ”Adjust range to last acquisition
window”

Check this box 2)

Enable event lines Uncheck this box 11)

Checkbox ”Grid enabled” Check this box 3)

Grid depth unit ms 4)

Ping tick spacing for example 100 5)

Depth tick spacing for example 10 6)

Show selected RX beam only Check this box -

Selected RX beam number 0 7)

Show selected TX beam only Check this box 9)

Selected TX beam number Check this box 9)

Checkbox “Bottom lock” Uncheck this box 8)

“3D” enabled Uncheck this box

Notes
1 This determines width of each beam displayed in the echogram image.
2 May be unchecked in order to display terrain with high dynamics.
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Note

If this feature is turned off, the min and max depth to be entered manually, determine
which part of incoming data to be displayed. If the incoming data are completely
outside the limits given by these depth parameters, nothing will be displayed!

3 Most users will prefer to have a grid in the echogram area.
4 Selecting meters (m) cause the range axis to be scaled using the sound velocity

in the water column. This will position bottom accurately if the sound velocity
is accurate. However, regarding penetration depth and the thickness of sediment
layers, the meter axis will only give an estimate. Usually, this will give a lower
estimate because the velocity of sound is normally higher sub-bottom than in the
water column.

5 The vertical grid lines are drawn with this interval.
6 Choice dependent upon the length of the acquisition window (and the level of zoom).
7 Select 0 (zero) to view the centre beam. Step up and down to view the along track

echogram as seen by other beams. Positive beam numbers are to the port side of
the ship.
If a non-existent RX beam number is asked for, the nearest available beam will
be displayed.

8 May be used to align all bottom echoes at a constant range position in the echogram
area. Requires that the bottom tracker is locked on the seafloor echo.

9 No effect unless system is operated in one of the Transmit cycle modes. If a
non-existent TX beam number is asked for, the nearest available beam will be
displayed. Beam number is 0 if only one TX beam; and positive 1 to N if N TX
beams.

10 When Copy to file is selected a jpg file is printed to the KM SBP Images folder.
11 External event lines can be displayed in the echogram area if CODA navigation

strings are received.
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Configuration of Legend 1

Table 5 Suggested legend settings (Legend 1)

Colours (Legend 1)
- Recommended setting Note

View mode Normal -

Polarity +/- 1)

Scale Logarithmic -

Colour map Jet, Inverse greyscale,
Greyscale

2)

Background Black -

Foreground White -

Upper threshold [dB] 0

Lower threshold [dB] -40

Maximum value [dB] 0.0

Dynamic range [dB] 54.0

Scale unit dB

Notes
1 Warning: Selecting “-” means nothing will be displayed in logarithmic mode when

instantaneous amplitude is calculated.
2 Other choices are available.
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Displaying the acrosstrack swath in Echogram 2
Note

Note Any of the Echograms can be used for this purpose.

Echogram area 2 is enabled/disabled in the View drop-down menu, and it may be used to
display the same data as that of Echogram area 1 with different dynamic range, colour
map, dynamic range, level of zoom, and so on.
To show the two echogram areas side by side, select the Vertical split 1-2/3 in the View
drop-down menu. When the vertical split is unchecked the two echogram areas are
arranged one above the other.
Alternatively, you may configure Echogram area 2 to view the fan of receiver beams.
To have a single receiver fan displayed per ping check Acrosstrack view on the Echogram
2 parameter sheet.

Check the external inputs
Proper operation of the external sensors are vital for the SBP 27 operation.

Attitude
If you did not perform the MRU test as part of the system startup, do it now. See System
Tests (Built-In System Tests) on page 22.
While pinging, verify that attitude information is received on the Beam reader parameter
sheet or in the Status area.
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NMEA readers

Check that the required information is received by the NMEA readers. To see the
information received by an NMEA reader, highlight the reader you want to check
(located in System→Readers and writers→NMEA readers) and the information received
will be displayed in the lower part of the property area.

You should always receive position data through the NMEA readers.

For more information see NMEA readers on page 107.

SRV datagram

The SRV datagram is an NMEA like datagram available from the EM multibeam echo
sounder. The SRV datagram contains the external depth used by the SBP 27 software for
automatic adjustment of the acquisition window.

When the bottom is plane and sloping, the EM can estimate the local slope angles
and inform the SBP 27 through the SRV datagram, so that the beams can be directed
perpendicularly to the bottom, in order to get the best resolution and contrast for the
seabed and sediments parallel to the seabed.

The SRV datagram also contains the sound velocity.

We strongly recommend to read the SRV datagram from the EM sounder. Note that the
SRV datagram can only be received when the EM sounder is active.

For EMs working with SIS 3.7 and later versions the SRV datagram contains information
that is used by the SBP to reduce crosstalk between the two systems when the SBP is
run synchronized.

Note

Note that the model number of an EM providing SRV datagrams must be listed in the
SRV shallow/deep water priority strings found under the NMEA readers. For details
see NMEA readers on page 107

Check the basic operation
Make sure Survey mode is selected.

For more information about the available modes see Operational procedures on page 16.

How to start the echo sounder (Start pinging)

Press the Start button or select the desired transmit mode and push the Send button
located on the bottom of the Runtime parameters sheet.

For description of the Runtime parameters see Runtime parameters on page 131
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Check the basic operation
Before you start logging, you must make sure that the correct depth is provided externally,
alternatively that the internal bottom tracker of the SBP 27 has locked on to the bottom .

Important

The SBP 27 must be running in Transmit mode: Normal until the internal bottom tracker
has locked onto the bottom.

How to run the survey
Run the survey
For each survey line;
1 Enter Job name and Line

In order to start a new survey, the Job name and Line parameters must be given. This
is done in the Status window.

2 Move vessel to the beginning of the line
3 Start Logging

We recommend to always log raw data in the RAW format.
Caution
Be careful not to overwrite an existing file by accident. This happens if
you choose an existing filename.

4 Run the line
5 Stop logging at the end of the line.

How to shutdown the SBP 27
Software
Exit the SBP 27 by selecting the Exit from the File menu.

Hardware units

Operator Station
1 Locate the unit’s mains switch, and switch off.
2 Switch off all the peripherals.

Transceiver Unit
Switch the power off by using the remote On/Off button.
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Logging data
It is possible to log raw and processed data simultaneously in survey mode.

Depending on the settings of real-time processing and the position of the processed data
logger in the processing chain, processed data may become worthless. By logging the
raw beam data, no information is lost and the data can be post-processed to optimize
the result.

When you start logging, you have to specify the name of the log file or a directory in
which to store the data. We recommend logging to a directory: This minimizes the risk
of overwriting existing files because the file names are then automatically generated
based on date and time.

Raw data can be logged in either the RAW format or the SEG Y format. Data logged in
the RAW format contains information (heading, vessel speed and attitude) that is not
logged in the SEG Y format. We recommend logging in RAW format, and later convert
to SEG Y when needed, unless the extra information provided by the RAW format is
considered redundant or not interesting.

Refer to File conversion on page 47 for more information.

If the Processed data logger is at the top of the Processing chain, the data logged will
be truly raw beam data as is always the case for the Raw data logger. This means it is
possible to log raw beam data simultaneously in both RAW and SEG Y format.

For more information about the Processed data logger, see Processed data logger on
page 120.

Logging in survey mode

To start raw data logging in survey mode you can either use the red Raw data logger

button on the tool bar or the Raw data logger found on the System tab.

For more details, see Raw data logger on page 124.

To start logging of processed data in survey mode you can either use the green Processed

data logger button on the tool bar or the Processed data logger found on the
Processing tab.

For more details, see Processed data logger on page 120.

Logging in replay mode

When you want to log in replay mode, you can either use the green Log button on
the tool bar or the Processed data logger found on the Processing tab.

For more details, see Processed data logger on page 120.
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Configuration files
The SBP 27 is very flexible and contains many possibilities. Both in the setting
of runtime parameters, which affect the acoustic signal, and in the configuration of
the online processing and choice of data display, it is possible to ”get lost” for an
inexperienced operator. Almost all configurable parameters, including the installation
parameters and the setup of the network communication and the serial lines, are stored
in two configuration files. On startup, the system loads a pair of configuration files
located in the working directory of the program. The configuration files are described in
the following sections.

Installation parameters
All installation parameters are stored in the file SBPInstall.xlm. This file contains
installation parameters for array, motion sensor and antenna. It also contains the network
configuration (IP addresses, UDP ports) and setup of NMEA readers and Printers.

Once the SBP system is properly configured one will rarely make changes to the
installation parameters. When changes are to be made to the installation parameters, one
must be logged on as Root. When the software is shut down, you will not get the option
to save changes to SBPInstall.xml. Changes to the installation parameters must be
stored to file using File→Save Installation, and this menu choice is only available when
logged on as Super. For changes to have effect on next startup, changes must be saved to
SBPInstall.xml in the working directory of the program.

Note

We advice that you make a read-only copy of SBPInstall.xml and store it in the config
directory of the software installation.

Note

If changes have been made to any of the installation parameters, use File→Restart to
transmit the new installation parameters to the TRU and the receiver beamformer.

System configuration
Almost all parameters not defined as installation parameters are stored in the file
SBPConfig.xml. One exception is the runtime parameter power level; for safety reasons
this parameter always reverts to the minimum value when the system is restarted. When
the system is closed in a normal manner using File→Exit, you will get the question Save
current configuration to SBPConfig.xml file.

We strongly recommend to store away one or more ”good” configuration files. As
experience is gained, you may want to store away configuration files for various
situations. There may be different configuration files for different combinations of deep
or shallow water, rough or calm weather, externally triggered or internally triggered
transmissions, etc.
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Note

You are advised to write-protect some of the configuration files in order to avoid
accidental destruction of carefully designed configurations. This is done from the
Windows operator system of the operator unit.

How to install the software updates
Software updates will normally be distributed on CDs. Installation instructions will
accompany the software. Software updates in the transceiver unit must be carried out by
personnel from Kongsberg Maritime AS.

Processing chain
The real-time processing and post-processing available in SBP 27 is located under the
Processing tab in the property area.

A large number of standard and more specialized processing objects are located here in
a list. The sequence of the items in this list determines in which sequence the various
processing steps are applied to the signals.

The signal processing starts according to the top item of the list, and the processing
proceeds down the chain.

Any item can be Enabled/Disabled by checking/unchecking the Enabled checkbox.
When disabled the item in the Processing chain will be displayed in gray.

Using the Move up/down arrows located in each object, all items can be moved freely
up/down the processing chain.
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Note

This does not imply that enabled items can be positioned in any sequence without serious
consequences.

As an example: Calculating instantaneous amplitude (attribute processing) prior to
matched filtering is a very bad idea. The signal output at the end of the chain is the input
to the echogram areas.

Some of the objects in the processing chain may never or rarely be used. User Root is
given access to an Exclude checkbox. Checking this check box for an object in the
processing chain, will make the object invisible to the standard User.

For more details, see Processing chain on page 123.
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Built-In system tests (BIST)
In order to verify system operation, and as diagnostic tools in case of problems, a few
software tests are available. They are located in the Built-In System Test folder under
the property sheet System.
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Software versions

This test provides software version number and date for the major software components
in the system.

One exception is the operator unit software, whose version number is given in the About
box found under the Help menu. Another exception is the Online Monitor where version
number is found in the lower left corner of the main window.

In addition to providing the software versions, a successful test shows that all units are
switched on and that the main communication is established between all units.
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CPU Card Test

The CPU card test report temperatures, voltages, date/time, and software version.
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SIHD8 Card Test

This test reports board temperatures and voltages for the SIHD8 boards and also for
the SISP10 board.
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High Voltage Power Test

Temperatures and voltages of all installed high voltage power units are displayed.
• Sync shows if the switching frequency of a power unit is synchronized by the SISP10

board. The normal result is ON
• On shows whether or not a unit is active,. During a BIST test the normal result is OFF.
• SS refers to Safety Shutdown. The normal value is OFF. If this value is ON the high

voltage power will refuse to ping. Check the switches on front of the power units
if the result is ON.
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Receiver Noise Test

The rms voltage is a measure for all receiver channels within the frequency band from
2 kHz to 8 kHz. Time series of length 500 milliseconds are used. By correcting for
the directivity index and the sensitivity of the hydrophone, the analog gain prior to
analog-to-digital conversion, and the bandwidth, we find the noise level in the sea.

During the Factory Acceptance Test (FAT), where all inputs to the preamplifier unit are
shortened, this test is used to calculate the equivalent noise level of the systems self noise.

Note

If all noise figures are much lower than what has previously been observed, check that
the EM 122/302 preamplifier is turned on (which is the normal situation independent of
whether the EM transceiver is switched on or not). The values reported should all be
>40 dB re 1μPa @ 1m.

Note

If one channel repeatedly has a very high noise level compared to the others (tens of dB),
this indicates an error on that particular channel. Be aware that a single channel with
an extreme noise level may wipe out the good data provided by the other channels; it
important to remove a board with such a noisy channel.

If a spare board is not at hand, it may be better to run with a reduced number of channels
rather than running with a faulty board
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MRU (Motion Reference Unit) Test

This test reports the number of attitude messages received by the transceiver unit in one
second. The content of one of the attitude messages is displayed.

The test can be used to verify that attitude is received and read by the transceiver unit.
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System Report
The System Report test will provide information about current system.
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File conversion
Files can easily be converted from the RAW format to the SEG Y format from the SBP 27
operator unit. Using the file conversion utility you are allowed to easily:
• Convert a single file from one format to the other.
• Convert a directory of files of one format to a directory of files of the other format.
• Convert a directory of files of one format to a single file of the other format.
• Convert a single file of one format to a directory of files of the other format.
This utility also gives you the opportunity to:
• Merge a number of files into a single file.
• Create a number of smaller files from a single file.
• Extract a single receiver beam from a file containing a fan of receiver beams.
A Converter filter can be enabled to apply either bandpass, matched or spiking filtering to
the acquired data before they are converted to selected format.

How to convert a RAW data file
1 Choose Convert from the Mode drop-down menu on the Tool bar.
2

Configure the properties
of File writer located in
System→File converter.
• Always use selected

directory should be
unchecked

• If converting to SEG
Y, configure the SEG Y
parameters as desired

• Specify the maximum file
size

• Uncheck/check the Log
selected beam check boxes
If you check that check box
you must remember to set
which beam number you
want to extract

• If the input is multi-beam
data and one or both Log
selected beam checkboxes
are unchecked, decide if
the output should be one
beam per file or many

beams in a single file.
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Note

If conversion to SEG Y format is selected, the multi-beam data will always be
split into several files with one beam in each.

3 To initiate the file conversion process, press the >button of the Tool bar
4 Choose input file or directory
5 Choose output format and output file or directory

For more details refer to the File writer on page 93.
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Menu system

Topics
• Principles on page 50
• Main menu on page 51
• Tab menu on page 53
• Tool bar on page 62
• Title and info bar on page 62
• Echogram area 1, 2 & 3 on page 63
• Property area on page 67
• Legend area 1, 2 & 3 on page 70
• Single trace area on page 71
• Ping number and file length on page 72
• Status area on page 72
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Principles
The SBP 27 is organized in a set of windows appearing on the screen. The windows will
display a menu system, parameter settings and graphical display of the SBP 27 data. The
various parameters and views are set and presented through the menu system.

Figure 2 SBP 27 application window, example

A Main menu
B Tabs menu
C Properties
D Parameter sheet
E Status
F Echogram 1
G Legend 1
H Echogram 2
I Legend 2
J Single trace
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Main menu
The main menu bar on the top of the window provides access to a number of drop-down
menus.

Main menu
• File
• View
• LogOn
• Help

File menu
The File drop-down menu gives you the following choices

• Save Configuration – Save parameter configuration.
See Save configuration on page 136

• Load Configuration – Load a previously saved parameter configuration.
See Load configuration on page 102

• Restart – Reset the Transceiver Unit (TRU).
See Restart on page 129

• Exit – Closes all programs controlled by SBP 27.
See Exit on page 91

For user level Super you get the following additional choices

• Save Installation – In order to make changes to installation parameters permanent the
values have to be stored in a configuration file SBPInstall.xml located in the working
directory of the software.
See Configuration files on page 36.
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• Load Installation – If desirable an alternative configuration file, saved by save
installation to another location than the working directory, can be loaded into the
software without tampering with the default installation parameters. Remember to
select File→Restart after loading the file in order for the new parameters to take effect.

View menu
The View drop-down menu enables/disables the different view areas.

• Property area – Contains tabs and related parameter sheets.
See Property area on page 67

• Single trace area – Displays the trace data in “scope” mode.
See Single trace area on page 71

• Legend area 1, 2 & 3 – Displays a colour coded legend for the Echogram.
See Legend area 1, 2 & 3 on page 70

• Status area – Shows current parameters and status of the system during online
operation.
See Status area on page 72

• Echogram area 1, 2 & 3 – Displays the processed realtime or replay data. A second
Echogram area can be enabled for e.g. comparison purposes.
See Echogram area 1, 2 & 3 on page 63

• Vertical split – When enabled, and Echogram area 2 is enabled, the two Echogram
areas will be shown side by side. When disabled, and Echogram area 2 is enabled, the
two Echogram areas will be shown by a horizontal split.
See Vertical spilt on page 147

• System messages – Display a separate window with all system messages given.
See View system messages on page 149.

• Survey warnings – By default this window pops up whenever new information is
printed to it.
See View survey warnings on page 148.
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LogOn menu
The LogOn drop-down menu allows you to log on as a normal operational user, User, or
as an expert user, Root.

Note

Root user is password protected.

When logged on as Root you will find Super as a third option in the LogOn menu list.
Super is password protected and intended for Kongsberg Maritime internal use only.

Help menu
In the Help drop-down menu the following choices are available:

• About

See About on page 75
• Topics – Opens Online help.

See Topics on page 145

Tab menu
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The tab menus contain tabs for selecting parameter sheets. The tab menus are found on
top of the property area which is located on the left side of the screen. It provides the
following choices:
• System – Presenting parameter area for basic configuration of the system hardware.

See The system tab on page 56
• Processing – Presenting parameter area with processing functions.

See The processing tab on page 60
• Display – Presenting parameter area for functions relevant for displaying the data.

See The display tab on page 62
• Summary – This tab menu will only be visible when you are in survey mode. It is a

shortcut menu to the most relevant parameters. When you change parameters from
this menu, they will change immediately.
See The summary tab on page 62

Each tab lists a tree structure which when expanded to lowest level will show available
parameters for the object expanded.

By selecting the object in the list a parameter sheet becomes available.

Figure 3 Example of the tree structure, the selection of an object and the parameter
sheet appearing for that object

Moving objects

Some of the objects can be moved up and down in the list they appear in using the
arrow buttons in the parameter field. This applies to objects located in the different data
selectors and to objects in the processing chain
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Enabled

Some objects needs enabling by checking the Enabled checkbox in the parameter
sheet. When an object is enabled, it will appear as black with an arrow icon in front.
When disabled, it will appear gray. When an object is disabled (gray), the parameters
it contains, are out of function.
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The system tab
Depending on mode of operation, i.e, survey mode, replay mode, slave mode or convert
mode different parameters are available within the System tree structure.

Figure 4 Survey mode Figure 5 Replay mode

Figure 6 Slave mode Figure 7 Convert mode
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Table 6 System setup

Select To Applies to
modes

Reference

TRU detect Display parameters
for the Transceivers
Unit (TRU)

Survey mode TRU detect on
page 146

Network
configuration

Display interface
parameters for
the network
communication

Survey mode Network
configuration on
page 104

Installation
parameters

Display parameters
applicable to the
installation of the
SBP 27

Survey mode Installation
parameters on
page 99

Runtime parameters Shows the SBP 27
runtime parameters

Survey mode Runtime parameters
on page 131

Table 7 Built-in system test

Select To Applies to
modes

Reference

Test Show the parameter
sheet for performing
the Built-In system
tests

Survey mode Built-In system tests
(BIST) on page 39

Table 8 Readers and writers

Select To Applies to
modes

Reference

Beam reader Show the parameter
sheet applicable to
signal transmission
and reception

Survey mode Beam reader on
page 78

Repeat writer Enables a remote
computer running
the SBP 27 software
in slave mode to
subscribe to the raw
beam data

Survey mode

Replay mode

Repeat writer on
page 127
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Table 8 Readers and writers (cont'd.)

Select To Applies to
modes

Reference

Process writer Enable a copy of
processed beam data
to be sent to a remote
computer on the
network

Survey mode

Replay mode

Process writer on
page 119

Datagram repeater Enable a copy of
selected datagrams to
be sent to a remote
computer on the
network

Survey mode Datagram repeater
on page 83

NMEA readers Show parameter
sheet for input of
NMEA data

Survey mode NMEA readers on
page 107

NMEA reader 1 to
NMEA reader 5

Enable or disable
NMEA inputs

Survey mode NMEA reader 1 to 5
on page 110

Raw data logger Show parameters for
setting up raw data
logging

Survey mode Raw data logger on
page 124

Replay reader Display parameter
values read from
the file that is being
replayed

Replay mode Replay reader on
page 129

Repeat reader Read copy of beam
data from a master
computer on the
network

Slave mode Repeat reader on
page 126

Note

NMEA Reader 1 - 5 must be given descriptive names reflecting what type of information
they receive.
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Table 9 Data selectors

Select To Applies to
modes

Reference

Depth selector [m] Show parameter
sheet for selecting
a depth to
automatically adjust
the observation
window

Survey mode Depth selector on
page 86

Depth from bottom
tracker [m]

Show parameter
sheet for enabling
depth from bottom
tracker

Survey mode Depth from bottom
tracker on page 85

Depth from NMEA
reader [m]

Show parameter
sheet for enabling
depth from NMEA

Survey mode Depth from NMEA
on page 85

Sound speed selector
[m/s]

Show parameter
sheet for setting
manual sound speed

Survey mode Sound speed selector
on page 139

Sound speed from
NMEA [m/s]

Show parameter
sheet for enabling
sound speed from
NMEA

Survey mode Sound speed from
NMEA reader on
page 138

Coordinate selector Convert from
Latitude/Longitude
to e.g. Cartesian
coordinates

All modes Coordinate selector
on page 82

Table 10 File converter

Select To Applies to
modes

Reference

File reader Display parameters
read from a replayed
file

Convert mode File reader on
page 92

Converter filter Show filter
parameters to be used
for file converting

Convert mode Filters on page 95

File writer Show parameter
sheet for writing a
file

Convert mode File writer on page 93
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Table 11 Printers

Select To Applies to
modes

Reference

JPEG printer Show parameters for
setting up printing to
a JPEG file

All modes Printer on page 112

Printer Show parameters for
setting up printing to
a printer

All modes Printer on page 112

Note

When a Printer is configured, the name will change to the name of that printer (e.g.
“JPEG Printer”, “Analog printer “ or “EPC9800 printer”).

Root user

When logged on as Root the different modes holds the same set of parameters. The
following additional parameters becomes available:

Note

Applicable to all modes

Readers and writers
• Repeat reader→Repeat reader port – Sets up the port for reading beam data from a

master computer on the network.
See Repeat reader on page 126

• Repeat writer→Repeat writer port – Sets up the port for sending beam data to a slave
computer on the network.
See Repeat writer on page 127

• NMEA readers→NMEA reader 1 to NMEA reader 5: Enable or disable an NMEA and
select input port type and configuration.
See NMEA reader 1 to 5 on page 110
– NMEA port n: Define communication parameters for the NMEA input

The processing tab
The Processing tab contain a number of different methods and parameters, referred to as
the Processing chain, that can be selected for SBP 27 processing. The objects may be
manually enabled or disabled. The sequence in which the processing is carried out may
also be changed in the configuration of the Processing chain.

60 442094/B



Menu system

Refer to Processing chain on page 37 for description of
how to configure the processing.

The Processing tab menu gives you the following choices
under Processing chain (in alphabetic order). References
are made to the relevant descriptions.
• Attribute processing – See Attribute processing on

page 75
• Audio – See Audio on page 76
• Automatic gain control (AGC) – See Automatic gain
control - AGC on page 77

• Bottom tracker – See Bottom tracker on page 80
• Data plotter 1 and 2 – See Data plotter 1 and 2 on

page 84
• Dereverberation – See Dereverberation on page 87
• Filters – See Filters on page 95
• Gain – See Gain on page 96
• Gain correction – See Gain correction on page 98
• Mute – See Mute on page 104
• Processed data logger – Applies to Replay mode only.

See Processed data logger on page 120
• Process writer – See Process writer on page 119
• Time variable gain (TVG) – See Time variable gain (TVG) on page 145
• Processed data logger – Applies to all modes when logged on as Root.

See Processed data logger on page 120
• Swell filter – See Swell filter on page 141
• Stacking – See Stacking on page 139
• Time variable filter (TVF) – See Time variable filter (TVF) on page 144
• Synthetic aperture processing – See Synthetic aperture processing on page 142

Root user

When logged on as Root some of above processing objects may be excluded from the
User's list in order to avoid confusion and incorrect use.
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The display tab
The Display tag menu allows you to change
settings for the echogram areas. The
following choices are available:
• Echogram 1 and 2 – See Echogram 1, 2
& 3 on page 88

• Single trace – See Single trace on page 137
• Legend 1 and 2 – See Legend 1, 2 & 3

on page 101

The summary tab
The Summary tag menu show you and allows you to change the most relevant SBP
27 parameters during a survey.

The Summary tab is only visible when you are in survey mode.

See Summary tab on page 140 for closer description.

Tool bar
The Tool bar is located underneath the main menu bar. It contains buttons for fast access
to important functions. The following buttons are present

• Drop-down menu for selection of system mode
• Push buttons to control start/stop logging and recording. The buttons holds different

functions depending on mode. These are described in Replay buttons on page 128
• Zoom buttons – See Zoom buttons on page 149
• Save screen to file button – See Save screen to file on page 137

Title and info bar
The Title and Info bar in the top line of the SBP 27 window shows the name of the
program, date and time.

In replay mode the file name of the raw data file that is being replayed will be shown.
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Echogram area 1, 2 & 3
Echogram area 1 and Echogram area 2 (if enabled) are used to present the processed
real-time or replay data.

Figure 8 Echogram area 1 & 2

The data presentation in the Echogram area is controlled by Zoom buttons on the Tool
bar, the Legend parameters and by the Echogram parameters.

See
• Zoom buttons on page 149
• Legend 1, 2 & 3 on page 101
• Echogram 1, 2 & 3 on page 88

The Echogram area parameter sheet provides three options for displaying the data:
• Adjust to current window

• Adjust to current trace length

• Bottom lock

Adjust to current window

When checked the Echogram image is automatically adjusted to fit the depth range
to current acquisition window.
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Figure 9 The echogram area when “Adjust range to current window” is checked

Normally the check box Adjust to current window should be checked.

Note

If you choose to uncheck this box in order to manually set the minimum and maximum
range, the incoming data will only be displayed if a part of the trace is within these limits.

Adjust to current trace length

When checked the Echogram image is automatically adjusted to fit the current trace
length. The seabed will appear discontinuous when the depth changes significantly,
causing the acquisition delay to change.
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Figure 10 The echogram area when “Adjust range to current trace length” is checked
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Bottom lock

When checked, the data traces will be aligned to make the detected bottom appear at a
fixed horizontal position within the display.

Figure 11 The echogram area when “Bottom lock” is on

Displaying two echograms – Example configurations

Echogram area 2 can be useful when there is more than one beam in the data. The two
areas can be displayed side by side or one above the other.
1 Displaying the two areas side by side, showing an alongtrack echogram in Echogram

area 1 whilst Echogram area 2 is set up to display the acrosstrack echogram given
by the fan of receiver beams
or

2 The echogram areas may be used to compare the alongtrack echograms provided by
two different beams. The data presentation mode in an Echogram area is controlled
by Zoom buttons on the Tool bar, the appurtenant Legend, and by Echogram area
parameters.
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Echogram keyboard and mouse functions
a Access to Echogram parameters: Click left mouse button within the echogram area to

bring up the Echogram parameter sheet.
This shortcut requires the Property area to be visible

b Deselecting the Zoom buttons: Click right mouse button within one of the display
areas (an echogram area or the single trace area).
The zoom functionality will no longer be active.

c Access to Legend parameters: Click left mouse button within the legend area to bring
up the Legend parameter sheet.

d Mouse position: As the mouse is moved over an alongtrack echogram the depth and
position of the pixel pointed at is displayed at the bottom of the application window.
In the single trace area depth and amplitude are displayed.

e Horizontal and vertical distance: Click, hold, and drag the mouse over an alongtrack
echogram to have the horizontal and vertical distance over which the mouse has
been dragged displayed at the bottom of the application window.

f Beam pick: To examine a particular beam in any of the echogram areas, position
the mouse over the beam and click. The time series will be displayed in the single
trace area, and the positioned you clicked at is marked with a horizontal blue line
in the single trace area.

Property area
The property area is located on the left side.
• It contains tabs for selecting relevant parameter sheets.
• It contains parameter sheets related to the current tab selection.
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There are three tabs in Replay, Slave and Convert modes
• System
• Processing
• Display

In Survey mode a fourth tab appears:
• Summary

You may hide the property area in order to get a larger echogram area. Deselect the
Property area from the View menu.

Parameter sheet area
The Property area comprises a function menu in the upper part with the corresponding
Parameter sheet in the bottom part. Some of the parameters have a tree structure where
sub-parameters are revealed when the next level is selected.

The Parameter sheets contains fields with one of the following properties:
Parameter type Property

Parameter value, text or number, is written directly in the box

Parameter value, number, is, either, written in the box or
incremented or decremented in fixed steps by using the up and
down arrow buttons
Parameter is selected from the drop-down menu, which is
presented by clicking the down arrow button
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Parameter type Property

This parameter is selected by checking the check box

The Move arrows are used to move the position of the selected
parameter up or down in the property area. Applies to the
Processing tab only.

Background colour codes and parameter sheet buttons

Gray: The value in a grey field can not be changed manually by a normal user. Can
only be changed by Root user.

Yellow: You have changed the value, but the new value is not yet applied.

Red: The entered value is outside the allowed range .

White: The value is in use. In the parameter sheets where there are Apply and Cancel
buttons, these buttons must be pressed to apply the value.

Apply: Button for accepting the modified parameter values. A yellow background colour
in the parameter field indicates that the value has not been accepted yet.

Note

New parameters will take effect without any additional warning.

Send: The Runtime parameter sheet contains a Send button below all the parameters.
However, due to the automatic features of the SBP 27, some parameters are sent
automatically if the value is within the allowed limits (otherwise the background colour
becomes red after the value is entered). This applies to e.g. the acquisition delay and
the acquisition window length. When these parameters have been accepted by the
Transceiver Unit, the background colour of the updated parameter turns white. If a
parameter doesn’t turn white within seconds, you have to press the Send button to retry
(this applies to e.g. all parameters related to configuration of the transmit pulse). Again,
the yellow backgrounds of the updated fields turn white once they are accepted by the
Transceiver Unit.

Cancel: Button for discarding the modified parameter. This is indicated by that the
yellow background colour turns white, and the value returns to the original value.
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Legend area 1, 2 & 3
The Legend areas show how intensity of the signal is colour coded in the
Echogram areas.

You may hide the legend areas from the View menu in order to get larger
echogram areas.

The parameters applicable to the legends are found on the Property sheet
under the Display tab.

A shortcut to bring up the Legend parameter sheet is to click by left mouse
button on the colour bar.

Two small horizontal bars are found on the colour bar. These bars show the
maximum and the minimum signal level to be displayed. The bars may be
grabbed by the mouse and moved up or down to change the display thresholds.
These thresholds can also be changed by entering numerical values on the
Legend parameter sheet.

On the Legend parameter sheet you also choose between linear and
logarithmic scale, and you can choose from a number of colour maps.

The numbers given along the scale will be either in 10% steps or 6 dB steps
for linear and logarithmic coding, respectively.

Any of Legends 1-3 and Echogram 1-3 can be adjusted simultaneously. Hold
down the shift key while highlighting the objects to which you would like to
apply the same changes.
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Single trace area
On the right-hand side of the SBP 27 window, the Single
trace area is located. This area is primarily used for QC
check of the acquired signal.
The area displays the trace data in “scope” mode. Two
curves can be displayed at the same time, showing the
trace shape at different places in the processing chain. This
area also shows graphical information for the TVG curve,
seabed tracking, external depth and limits for automatic
trigger delay change.
The data presented in the window is selected in the Data
plotter 1 & 2 functions in the Processing tab. Remember
to place the Data plotter(s) in the desired position of the
processing chain, using the Move buttons. This means that
two curves may be displayed at the same time, taken from
different locations in the processing chain.
The Zoom buttons can be used to zoom along the range
axis. The tic spacing is set on the parameter sheet of the
Display tab.
The parameter sheet may be brought up by clicking the
mouse within the single trace area.
There are several markers in the area which are described
in the following:
Horizontal red bar: When the seabed tracking function
is enabled, a red horizontal bar is displayed at the location
where the seabed is detected.
Vertical red bar: When the seabed tracking function is
enabled, a red vertical bar is displayed indicating the search
area for seabed detection in the next trace.
Horizontal yellow bar: This bar is present when Show
external bottom is checked in the bottom tracker. When
external depth is supplied to the system in survey mode
the two-way range is computed based on this depth and a
yellow bar is used to indicate the externally provided range.

In replay mode the yellow bar shows the depth stored together with the beam data.
Horizontal blue bar: When using the beam picking feature of Echogram area 1, 2 &
3, a blue horizontal bar shows which sample the mouse pointed at when the beam was
selected.
TVG: A green curve, with markers A, B, C and D (not shown) is shown when the
TVG (Time Variable Gain) is enabled. This curve displays the TVG currently used.
The different sections may be modified interactively by dragging the small squares
using the mouse.
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Ping number and file length
Note

This slide bar applies to Replay mode only.

The text field on the left indicates the number of the current ping. Use the slide bar to
go backwards and/or forward in the file.

Status area

The Status area in the lower part of the SBP 27 window shows current parameters and
status for the system during online operation, which also will be stored together with the
recorded data. During replay the stored parameters will be displayed.

You may choose to show or hide the Status area may from the View menu.

During real-time operation, this area is updated once for each ping. In replay mode it
is updated for each ping replayed. The information is grouped in the following main
categories:
• When
• What - job info
• Where
• Transmitter parameters
• Receiver parameters
• Attitude information

In addition to numerical values for roll, pitch and heave for the last ping, the attitude
information is displayed as time series. The graphic displays are scaled automatically
depending on current range of values shown in the display.

By pointing the mouse to the curve, the value for that point is displayed in the text field
on the right. You will also be given a peak-to-peak value.

Note that the background colour of the peak echo level field changes to yellow when the
echo level is close to and red when it is into the non-linear regime of the preamplifier
(causing distortion/clipping of the strongest parts of the signal). To avoid distortion
reduce the transmit power level.
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Parameter sheets, buttons
and dialogue boxes

This chapter presents the parameter sheets, buttons and dialogue boxes for the SBP
27 main application.

Alphabetical list
All the parameter sheets, buttons and dialogue boxes are listed alphabetically below
• About on page 75
• Attribute processing on page 75
• Audio on page 76
• Automatic gain control - AGC on page 77
• Beam reader on page 78
• Bottom filter on page 80
• Bottom tracker on page 80
• Convert buttons on page 81
• Converter filter on page 82
• Coordinate selector on page 82
• Datagram repeater on page 83
• Data plotter 1 and 2 on page 84
• Depth from bottom tracker on page 85
• Depth from NMEA on page 85
• Depth selector on page 86
• Dereverberation on page 87
• Echogram 1, 2 & 3 on page 88
• Exit on page 91
• File reader on page 92
• File writer on page 93
• Filters on page 95
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• Gain on page 96
• Gain correction on page 98
• Installation parameters on page 99
• Legend 1, 2 & 3 on page 101
• Load configuration on page 102
• Load installation on page 103
• Mute on page 104
• Network configuration on page 104
• NMEA readers on page 107
• NMEA reader 1 to 5 on page 110
• Printer on page 112
• Printer configuration on page 116
• Process writer on page 119
• Processed data logger on page 120
• Processing chain on page 123
• Raw data logger on page 124
• Repeat reader on page 126
• Repeat writer on page 127
• Replay buttons on page 128
• Replay reader on page 129
• Restart on page 129
• Root on page 130
• Runtime parameters on page 131
• Save configuration on page 136
• Save installation on page 137
• Save screen to file on page 137
• Single trace on page 137
• Slave buttons on page 138
• Sound speed from NMEA reader on page 138
• Sound speed selector on page 139
• Stacking on page 139
• Summary tab on page 140
• Super on page 140
• Survey buttons on page 141
• Swell filter on page 141
• Synthetic aperture processing on page 142
• Test on page 143
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• Time variable filter (TVF) on page 144
• Time variable gain (TVG) on page 145
• Topics on page 145
• TRU detect on page 146
• User on page 147
• Vertical spilt on page 147
• View echogram area 2 on page 147
• View legend area 1 & 2 on page 147
• View property area on page 148
• View single trace on page 148
• View status area on page 148
• View survey warnings on page 148
• View system messages on page 149
• Zoom buttons on page 149

About
The About dialogue box is accessed from the Help menu.
This is where the version number and date of the operator software is found.

Attribute processing
The Attribute processing parameter sheet is accessed on the Processing tab.

Attributes are calculated based on the complex, analytical signal. Performing a FFT
(Fast Fourier Transform) on the real signal, removing the imaginary part, multiplying the
real part by two, and then taking the inverse FFT produces this signal. More information
about Attribute calculation can be found in Attribute calculation on page 160.

Attribute processing parameters
Enable: Must be checked to enable the function
Move: Use arrows to move the function or down in the processing chain
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Attributes:

• Inst. amplitude: Instantaneous amplitude is the magnitude of the analytical signal
which equals to the envelope of the real signal.

• Inst. phase: Instantaneous phase is the phase calculated based on the analytical signal.
• Inst. frequency: Instantaneous frequency is the local frequency content in the signal

trace. The scale in the display is starting at zero Hz and ends at half the sampling
frequency. The Gain parameter may be used to increase resolution if the gain function
is located below the Attribute processing function. Setting Gain to 200% increases
the frequency resolution by a factor of two.

• App. polarity: Apparent polarity shows the polarity of the real trace signal at local
maxima in the instantaneous amplitude. The polarity is scaled by the instantaneous
amplitude level.

Audio
The Audio parameter sheet is accessed from the Processing tab.

Audio processing is used for directing the processed signal to the audio output on the PC.

Audio parameter

Enable: Must be checked to enable the function

Move: Use arrows to move the function or down in the processing chain

Frequency [Hz]: Used for selecting the upper frequency in the down-shifted frequency
band of the original acquired data.

Audio device [Hz]: Java Sound Audio Engine is the default audio device.

76 442094/B



Parameter sheets, buttons and dialogue boxes

Automatic gain control - AGC
The AGC parameter sheet is accessed from the Processing tab.

The AGC or Automatic Gain Control function is used for optimizing the display of the
data traces. The AGC adjusts the gain. Weak portions are amplified and strong portions
are attenuated. The result is a filter effect, reducing noise and reverberation.

AGC parameters

Enable: Must be checked to enable the function

Move: Use arrows to move the function or down in the processing chain

Window length [%]: This parameter specifies the window length used for calculating the
normalising or gain factor. The length is given in percent of the full trace length.

Apply point [%]: This parameter specifies which sample within the window the
normalising and scaling shall be applied to. The value is given in percent of the window
length. 0% and 100% refers to first and last sample, respectively.

Amp. scaling [%]: The scaling parameter is used to reduce the output of the amplitude
to a suitable level for presentation. The scaling is given in percentage. 100% gives no
amplitude reduction, 50% halve the amplitude, whilst if set to 0% no data will be shown.
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Beam reader
The Beam reader parameter sheet is accessed from Readers and writers located under
the System tab.

The beam reader displays the beam data read from the beam former unit. The data
corresponds to the raw data format.

Beam reader parameters

Beamformer State: The state of the beamformer. It can be active or passive

System serial no

Ping counter

RX Beam number

TX Beam number

Burst counter

Sampling rate [Hz]: Fixed sampling rate. Set in the Installation parameter.

Pulse form: Transmit pulse form. Set in the Pulse Form parameter in the Runtime
parameters.

Pulse shape [%]

Source power [dB]: Transmitted power. Set in the Source Power [dB] parameter in the
Runtime parameters.
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Pulse length [ms]: Transmitted pulse length. Set in the Pulse length [ms] parameter in
the Runtime parameters.
Sweep low frequency [Hz]: Transmitted sweep low frequency. Set in the Sweep low
frequency [Hz] parameter in the Runtime parameters. Only used when the pulse form
is Chirp Up/Down.
Sweep high frequency [Hz]: Transmitted sweep high frequency. Set in the Sweep high
frequency [Hz] parameter in the Runtime parameters. Only used when the pulse form
is Chirp Up/Down.
CW pulse frequency [Hz]

Beam width Tx: TX beam width at transmission. Set in the Beam width TX parameter in
the Runtime parameters.
Beam width Rx: RX beam width at transmission. Set in the Beam width RX parameter in
the Runtime parameters.
Fan width [deg]: Width of beam fan. Determined by the beam spacing and the number of
beams set in the Runtime parameters. Not used when the number of RX beams is one.
Acquisition delay [ms]: Start of acquisition after TX. Set in the Acquisition delay [ms] in
the Runtime parameters.
Number of RX beams: Number of beams from the beamformer. Set in the Number of RX
beams in the Runtime parameters.
Number of TX beams: This number is equal to the number of pings in a TX cycle mode.
Either TX beam width or TX tilt angle is changed from beam to beam
Transmit tilt [deg]: Transmit tilt, along.
Receive tilt [deg]: Receive tilt, across.
Roll at Tx [deg]: Measured roll when transmitting.
Roll at Rx start [deg]: Measured roll at start of acquisition.
Roll at Rx stop [deg]: Measured roll at the end of acquisition.
Pitch at Tx [deg]: Measured pitch when transmitting.
Pitch at Rx start [deg]: Measured pitch at start of acquisition.
Pitch at Rx stop [deg]: Measured pitch at the end of acquisition.
Heave at Tx [deg]: Measured heave when transmitting.
Heave at Rx start [deg]: Measured heave at start of acquisition.
Heave at Rx stop [deg]: Measured heave at end of acquisition.
Heading at Tx [deg]: Measured heading when transmitting.
Heading at Rx start [deg]: Measured heading at start of acquisition.
Heading at Rx stop [deg]: Measured heading at end of acquisition.
Number of samples: Number of samples in each trace.
Latitude / Longitude: Information comes from the NMEA reader.
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Use heading from NMEA reader: Uncheck this box if you want to use the heading
received from the TRU.
Heading: Information comes from the NMEA reader.
Speed: Shows the current speed of the vessel.
Depth [m]: Depth relative to transducer. Parameter comes from the Depth selector.
Average sound speed [m/s]: Average sound speed.

Bottom filter
The Bottom filter is accessed from Readers and writers→NMEA Readers located under
the System tab.
Bottom filter: A simple filter for Bottom incidence range is introduced:
BIRNMEA : New value received by the NMEA reader

BIR : Value used to control the acquisition delay
α : The filter coefficient

Formula:

BIR = BIR× α + (1 − α)× BIRNMEA

The filter coefficient is entered on the NMEA readers parameter sheet. If the filter
coefficient is set to zero this means no filtering. A large filter coefficient may be useful
when the EM provide bad values under difficult survey conditions on a relatively flat
seafloor, but will be bad for “steep” slopes and “rough” terrain.

Bottom tracker
The Bottom tracker parameter sheet is accessed from the Processing tab.
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The Bottom tracker is used for finding and detecting the seabed. It’s function is to
track the seabed in profile data. This information can be used in several functions like
TVG, swell filter, mute, bottom lock, dereverberation and in automatic trigger delay
adjustments.

Bottom tracker parameters

Enable: Must be checked to enable the bottom tracker.

Move: Use arrows to move the Bottom tracker up or down in the processing chain

Show master depth: Check this to have the external depth displayed in the single trace
area (horizontal bar).

Window start [ms]: Sets the starting point for searching for the seabed. This value is only
used each time the tracker is enabled. Legal values are from 0 to 15,000 ms. Default
value is 0 ms.

Window length [ms]: Sets the area in which the bottom is search for. Noise spikes etc in
other parts of the trace will not be picked out as the bottom. Legal values are from 1 to
100 ms. Default value is 10 ms.

Threshold [%]: Sets the pick threshold in percent of the peak value in the trace, which
normally will be the seabed return. Legal values are from 0% to 100%. Default value is
70%.

Auto search: If track is lost, the window will open up to allow for automatic
re-establishing bottom track. When bottom is detected, the window will return to the
specified value.

Tip

Looking at the centre beam only will normally give a better performance of the bottom
tracker. Centre beam is selected by enabling Track selected beam only and selecting beam
number 0 from the Processing chain parameter sheet. See Processing chain on page 123

Convert buttons
The Convert buttons are located right above the Echogram area.

Convert mode

Click this button To

Start converting file formats

Pause file conversion process
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Converter filter
See Filters on page 95

Coordinate selector
The Coordinate selector parameter sheet is accessed from Data selectors→Coordinate
selector located under the System tab.

When enabled the source input will be converted to datum and projection entered in the
Alternate projection field.

The coordinate conversion function is based on the PROJ.4 Cartographic Projections
library. PROJ4, which in the SBP operator software accesses as a library function, is a
standard filter function which converts geographic longitude and latitude coordinates
into Cartesian coordinates.

Coordinate selector parameters

Source projection: Datum and projection for input.

Alternate projection: Datum and projection for output.
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Enable projection: Check to enable conversion to datum and projection entered in the
Alternate projection field.

Use Seabed position: Check to give each beam a set of coordinates at the seabed incident
point.

Datagram repeater
The Datagram repeater parameter sheet is accessed from Readers and writers→Datagram
repeater located under the System tab.

When enabled selected datagrams will be copied from the SBP 27 to specified remote
port. This may be useful e.g. for debug purposes.

To configure the Datagram repeater you must be logged on as Root. You will then have
access to the Datagram repeater port parameters located under the Datagram repeater.

Datagram repeater parameters

Enable: Check to enable selected datagrams to be copied to remote computer.

Repeat NMEA data: Check to enable copy of all datagrams enabled under NMEA readers.

Repeat install data: Check to enable copy of all installation datagrams sent to the
Transceiver Unit.

Repeat runtime data: Check to enable copy of all runtime datagrams sent to the
Transceiver Unit.
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Datagram repeater port parameters

Monitor messages: Check this box if you want to display all copied datagrams in a
separate window. This window will also allow you to Add a time stamp to the datagrams
and to Log to file.

Status: Shows port status.

Remote port: Port number of remote computer.

Remote address: Port address of remote computer.

Data plotter 1 and 2
The Data plotter parameter sheet is accessed from the Processing tab.

The data plotter is used to display single ping data in the Single trace area.

Two plotters are available. Data plotter 1 is often close to the top of the processing tree to
display the raw data, after applied gain. Data plotter 2 can be used at other locations in
the processing tree to see effects of the various processing steps.

Data plotter parameters

Enable: Must be checked to enable plot in Single trace area.

Move: Use arrows to move the Data plotter up or down in the processing chain

Plot colour: Used to select the colour of the curve drawn in the Single trace area.

Cursor read out for this plotter: When checked the depth and the amplitude will be
displayed at the bottom of the window as the mouse is moved along the data in the Single
trace area. If unchecked, only depth will be displayed.

Refer to Single trace area on page 71 for information about the Single trace area.
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Depth from bottom tracker
The Depth from bottom tracker parameter sheet is accessed from Data selectors→Depth
selector [m]→Depth from bottom tracker [m] located under the System tab.
When enabled and given the highest priority, or if Depth from NMEA reader is
unavailable, the Depth from bottom tracker will be used for automatic adjustment of the
acquisition delay.
The source listed last of Depth from bottom tracker and Depth from NMEA reader has
the highest priority.

Note

Calculate delay from depth located in the Runtime parameters must be checked to activate
automatic adjustment of the acquisition delay.

Parameters
Enable: Must be checked to apply depth data from the bottom tracker.

Use arrows to move Depth from bottom tracker up or down in the Depth
selector list.
Referenced value available: Not selectable. Will automatically be checked if a value is
available from the Bottom tracker.
Referenced value: The depth received from the Bottom tracker.

Depth from NMEA
The Depth from NMEA parameter sheet is accessed from Data selectors→Depth selector
[m]→Depth from NMEA [m] located under the System tab.
When enabled and given the highest priority the Depth from NMEA will be used for
automatic adjustment of the acquisition delay.
The source listed last under Depth selector has the highest priority.

Note

Calculate delay from depth located in the Runtime parameters must be checked to activate
automatic adjustment of the acquisition delay.
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Parameters

Enable: Must be checked to apply depth data from NMEA.

Use arrows to move Depth from NMEA up or down in the Depth selector list.

Referenced value available: Not selectable. Will be automatically checked if a value is
available from the NMEA readers.

Referenced value: Value received from the NMEA readers.

Depth selector
The Depth selector parameter sheet is accessed from Data selectors→Depth selector [m]
located under the System tab. Depth selector should always be enabled.

When enabled the Depth selector will be used for automatic adjustment of the acquisition
delay.

If the Bottom tracker is disabled, the value from the Depth selector is also used by the
TVG in tracking mode, and it is the source of depth written into the beam data.

If depth from both the Bottom tracker and from an external NMEA input is present the
reading with the highest priority will be used.

The source listed last of Depth from bottom tracker and Depth from NMEA reader has
the highest priority.

It is recommended to give Depth from NMEA higher priority than Depth from bottom
tracker.

Note

Calculate delay from depth located in the Runtime parameters must be checked to activate
automatic adjustment of the acquisition delay.
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Depth selector parameters

Enable: Must be checked to be active.

Default value: The default value is used if no other value is available. The acquisition
delay will automatically be adjusted to the default value in case of a timeout of the
external depth sensor. 0 (zero) will disable this automatic adjustment. We recommend
you to use 0 (zero) as your default value.

Referenced value available: Not selectable. Will automatically be checked if depth
information from either of the Bottom tracker or the NMEA readers is available.

Selected value: The depth value from the depth source of highest priority.

Dereverberation
The Dereverberation parameter sheet is accessed from the Processing tab.
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The Dereverberation function performs a multiple reduction operation. This function is
relevant to use in very shallow areas where the second bottom return masks sub-bottom
features.

Two methods for doing the processing are implemented. The Direct Method uses a
cross-correlation technique and the Cepstrum method operates in the cepstrum space.
The latter method seems to be more robust and gives better results

Dereverberation parameters

Enable: Must be checked to enable the function

Move: Use arrows to move the Data plotter up or down in the processing chain

Method: Selects the processing method to be used. Choices are Direct Method and
Cepstrum.

Amp. stop width: Defines an amplitude stop width in the cepstrum space given in
frequency points for the filter.

Phase stop width: Defines a phase stop width in the cepstrum space given in frequency
points for the filter.

Phase smoothing: Defines a smoothing factor in the cepstrum space given in frequency
points for the filter.

Bottom threshold: Sets the detection threshold for seabed detection in percents of the
peak level.

Echogram 1, 2 & 3
The Echogram parameter sheet is accessed either from the Display tab or by clicking left
mouse button within the Echogram area.

Echogram 1 and optionally Echogram 2 and Echogram 3 are used to present the processed
realtime or replay data.
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Refer to Echogram area 1, 2 & 3 on page 63 for examples of how the Echogram
parameters may be used to optimize the displays.
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Echogram parameters

• Copy screen: Press to have
what is displayed in the echogram
area copied to a jpeg file or to the
clipboard. The file is written to the
images folder.

• Trace width [pixel]: Use the arrow
buttons or the text field to enter
the pixel width of each trace on the
screen.
This parameter provides a
horizontal zoom. When the
echogram area no longer fits inside
the available part of the screen, a
horizontal scrollbar appear at the
bottom of the echogram area. This
bar makes it possible to display
traces that have disappeared on the
left-hand side of the Echogram area.

• Adjust range to current window:
Adjusts the echogram image
automatically to fit the depth range
to current acquisition window.

• Adjust to current trace length:
Adjusts the echogram image automatically to fit current trace length. The seabed
may appear discontinuous.

• If you want to adjust the depth yourself, uncheck the checkboxes and put your range
values into the text boxes:
– Min. range [ms]: Start displaying data from this point
– Max. range [ms]: Stop display of data at this point
Note

If you manually set the minimum and maximum range, the incoming data will only
be displayed if a part of the trace is within these limits.

• Enable event lines: This is only in use if a CODA navigation string is received, see
CODA navigation string for details. Whenever the fix number is incremented an event
line is drawn over the echogram and the fix number printed next to it.

• Grid enabled: Used to enable display of a grid
– Grid depth unit: Unit for vertical grid. Can be set to milliseconds or meters. Not
available in Acrosstrack view.

– Ping tick spacing: Distance between horizontal grid lines. Not available in
Acrosstrack view.

– Depth tick spacing: Distance between vertical grid lines
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• Show selected beam only: Should normally be checked in order to be able to specify
which receiver beam to display. Not available in Acrosstrack view.
– Selected beam number: Enter the beam number you want to display. Not available
in 3D mode.

• Bottom lock: When checked, the data traces will be aligned to make the detected
bottom appear at a fixed vertical position within the display.
– Bottom position [%]: Specifies the relative position of the locked bottom in the

full trace display.
• Acrosstrack view: Check this to display a fan of RX beams. Leave Geometric range

unchecked, and let the Shift X/Y values be zero.
• Geometric range: Compensates for beam angle when plotting data on the screen.
Only present in Acrosstrack view.

Exit
Exit is accessed from the File menu. This will shut down the system.

When you choose Exit you will be prompted whether you want to store current
configuration or not, or whether you want to cancel the Exit command.

Exit will close all the programs controlled by the SBP 27. You will however still be
logged on the work station.
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File reader
The File reader parameter sheet is accessed from
File converter→File reader located under the
System tab.

The File reader displays the information
contained in the file that is being converted, i.e.
the replay file, which can be in raw data format
or in SEG Y format.

File reader parameters

Replay file: Gives you information about which
file is being replayed and where it is located.

Override sound speed: Checkbox for overriding
the stored sound speed values during processing.

The remaining parameters displayed are header
information in the traces stored on file.

See File formats on page 177 for description.
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File writer
The File writer parameter sheet is
accessed from File converter→File
writer located under the System tab.

The File writer is used to set up file
format, max file size etc. for the files
being created by the file converting
process.

File writer parameters

Current log file: Displays the name
of the file running

Always use selected directory: When
checked, logging is enabled without
the pop-up dialogue; i.e. the log path
and the file format (raw/SEG Y/pro)
cannot be changed. Uncheck this to
be able to change log path/file format.
• For Remote logging control to

work without human interaction
Always use selected directory must
be checked. See – Remote control
datagram on page 198

Split raw files like seg files: The binary
trace header of the SEG Y format
does not contain all information
about the runtime parameters; some
information is only stored in the file
headers. For this reason, change of
some runtime parameters causes a
file break when logging in SEG
Y format. If this box is checked the

same events that trigger a SEG Y file break will trigger a file break also for data logged
in the more complete raw data format.

Use source file name: During file conversion (i.e. in Convert mode) the old file name will
be kept/included in the new file names if this is checked.

Path type: SEG Y/RAW file format or directory

SegY number format: Select between 4-byte IEEE float (recommended) and 2-byte IBM
integer.

SegY trace size: Select between Variable size and Fixed size.

442094/B 93



Kongsberg SBP 27

Note

Fixed size in combination with water column logging and automatic adjustment of trace
length typically results in numerous small SEG Y files.

SegY file extension: Select between seg, sgy, or segy.

Trace no in survey: A counter for the current survey.

Trace no in line: A counter for the current line.

Trace no in file: A counter for the current file.

File close/append: Selects number of pings between close – append action to the log file.
This will protect the system from losing a completed data file if the system crashes during
operation. No more than the selected number of pings will in worst case become lost.

Maximum file size [MB]: Use the arrow buttons or the text field to enter the maximum
size for your files.

Log selected RX beam only: Enable this if you want to log a selected RX beam only.

Selected RX beam number: When log selected RX beam only is checked, which beam
to log must be specified.

Log selected TX beam only: Enable this to log a single TX beam of a transmit cycle.
If a “transmit cycle mode” is enabled, the various beams in the cycle of N pings are
numbered from 1 to N.

Selected TX beam number: When log selected TX beam only is checked, which beam
to log must be specified.

TX beams to separate files / RX beams to separate files: Checking/unchecking these boxes
has no effect when logging in SEG Y format. SEG Y data are automatically split into
separate files for each combination of RX/TX beams.

Filenames are extended by _txN when TX beams to separate files is checked. If RX beams
to separate files is checked _rxpN, _rx0, or _rxsN (N ≥0, p=port, s=starboard) is added
to the file names to create unique filenames. Example showing what the file names
will look like when both are checked; i.e. there will be one file for each combination
of TX/RX beams:

• 20150617172546_tx1_rx0.segy

• 20150617172546_tx1_rxp1.segy

• 20150617172546_tx1_rxs1.segy

• 20150617172546_tx2_rx0.segy

• 20150617172546_tx2_rxp1.segy

• 20150617172546_tx2_rxs1.segy
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Filters
The Filters parameter sheet can be accessed from three different locations. Different
names of the parameters are being used:
• Filters is accessed from the Processing tab
• Converter filter is accessed from File converter→File reader→Converter filter located

under the System tab
Note

A flag is added to the raw format to distinguish between data that are matched filtered
and data that are not.

The Filters are used for filtering the acquired data. The following filter types are
implemented:
• Bandpass
• Matched
• Spiking
Matched filter processing results in pulse compression of long coded wavelets in order to
increase the signal-to-noise ratio and resolution. When short pulses are used, reduced
sidelobe levels may also be achieved. The filter is implemented in the frequency domain
with flat response and 100% transmission within the pass band and 0% transmission in
the stop-bands. The transition between the bands follows a raised cosine function.
See Parameter definintion for digital bandpass filter on page 96.

Filters parameters
Filter type: Choose between Bandpass, Matched and Spiking. Depending on what you
choose, different parameters will appear.
Corner frequencies: Choose between Manual or Auto selection of corner frequencies in
filter window.
• Auto: The frequencies are selected automatically depending on the start and stop

frequencies of the relevant chirp signature. The window has a cos2 roll-off.
• Manual: The following fields are present:
Low stop [Hz]: Specifies the low stop frequency of the filter. Legal values are from
0 Hz to 30,000 Hz.
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High pass [Hz]: Specifies the high pass frequency of the filter. Legal values are from
40 Hz to 30,000 Hz.

Low pass [Hz]: Specifies the low pass frequency of the filter. Legal values are from
100 Hz to 30,000 Hz.

High stop [Hz]: Specifies the high stop frequency of the filter. Legal values are from
100 Hz to 30,000 Hz.

Stability factor [ppm] (for spiking filter only): Add a constant to the filter denominator
for stabilizing purposes in Spiking filter.

Replica shaping: Checkbox for enabling replica shaping in Matched filter. The shaping is
performed by multiplying the filter by a Hanning window.

Figure 12 Parameter definintion for digital bandpass filter

Gain
The Gain parameter sheet is accessed from the Processing tab.
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The Gain function is used to applying additional gain to the processed data in order to
make presentation on display or printer as nice as possible.

Gain parameters

Enable: Must be checked to enable the function

Move: Use arrows to move the Gain up or down in the processing chain

Auto gain: When unchecked, the gain G can be specified manually (see below). When
checked, the parameter filter coefficient C appears and the autogain function tries to use
the dynamic range of the processing chain according the specified filter coefficient value.
Gain G is calculated by the following formula:

G = (1 − C) /Peaknew + C ∗Gprevious

where
• Peaknew is the peak value of the current ping
• Gprevious is the gain applied to the previous pin
• C = 0 means no history. Typical values range from 0.9 up to 0.99.

Under difficult conditions (such as when the signal is lost due to air under the transducer)
the autogain function does not behave properly and it is recommended that you switch
to manual gain

Filter coefficient: This parameter will not be shown unless Auto gain is enabled. (See
above).

NextGain = LastGain ∗ Coef + ThisGain ∗ (1 − Coef)

Gain [dB]: Sets the gain factor. The gain is given in dB. Zero dB does not influence
the result at all.

Note

The Auto gain option is of less interest since Gain correction was introduced. We
recommend using the Gain correction functionality for automatic compensation for the
spherical loss. See Gain correction on page 98 for description.
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Gain correction
The Gain correction parameter sheet is accessed from the Processing tab.

The gain correction compensates for spherical loss as the signal propagates. The gain
correction also compensates for reduction in source power and source level.

If for instance source power is reduced by 12 dB, 12 dB gain is applied to the received
signal. Or if you choose to run with transmit beam width “half array“, 6 dB gain is
applied to compensate for reduced source level.

Gain correction parameters

Enable: Must be checked to enable the function

Move: Use arrows to move the Gain correction up or down in the processing chain

Transmission loss [dB/km]: TVG compensates the transmission loss (absorption
coefficient [dB/km] may be specified to compensate for absorption).
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Installation parameters
The Installation parameters parameter sheet is accessed from System setup located under
the System tab.
The parameter sheet is visible when a normal User is logged on, but it can only be edited
when Super is logged on.
Parameters sent to the Transceiver Unit (TRU) will be shown with yellow background
until an acknowledgement from the TRU is returned.
The Installation parameters are SBP 27 parameters used for initial system configuration
and should normally not be changed during operation. The Installation parameters
contains the following groups of parameters:
• System parameters – specification of your multibeam echo sounder system
• Transmitter array – mounting parameters of your transmitter array
• Receiver array – mounting parameters of your receiver array
• GPS – mounting parameters of your GPS antenna
• MRU – mounting parameters of your MRU
Note

X, Y and Z positions that are to be entered are defined as positive forward (X), starboard
(Y) and downwards (Z) relative to the reference point.
Alongship, across and azimuth angles are defined as positive when bow up, port up and
clockwise rotation, respectively.

Installation parameters
Install State: Install state reports response to the Installation parameters sent to the TRU.
The following states may be reported:
• No data sent
• Wait for ACK
• Data sent N – where N is incremented for each data package sent
• Retry N – where N is incremented for each retry
• Message error N – where N is incremented for each error message
• Write error N – where N is incremented for each write error
• Install disabled
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Install OK: True when installation parameters are sent to and acknowledged by the TRU

System
• EM receiver type: Select your multibeam echo sounder system.
• No of Tx channels: Number of transmitter channels. Legal values are 16, 32 and 64.
• No of Rx channels: Number of receiver channels. Legal values are 16, 32 and 64.
• Sampling rate [Hz]: Fixed sampling rate/frequency.
• Water level Z-pos [m]: Water level relative to reference point.

Transmitter array
• X-position [m]: Transmitter array X-position.
• Y-position [m]: Transmitter array Y-position.
• Z-position [m]: Transmitter array Z-position.
• Alongship angle [deg]: TX alongship mounting angle.
• Across angle [deg]: TX across mounting angle.
• Azimuth angle [deg]: TX azimuth mounting angle.

Receiver array
• X-position [m]: Receiver array X-position.
• Y-position [m]: Receiver array Y-position.
• Z-position [m]: Receiver array Z-position.
• Alongship angle [deg]: RX alongship mounting angle.
• Across angle [deg]: RX across mounting angle.
• Azimuth angle [deg]: RX azimuth mounting angle.

GPS
• X-position [m]: GPS antenna X-position.
• Y-position [m]: GPS antenna Y-position.

MRU
• X-position [m]: Motion sensors X-position.
• Y-position [m]: Motion sensors Y-position.
• Z-position [m]: Motion sensors Z-position.
• Pitch offset [deg]: Motion sensor pitch offset in degrees.
• Roll offset [deg]: Motion sensor roll offset in degrees.
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Legend 1, 2 & 3
The Legend 1 & 2 parameter sheets are accessed from the Display tab.

Legend 1 controls the settings for Echogram area 1, and Legend 2 controls the settings
for Echogram area 2.

Legend parameters

View mode: Choose between Normal and Wiggle mode.

Polarity: Drop-down menu for selecting which part of the processed signal to be
displayed. The choices are +, - and +/-.
• + : displays positive parts of signal
• +/- : displays both positive and negative parts of signal
• - : displays negative parts of signal

Scale: Drop-down menu for selecting how the magnitude of the signal amplitudes is
mapped to the colour scale. Choices are Linear and Logarithmic.

Colour map: Drop-down menu for selecting various colour-coding scales. Choices are
JET, COOL, HOT, GRAY, INVGRAY, BONE, HSV and PINK.

Background: Button for selecting background colour menu. A new menu window is
displayed when the button is pushed. This menu is shown in Colour menu on page 102.

Foreground: Button for selecting foreground colour menu. A new menu window is
displayed when the button is pushed. This menu is shown in Colour menu on page 102.
Select the colour you want on your grid.

Threshold: Parameter fields for setting the relative amplitude to be displayed. These
values are used to suppress low-level noise in the presented data. Values are given in
percent if linear mode is selected and in decibels if logarithmic mode is selected.
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Figure 13 Colour menu

Maximum value Sets the maximum value referred to the top of the colour bar. The unit
depends on which scale is selected; linear or logarithmic.

Minimum value: Sets the minimum value for the colour bar.

Scale gain: Sets a multiplication factor for the colour bar.

Scale unit: Defines the text printed at the top of the colour bar.

Load configuration
The Load configuration dialogue box is accessed from the File menu.

When using Load configuration, you can load different parameter configurations. It has
to be a file saved in .xml format.
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If you want to save a parameter configuration, use Save configuration.

Related topics
• Save configuration on page 136
• Configuration files on page 36

Load installation
The Load installation dialogue box is accessed from the File menu when logged on as
Super.

When using Load installation you can load different installation parameter configurations.
It has to be a file saved in .xml format.

At startup, the SBP software will automatically load SBPInstall.xml. If you want to
use a different configuration, use can use Load installation.

If you want to save installation parameter configuration, use Save installation.

Related topics
• Save installation on page 137
• Configuration files on page 36
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Mute
The Mute parameter sheet is accessed from the Processing tab.

The mute function is used for muting or zeroing all trace values located from start of
trace and to a specified offset before the seabed position.

Mute parameter

Enable: Must be checked to enable the function

Move: Use arrows to move Mute up or down in the processing chain

Mute [ms]: Sets the offset before the seabed position for the mute.

Network configuration
The Network configuration parameter sheet is accessed from System setup→Network
configuration located under the System tab.

Note

The parameter sheet is visible when a normal User is logged on, but it can only be edited
when Super is logged on.
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Network configuration parameters
Setup State: Setup state reports response to the network communication between the
operator unit and the TRU.
The following states may be reported:
• No data sent
• Wait for ACK
• Data sent N – where N is incremented for each data package sent
• Retry N – where N is incremented for each retry
• Message error N – where N is incremented for each error message
• Write error N – where N is incremented for each write error
• Setup disabled
Setup OK: True when setup datagram is sent to and acknowledged by the TRU
Setup message port: Port where the OPU is listening for acknowledge messages
Setup port timeout: Timeout in ms
Install message port: Port listening for acknowledge messages
Install port timeout: Timeout in ms
Runtime message port: Port listening for acknowledge messages
Runtime port timeout: Timeout in ms
Beamformer LAN address: LAN address for beamformer
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TRU to Beamformer port: Port where beamformer listens for Transceiver Unit data

Beamformer to OPU port: Port where OPU listens for beamformed data

Beamformer port timeout: Timeout in ms

Local BIST port: Port for test response messages

BIST port timeout: Timeout in ms

Power unit LAN address: LAN address for power unit. The address is 157.237.15.98

OPU LAN address: LAN address for the operator work station. In a standard setup the
address is 157.237.15.95
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NMEA readers

The NMEA readers parameter sheet is accessed from Readers and writers→NMEA
readers located under the System tab.

There are five NMEA readers. These five readers have identical functionality, and they
can be configured to receive information over serial lines or Ethernet. Their default
names are NMEA reader 1-5, but the names can be changed to reflect the type or the
source of the information they are receiving. See example in the figures.

Note

When logged on as User you are allowed to enable/disable the NMEA readers only.

To configure the communication parameters and save changes to SBPInstall.xml you
need to be logged on as Super.

Note that when logged on as Super you also have access to change the names of the
NMEA readers.

To display the information read by all enabled NMEA readers, highlight the group
NMEA readers. The NMEA input data is shown in the lower part of the property area.
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If NMEA readers is highlighted, the NMEA readers parameters are displayed.
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NMEA readers parameters
UTC priority: Priority of NMEA type datagrams for time reference
Slope quality threshold: The bottom slope is computed by the EM system connected and
is used by the SBP 27 to adjust the tilt angles of the beams.
The slope calculation gives a quality measure that you can use to reject slope calculations
with poor quality. Values higher than the slope quality threshold that you enter will be
rejected, and last accepted slope values will be applied to the beams.
In the event of timeout of the EM slope data no tilt will be applied.
There are also individual slope quality thresholds for each of the NMEA reader 1 to 5.
The applied slope quality threshold is the minimum value of slope quality threshold for
the group of NMEA readers and the one entered for the particular NMEA reader 1
to 5 that receives the datagram.
Position priority: Priority list of NMEA type datagrams for position reference
Interpolate position: To compensate for the fact that position input are updated at
different rate than the ping rate, you may enable an interpolation to compute coordinates
for each ping location. If interpolation is disabled, all beams will be tagged with latest
received position. If the ping rate is higher than the position input rate all beams between
to position inputs will have the same position.
For each received position, the vessel speed is estimated based on the last two positions
and the time interval between them. This speed is used to extrapolate positions for ping
received after the last received position.
SRV shallow water priority is used to set priority between the various sources of SRV
datagram in shallow water.
SRV deep water priority is used to set priority between the various sources of SRV
datagram in deep water.
Water depth treshold defines the transition from shallow to deep in the context of SRV
priorities.
A shallow water priority string may look like this: “EM2040>EM712>EM122” meaning
SRV from the EM 2040 has priority over SRV from the EM 712, which in turn have
priority over the SRV from an EM 122.

Note

Note that the model number of an EM providing SRV datagrams must be listed in the
SRV shallow/deep water priority strings found under the NMEA readers.

Position filter: Filtering can be applied to reduce the effect of noisy positions. The
strength of the filtering is controlled by the Position filter coefficient. When the Position
filter is set to zero, no filtering is applied. If the filter coefficient is set to 0.9, the filtered
vessel speed is given by 1/10 of the last speed estimate (based on the two last positions)
and 9/10 of the previous value of filtered speed.
Bottom filter: A simple filter for Bottom incidence range is introduced:
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BIRNMEA : New value received by the NMEA reader

BIR : Value used to control the acquisition delay
α : The filter coefficient

Formula:

BIR = BIR× α + (1 − α)× BIRNMEA

The filter coefficient is entered on the NMEA readers parameter sheet. If the filter
coefficient is set to zero this means no filtering. A large filter coefficient may be useful
when the EM provide bad values under difficult survey conditions on a relatively flat
seafloor, but will be bad for “steep” slopes and “rough” terrain.
Apply ZDA/GGK correction: Checkbox for enabling or disabling the use of clock
correction from the NMEA ZDA or GGK correction

NMEA reader examples
To see the information read by a specific NMEA reader only, highlight the reader of
interest. Examples are shown on the next pages.
To avoid a large number of error messages, it is recommended to disable readers that
are not being used.

NMEA reader 1 to 5
The NMEA reader 1 to 5 parameter sheets are accessed from Readers and writers→NMEA
readers→NMEA reader n (where n is a number 1 to 5) located under the System tab.
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When logged on as User you will only have access to enable or disable the NMEA input.
When logged on as Root the following parameter settings becomes available:
• NMEA port n: Select Port type from Serial port or UDP port
• Serial port (NMEA n):

– Monitor messages: Check this box if you want to display all NMEA datagrams in
a separate window. This window will also allow you to Add a time stamp to the
datagrams and to Log to file.

– Status: Display current status of the COM port
– TimeOut: Specify time-out of the port in milliseconds.
– Baud rate: Specify baud rate of the input on the serial port
– Port name: Select serial port for NMEA input. Can be set from COM1 to COM

8. Definition of the COM port names and addresses must be defined by your
hardware and computer setup.

– Flow control: Specifies whether flow control is being used. Can be set to
XON/XOFF or Hardware

– Data parity: Select data parity of the NMEA serial input. Can be set to ODD,
EVEN or NONE

– Data bits: Select data bits of the NMEA serial input.
– Stop bits: Select number of stop bits of the NMEA serial input.
Note

Serial communication parameters must be set according to the setup used to output
the NMEA data.

• UDP port (NMEA n):
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– Monitor messages: Check this box if you want to display all NMEA datagrams in
a separate window. This window will also allow you to Add a time stamp to the
datagrams and to Log to file.

– Status: Display current status of the UDP port
– TimeOut: Specify time-out in milliseconds of the UDP port
– Single message package: Check this box if you want the NMEA datagrams to

be sent message by message, which will assure that no messages are lost due
to incomplete contents.

– Local port: Specify the port number for NMEA input on your computer
– Local address: Specify the port address for the NMEA input on your computer

Printer
The Printer parameter sheet is accessed from Printers→Printer located under the System
tab.

The Printer will print specified selection of the Echogram.

Two printers can be configured, and when they are configured the printer or drive name
will be displayed; otherwise the names of these objects will be Printer 1 and Printer 2.
Printer 1 is by default setup as a JPEG printer. A number of other printer types are
available, but must be configured for each installation.

Note

New printer types can be configured for use when logged on as Super user.

Printer parameters

Source
• Print current page – prints current view
• Print from now on– prints from current trace (ping)
• Print test page – prints a test page demonstrating the colour scale
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• Print selected RX beam only – prints data from selected RX beam only
– Select RX beam number to be printed

• Print selected TX beam only – prints data from selected TX beam only
– Select TX beam number to be printed

• Press to start print
If you are printing to the JPEG printer you will be prompted for file name and location.

Important

File extension .jpg must be added to the file name for JPEG printing.

Colours

Set colour scheme of the prints.

The colour definitions are described in Legend 1, 2 & 3 on page 101

Annotation
• Manual: Enter an annotation in the text field, e.g. describing what you see or

parameter chenges. By pressing the Annotation button the annotation will be printed.
• Automatic: Select if annotation is active synchronized to Time or Ping
• Interval (sec/trace): Selects interval size for automatic annotation.
• Print time: Select if you want to print time/date info
• Print position: Select if you want to print position
• Number of grid lines: Sets the number of grid lines to be printed
• Font size: Select annotation font size
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Drawing
• Reverse data: Select to print data in from right or from left
• Mirror text: Depending on your printer type, the text may need to be mirrored to

be visible
• Trace width: Selects the print width for each ping in number of ”pixels” on the

current printer
• Trace zooming: Select to enable printing of a reduced part of the full trace
• Fixed range: Select to enable printing of a fixed range of the full trace
• Print start [ms]: Sets start point of the trace to print
• Print length [ms]: Sets the length of the trace to print

Printer example settings

Below examples are prints of the same dataset, only using different printer parameters.

Trace zooming disabled

When Trace zooming is disabled the full paper width will be used for printing. For each
time the acquisition window/acquisition delay is changed the origin of the print must be
changed. An annotation showing the new delay is added to the print.

In areas with rapidly changing depth the prints will appear discontinuous, and may
be difficult to read.

Figure 14 No trace zooming
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Trace zooming enabled

With Trace zooming enabled only a portion of the paper width is used for printing
the trace. This allows the trace to shift within the paper width without discontinuity.
However, if the trace exceeds the paper width the trace is shifted and printing is
continued.

The print is scaled according to Print start and Print length where Print length sets the
paper width in terms of trace length in milliseconds, whilst Print start sets the where in
the trace to start printing.

Example below starts at 0 ms and is 500 ms wide.

This function will normally give best readability for online printing.

Figure 15 Trace zooming

Trace zooming and fixed range enabled

With Trace zooming and Fixed range enabled, you may select an area of interest to print.
This may in particular be useful to investigate e.g. artefacts during replay.

Example below shows a print selected with Print start at 260 ms and Print length at 40 ms

Figure 16 Trace zooming and fixed range
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Printer configuration
Note

You have to logged on as Super user in order to have access to Printer configuration.

When logged on as Super a number of additional tabs becomes available. Printer 1 and
Printer 2 configuration is accessed from Printers located under the Setup tab.
Maximum two printers may be used at the same time.

Printer 1 & 2 configuration parameters
The configuration sheet depends on Printer type selected.
Port type: Select the port the printer is connected to.

Printer type: Specifies the printer model connected to the selected port. The choices are:
• No printer
• Analog printer (using Audio output)
• JPEG printer (for printing high resolution to file)
• GSP1086 printer (EPC)
• HSP100 printer (EPC)
• Ultra and Waverly printers (now Coda Octopus)
• EPC9800 printer
• Epson ESC/P2 printer
• PCL printer (HP DeskJet/LaserJet)

Gray scale recorder

• Horizontal dots: Number of dots per sweep on grey scale recorders.
• Lines per inch: Sets the lines per inch for the EPC9800 printer. This item is only

visible when EPC9800 printer is selected.
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• Colour model: Colour model used; only grey for line scan recorders.

Colour printers
• JPEG quality [1..0]: Specifies print

quality for printing to a file in JPEG
format. Selecting 1 gives best quality.
This option is only available when
JPEG printer is selected.

• Paper width [mm]: Physical width of
the paper the paper used.

• Paper height [mm]: Physical height
of the paper used. A value of zero
indicates continuous paper.

• Paper left margin [mm]: Width of the
left hardware dependent margin.

• Paper right margin [mm]: Width of the
right hardware dependent margin.

• Paper top margin [mm]: Width of the
top hardware dependent margin.

• Paper bottom margin [mm]: Width of the bottom hardware dependent margin.
• Extra left margin [mm]: Width of the additional user defined left margin.
• Extra right margin [mm]: Width of the additional user defined right margin.
• Extra top margin [mm]: Width of the additional user defined top margin.
• Extra bottom margin [mm]: Width of the additional user defined bottom margin.
• Dots per inch: Sets the printer resolution on the paper. The values are depending on

the printer model.
• Colour model: Specifies the colour model to use with the printer. Typical choices are

(context sensitive): BW, CMY, CMYK, RGB.

The paper/margin description is shown in the following figure where the grey tones
define relevant areas on the paper. Dark grey defines the physical paper, the light grey
defines the area printable by the printer and the white area is the area where acoustic data
are printed. The margin given as dark grey is given by the actual printer documentation.
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Analog printer

• Analog frequency [Hz]: Sampling frequency with which data are supplied to the
audio output.

• Signal pad time [ms]: Padding of the signal trace for reducing problem with writing
new data before old data are clocked out.

• Horizontal dots: Number of samples to send to the audio output. Duration of the
output signal is fixed equal to <Horizontal dots>/<Analog frequency>. Any time
duration of the recorded data is mapped into this fixed length.

The TOPAS data shown in the first of the two next figures is a snapshot of a 50 ms data
trace from the QC display on the operator console.
The lower figure shows what is sent to the audio output for use by an analog printer.
The system is here set up for printing negative signal values and a fixed duration of 90
ms (3600 samples at 40 kHz).
The analog printer must be set up for printing both positive and negative values.
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Process writer
The Process writer is found in the processing chain and its parameter sheet is accessed
from Readers and writers→Process writer located under the System tab.

When the Process writer is enabled processed data will be copied to the port number
specified in the parameter sheet. Process writer enables a remote computer running the
SBP software in slave mode to subscribe to processed beam data.

The position of the Process writer in the Processing chain determines what processing is
applied to the data. It can be moved freely up/down in the processing chain. If located at
the bottom of the processing chain, the data received by a slave unit will be identical to
the data displayed in the Echogram area of the master system. To configure the Process
writer you must be logged on as Root.
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Process writer port parameters

Stub port address: Port number for data transmission.

Processed data logger
The Processed data logger parameter sheet is accessed from the Processing tab.

The Processed data logger is used for setting up data logging of processed data.

Note that the position of the parameter sheet in the processing chain determines what kind
of data is stored. When the Processed data logger is positioned on top of all other enabled
items in the processing chain, it logs data in the RAW format. This way the Processed
data logger may be used to extract a part of an existing RAW file. If Processed data logger
is positioned after the e.g. Matched filter is applied, it logs pulse compressed data.
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When you check the Enable check box, a dialogue box will appear. Choose the format
you want to log in, and select if you want to log to file or directory. Press OK when
you are done.
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Processed data logger parameters

Current log file: Path and name of the current log file

Split raw files like seg files: Checkbox for selecting file splitting based on parameter
changes similar to the SEG Y format splitting.

Path type: Displays file format and whether it is a file or directory

Trace no in survey: A counter for the current survey

Trace no in line: A counter for the current line

Trace no in file: A counter for the current file

File close/append: Selects number of pings between close – append action to the log file.
This will protect the system from losing a completed data file if the system crashes during
operation. No more than the selected number of pings will in worst case become lost.

Max file size [MB]: Use the arrow buttons or the text field to enter the maximum file
size you want for your files or directories. When the size of a file exceed this values, a
new file will be created

Log selected RX beam only: Enable this if you want to log a single beam from data
containing a number of receiver beams

122 442094/B



Parameter sheets, buttons and dialogue boxes

Selected RX beam number: Select the RX beam you want to log.
Log selected TX beam only: Enable this if you want to log a single beam from data
containing a number of transmitter beams
Selected TX beam number: Select the TX beam you want to log.

Processing chain
The real-time processing and post-processing available in SBP 27 is located under the
Processing tab in the property area.
The parameter sheet for the Processing chain contains parameters for selection of beams
used for bottom tracker and for display in the single trace area.

Processing chain parameters
Track selected beam only: Enable this checkbox if you want to use one selected beam
only for display and for the Bottom tracker.
Selected beam number: Select the beam you want to display or use for bottom tracking.
This may often be the centre beam, i.e. beam number 0, which normally gives the best
signal.
Number of beams: Shows number of beams in the data.
Beam number: Shows what beam is currently being processed.
Maximum backlog: Highest allowable number of beams that can be queued up in the
memory of the Operator Station for processing.
Current backlog: Number of not yet processed beams in memory. If current backlog
exceeds maximum backlog the computer is to heavy loaded, and data may be lost.

Note

To prevent loss of data in a case of queued up data in memory, maximum backlog must
never be set smaller than number of beams. We also recommend adding a margin to
number of beams.

Related topics
• Bottom tracker on page 80
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Raw data logger
The Raw data logger parameter sheet is accessed from Readers and writers→Raw data
logger located under the System tab.

The Raw data logger is used for setting up raw data logging parameters.

When you mark the check box for Enabled, a file open dialogue box will appear. If the
check box is already marked, uncheck it and check it again. Choose the format you want
to log in. Select if you want to log to file or directory. Press OK when you are done.
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Raw data logger parameters
Current log file: Path and name of the current log file
Split raw files like seg files: Checkbox for selecting file splitting based on parameter
changes similar to the SEG Y format splitting.
Path type: Displays what kind of format and if it’s a file or directory
Trace no in survey: A counter for the current survey
Trace no in line: A counter for the current line
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Trace no in file: A counter for the current file

File close/append: Selects number of pings between close – append action to the log file.
This will protect the system from losing a completed data file if the system crashes during
operation. No more than the selected number of pings will in worst case become lost.

Max file size [MB]: Use the arrow buttons or the text field to enter the maximum file
size you want for your files or directories. When the size of a file exceed this values, a
new file will be created

Log selected RX beam only: Enable this if you want to log a single beam from data
containing a number of receiver beams

Selected RX beam number: Select the RX beam you want to log.

Log selected TX beam only: Enable this if you want to log a single beam from data
containing a number of transmitter beams

Selected TX beam number: Select the TX beam you want to log.

For more information about Logging, refer to Logging data on page 35.

Repeat reader
The Repeat reader parameter sheet is accessed from Readers and writers→Repeat reader
located under the System tab.

Repeat reader is used in slave mode to read a copy of the beam data sent on the network
as specified in Repeat writer on page 127. The slave computer can then run the SBP
27 software with the same beam data as the master system, but independently with
respect to realtime and post processing.

The beam data from the master system can either be realtime, i.e. the master system
operates in survey mode, or it can be replayed data from the master system.

When you mark the check box for Enabled beams from the master system will be read.
Data that are read will be displayed in the Repeat reader parameter sheet.

For parameter description refer to File reader on page 92

To configure the Repeat reader you must be logged on as Root. Then you will have
access to the Repeat reader port parameter sheet located under the Repeat reader.
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Repeat reader port parameters

Stub port number: Enter the stub port number for the repeat writer on the master system.

Stub address: Enter the IP address of the master system.

Repeat writer
The Repeat writer parameter sheet is accessed from Readers and writers→Repeat writer
located under the System tab.

When you mark the check box for Enabled beams from the master system will be copied
to the specified port number. .

Repeat writer enables a remote computer running the SBP 27 software in slave mode to
subscribe to the raw beam data.

To configure the Repeat writer you must be logged on as Root. You will have access to
the Repeat writer port parameter sheet located under the Repeat writer.

Repeat writer port parameters

Stub port address: Port number for data transmission.
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Replay buttons
The Replay buttons are located right above the Echogram area.

Replay mode

Click this button To

Start replay

Do single step replay

Do single fan step replay

Hold replay

Log processed data – enables Data logger in Processing chain

128 442094/B



Parameter sheets, buttons and dialogue boxes

Replay reader
The Replay reader parameter sheet is accessed from
Readers and writers→Replay reader located under the
System tab.

The Replay reader parameter sheet display parameter
values read from the file that is being replayed.

Replay reader parameters

Replay file: Gives you information about which file is
replayed and where it is located

Replay rate (ms): Sets minimum time interval between
reading pings from file

Skip traces: sets the number of traces to skip in order
to compress the data horizontally.

Pause at trace: Stops replay at trace number specified.

Override sound speed: Checkbox for overriding the
stored sound speed values during processing.

The remaining parameters displayed are header
information in the traces stored on file.

See File formats on page 177 for description.

Restart
Restart is accessed from the File menu.

When you select Restart, a reset command is sent to the Transceiver Unit to perform
a software restart.
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If the TRU has been subject to a power reset, the connection between the TRU and the
operator unit is lost, and the TRU starts broadcasting “here-I-am”-messages. There is
no need to restart the operator software. Using the Restart command will make the
operator unit listen for these messages so that the connection between the units of the
system can be re-established.

Root
The Root dialog box is accessed from the LogOn menu.

When logged on as Root, you get access to most of the parameters. The parameters that
are grey when a normal user is logged on will turn white as an indication of this.
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Runtime parameters
The Runtime parameters parameter sheet is accessed from System setup→Runtime
parameters located under the System menu.

Note

The runtime parameters are visible in Replay mode only when Root is logged on.

White fields can be changed, grey fields can not. Changed, but not yet applied parameters
are displayed with yellow background. Applied parameters are white, whilst illegal
parameters are shown with a red background.

Note

Note that the parameter sheet will appear differently depending on transmit mode and
pulse form selected.

Runtime parameters
The runtime parameters are explained in more details in Main operational modes on
page 162.
Run state: Install state reports response to the Runtime parameters sent to the TRU.
The following states may be reported:
• No data sent
• Wait for ACK
• Data sent N – where N is incremented for each data package sent
• Retry N – where N is incremented for each retry
• Message error N – where N is incremented for each error message
• Write error N – where N is incremented for each write error
• Runtime disabled
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Transmit mode
• Transmit mode: Choose between Normal, Burst, Single pulse or Off
• Max burst pulses: Applicable to Burst mode only. Enter the desired maximum number

of pulses per burst cycle in the first text field. Legal values are from 1 to 20. The
second text field shows the achieved number of pulses per burst cycle.

• Burst pulse delay [ms]: Time between burst pulses
• Transmit cycle mode: Choose between None, Cycle tilt angle and Cycle beam width.

Note

NOTE for systems with a 12 degree TX the Cycle beam width option is not available

See Transmit cycle modes on page 164 for technical details.
• Pings in cycle: Visible when Cycle tilt angle is selected. Choose from 2 to 11 pings
• Tilt step [deg]: Visible when Cycle tilt angle is selected. Specify the desired tilt step

angle. Maximum tilt angle allowed is 15 degrees.
• Beam widths: Visible when Cycle beam width is selected. Choose between 3°/6°,

6°/12°, 3°/12° and 3°/6°/12° degrees for a 3 degree transmit array. For a 6 degree
transmit array only 6°/12° is available.

Synchronization
• Synchronisation: Choose between EM trigger, External trigger or Fixed rate. To run

the system independently of other systems select Fixed rate.
• Ping interval: Applicable to Normal mode only. Enter desired ping interval in first text

field. Legal values range for Ping interval is from 200 ms to 120 000 ms. The actual
value depends on wavelet type, water depth and operation mode. Typical values in
shallow areas are 300 to 500 ms in Burst and Ricker modes, and 1000 ms in Chirp
mode. Actual ping interval will be shown in second text field.

• Acquisition delay [ms]: Time from transmit start to start of data acquisition. See figure
Acquisition delay and acquisition window on page 136.The maximum legal value is
20000 ms. The minimum legal value is depending on the pulse length.

• Acquisition window [ms]: Duration of a single data acquisition [ms]. See figure
Acquisition delay and acquisition window on page 136. Legal values are from 5
ms to Maximum window length.
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• Maximum window length [ms]: For Super Three values are available:
– 500 ms for backwards compatibility
– 1500 ms for compatibility with SEG Y (default)
– 15000 ms (Maximum) for studies of noise/reverberation
Factory default is 1500 ms. Note that a longer maximum trace length is not compatible
with SEG Y. To change the maximum trace length, log on as Super and the following
drop-down menu will appear on the runtime parameter sheet.

• Reduce EM<>SBP crosstalk: Visible only when the system is set to be synchronized.
We recommend to keep this checked.

Pulse form
• Pulse form: Choose between CW pulse, Linear chirp up, Linear chirp down,
Hyperbolic chirp up, Ricker pulse and No pulse.
– CW pulse: Continuous wave pulse of constant amplitude and frequency.
– Chirp: A chirp is a signal in which the frequency linearly or hyperbolical increases

(up-chirp) or decreases (down-chirp) with time. This wavelet is a coded wavelet
where the signal energy is stretched out in time. The bandwidth is determined by
the start and stop frequencies for the sweep. On reception of this wavelet, matched
filtering is required in order to concentrate the energy into a narrow pulse

– Ricker: The Ricker wavelet is a single pulse with nice time domain behaviour for
high-resolution work. This wide-band wavelet requires a high signal-to-noise
ratio for optimal performance

• CW pulse frequency [Hz]: Applicable to CW pulse only.
• Sweep low frequency [Hz]: Applicable to Chirp pulse only. Start frequency determining

the bandwidth.
• Sweep high frequency [Hz]: Applicable to Chirp pulse only. Stop frequency

determining the bandwidth.
• Minimize pulse shape: Check this to have the taper minimized automatically when

pulse length is changed.
• Pulse shape [%]: If this parameter is set to 100 a Hanning window of length equal

to the pulse length is used to taper the pulse. When Minimize pulse shape is checked
minimum shaping is applied and this parameter is updated automatically if the pulse
length is changed. A harder taper can be applied by unchecking the Minimize pulse
shape and specifying the Pulse shape percentage manually. See Amplitude shaping
– and pulse shape parameter on page 176 for details.
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• Pulse length [ms]: Transmitted pulse length. Will be rounded to an integral number
of wavelength. Legal values are from 2 ms to 100 ms

• Source power [dB]: Source power measured in dB. Legal values are from -30 dB to
0 dB
Selected value is displayed in the left field, whilst current value is displayed in the
right.

• Automatic power adjustment: Check this to have the transmit power level
automatically adjusted to reduce amount of clipping in the pre-amplifier when the
return signals are very strong. Typically the strongest signal is is the bottom return
and possibly reflections from shallow sediment interfaces of high contrast.

Note

In the raw files, data for each trace are stored with unscaled amplitude when the
transmit power level varies so accurate information is preserved.

In the SEG Y files the transmit power level is only stored in the file header. To avoid
numerous small files as the transmit power level is varying this is what happens:
– The desired power level is stored in the SEG Y data file header.
– The trace samples are scaled to compensate for the difference between desired
power level and actual power level.

If this is unacceptable refrain from using the option of automatic power adjustment.

• Power ramping rate [dB/min:] For mammal protection you may increase the source
power from lowest level (-30 dB) up to selected source power by a number of dB
per minute.
When you stop pinging the source power will after a timeout threshold of 2 minutes
decrease the source power to lowest level by the set number of dB per minute.
When set to 0 the power ramping is disabled.

Beams
• Beam width Tx: Choose between Full array, Wide 10/20/30, Focused, Half array,

Quarter array and Follow TX beam width
• Beam width Rx: Choose between Full array, Wide 10/20/30, Focused, Half array,

Quarter array and Follow TX beam width.
• Number of Rx Beams: Number of beams from beamformer. Choose between 1,

3, 5, 7, 9 and 11.
• Beam spacing [deg]: Angle between RX beams. Legal values are up to 15 degrees

Depth
• Acquire Water Column data: Check this box to run with minimized acquisition delay.

Minimum acquisition is 8 milliseconds more that the pulse length. To have the
minimum acquisition delay possible use pulse length 2 milliseconds.
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Note

– Calculate delay from depth changes to Calculate trace length from depth when this
option is checked.

– If both Acquire Water Column data and Calculate trace length from depth are checked
the field Acquisition window changes to Sub-bottom window.

• Calculate delay from depth: Check this box if you want to calculate the acquisition
delay from external depth.

• Depth from transducer [m]: Depth relative to transducer from either an EM system
or Bottom tracker

• Delay hysteresis [ms]: Will not change delay unless step is larger than this [ms]
• Bottom screen pos [%]: Set where you want to start displaying the bottom on the

screen. Example: bottom screen set to 20% will make the first 20% of the trace be
occupied by the water column. 0% means that bottom is shown at start of trace, 100%
means end of trace. Legal values are from 0 to 100

Slope
• Automatic slope correction: Perform automatic or manual bottom slope correction
• Slope alongship [deg]: Bottom slope alongship from an EM system
• Slope across [deg]: Bottom slope across from an EM system
• Slope quality: Bottom slope estimated quality from an EM system

Range
• Bottom Incidence Range BIR [ms]: Bottom delay normal to surface from an EM system
• Normal Incidence Range NIR [ms]: Bottom delay normal to bottom from an EM system

Sound speed
• Transducer sound speed: Sound of speed in m/s at transducer from an EM system
• Average sound speed: Sound of speed in m/s in water from an EM system
• Bottom sound speed: Sound of speed in m/s at bottom from an EM system
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Figure 17 Acquisition delay and acquisition window

Save configuration
The Save configuration dialogue box is accessed from the File menu.

When using Save configuration, current parameters are stored into the file SBPConfig.xml.

You can save different parameter configurations with different names. It has to be in
.xml format.

If you want to use a different configuration, use the Load configuration.

Related topics
• Load configuration on page 102
• Configuration files on page 36
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Save installation
The Save installation dialogue box is accessed from the File menu when logged on as
Super.
When using Save installation, current installation parameters can be stored into the file
SBPInstall.xml located in the working directory.
This file contains installation parameters for array, motion sensor and antenna. It also
contains the network configuration (IP addresses, UDP ports) and setup of NMEA
readers and Printers.
You can save different installation parameter configurations with different names. It
has to be in .xml format.
At startup, the SBP software will automatically load SBPInstall.xml. If you want to
use a different configuration, use the Load installation.
Note

We advice that you make a read-only copy of SBPInstall.xml and store it in the config
directory of the software installation.

Note

If changes have been made to any of the installation parameters, use File→Restart to
transmit the new installation parameters to the TRU and the receiver beamformer.

Reference
• Configuration files on page 36

Save screen to file
The Save screen to file button is located on the Tool bar above the Echogram area.

When pushed an image of the application window is written in the Images folder in jpeg
format. A keyboard shortcut for this command is CTRL+S.

Single trace
The Single trace parameter sheet is accessed from the Display tab.
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Single trace parameters

Grid Tic Spacing: Sets the spacing between the horizontal grid lines of the Single trace
area, given in number of pixels.

Slave buttons
The Slave buttons are located right above the Echogram area.

Slave mode

Click this button To

Start reading

Log processed data – enables Data logger in Processing chain

Sound speed from NMEA reader
The Sound speed from NMEA parameter sheet is accessed from Data selectors→Sound
speed selector [m/s]→Sound speed from NMEA reader [m/s] located under the System tab.

The sound speed is used for converting external depth to travel time for automatic
adjustment of runtime parameters.

Sound speed from NMEA parameters

Enable: Must be checked to apply sound speed data from NMEA.

Referenced value available: Check to enable the use of a reference value.

Referenced value: Enter the average sound velocity.
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Sound speed selector
The Sound speed selector parameter sheet is accessed from the System tab.

The Sound speed selector is used for selecting which sound speed value to use (if more
that one is available) for converting between depth and time delay.

Sound speed selector parameters

Default value: The default value is selected if no other value is available

Referenced value available: Makes the sound speed relative to transducer available

Selected value: The selected sound speed measured relative to the transducer.

Stacking
The Stacking parameter sheet is accessed from the Processing tab.

The stacking or trace mixing function is used for reducing incoherent noise in adjacent
traces. A given number of traces are averaged sample by sample to produce a new trace
of averaged samples. Optimal performance is achieved when reflecting horizons are
fairly parallel and horizontal. The improvement in signal-to-noise ratio for correlated
signals will be approx. 10× log (N) where N is number of traces used in the processing.

Stacking parameter

Enable: Must be checked to enable the function

Move: Use arrows to move Stacking up or down in the processing chain

# Traces: Sets the number of adjacent traces to be used in the averaging.
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Summary tab
The Summary tab is only visible when you are in survey mode.
It is a shortcut menu to most relevant parameters in survey mode.

The parameters are a subset of parameters from the following parameter sheets:
• Runtime parameters – See Runtime parameters on page 131
• Raw data logger – See Raw data logger on page 124
• Gain – See Gain on page 96
• Bottom tracker – See Bottom tracker on page 80
• Time variable gain – See Time variable gain (TVG) on page 145
• Automatic gain control – See Automatic gain control - AGC on page 77

Super
Super user is intended for Kongsberg Maritime internal use only.
When logged on as Root the Super dialog box can be accessed from the LogOn menu.
When logged on as Super you are given access to additional settings and configuration
of the SBP 27.
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For normal operation configuration via Super user is not required. However, you may
during initial configuration of your system need access as Super user for the following:
• Configuration of printers
• Giving descriptive names to the NMEA readers

Survey buttons
The Survey buttons are located right above the Echogram area.

Survey mode

Click this button To

Start transmission mode normal

Start transmission mode burst

Start transmission mode single ping

Log sampled raw data for later replay – enables Raw data logger in Readers
and writers

Swell filter
The Swell filter parameter sheet box is accessed from the Processing tab.

The swell filter is used to reduce the influence of the heave movement of the vessel on
sub-bottom data when a VRU is not integrated in the system. The system detects the
current seabed location and compares it with previous locations. If there is an offset, the
last location is moved to the average of a number of previous locations.

Note

The swell filter may remove information about sand waves on the seabed and must
therefore be used with care.
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Swell filter parameters
Enable: Must be checked to enable the function
Move: Use arrows to move Swell filter up or down in the processing chain
Swell Mode: This drop-down menu contains options for the filtering function:
• Moving avg: The seabed position is calculated as the average of the seabed position in

the last N number of pings. Each position has the same weighting factor.
• Linear weight: The seabed position is calculated as the average of the current position

plus the previous N detected positions minus the previous average position.
# traces: The number of traces used in the calculations.

Synthetic aperture processing
The Synthetic aperture sonar (SAS) processing parameter sheet is accessed from the
Processing tab.

Synthetic Aperture Sonar (SAS) processing is used to increase lateral resolution of
the SBP 27 system. It is primarily used where small features and objects buried in the
sediments are of special interest.
In order to get good results, accurate vessel speed and heave compensation has to be
present.

SAS parameters
Enable: Must be checked to enable the function
Move: Use arrows to move Synthetic aperture processing up or down in the processing
chain
# traces: Sets the number of traces/pings to be used in the SAS processing.
Avg. velocity [m/s]: Average sound speed in the water used in the processing.
Start time [ms]: Start time for the part of the traces to be used for processing. The reason
for selecting only a part of the trace is to reduce CPU requirement as the SAS processing
is quite CPU consuming.
Stop time [ms]: Stop time for the SAS processing window.
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Figure SAS parameters on page 143 shows definition of parameters. Number of traces
is approximately the number of pings recorded during the passage from position 1 to
position 3. As seen, all pings in between will get an echo from the spherical “object”
buried in the seabed. For each ping, the position is compensated for the varying distance
between the sensor and the object thereby accumulating reflected energy from individual
resolution cells in the processing window limited by the start and stop times and the
length. The physical length is approx. #traces× pinginterval × vesselspeed.

Figure 18 SAS parameters

Test
The Test parameter sheet is accessed from Built-in system test→Test located under the
System tab.

Refer to Built-In system tests (BIST) on page 39 for more information about the system
tests.

Test parameters

SW versions: This test provides version number/date for the major software components
in the system.
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MSP CPU Card Test: This test verify that contact with the main processor on the MSP
board is established, which is also done in the SW versions test.

HD8 Card Test: The response to this test is a matrix with information about measured
voltage and temperature on each HD8 board – one row per HD8 board.

High Voltage Power Test: The HV power unit attempts to increase the high voltage in
steps of 30 volts up to 210 volts, while measuring the resulting voltage.

Receiver Noise Test: Noise level in the sea.

MRU (Motion Reference Unit) Test: This test reports the number of attitude messages
received by the transceiver unit during one second.

Time variable filter (TVF)
The TVF parameter sheet is accessed from the Processing tab.

To make the TVF active, check the Enabled box on the top of the dialogue box.

The time varying filter is used for band pass filtering of the acquired data using a linearly
varying bandwidth as a function of position in the trace.

TVF parameters

Start HP [Hz]: Sets the high pass corner frequency at the filter start.

Start LP [Hz]: Sets the low pass corner frequency at the filter start.

Stop HP [Hz]: Sets the high pass corner frequency at the filter end.

Stop LP [Hz]: Sets the low pass corner frequency at the filter end.

Set point [ms]: Sets the starting point of the linear change in the trace in absolute time.

Max duration [ms]: Sets the duration of the linear change in the trace in milliseconds.
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Time variable gain (TVG)
The TVG parameter sheet is accessed from the Processing tab.
To make the TVG active, check the Enabled box on the top of the dialogue box.
The TVG is mainly used for compensating propagation attenuation of the signal. Due to
the high dynamic range of the analogue-to-digital converter, the TVG is applied digitally.

Three different slopes may be used.

TVG parameters
TVG Control: Selects how the start position of the TVG curve is controlled. The choices
are Manual and Tracking.
• Manual: The start position is fixed until the operator specifies a new start value.
• Tracking: The start position follows the Bottom tracker or an External depth input

with a specified offset.
The Bottom tracker will be used if it is enabled and if it is placed above the TVG
in the Processing chain.

TVG Start A: Gives an offset for the start point in tracking modes.
Section A-B / Section B-C / Section C-D: Specifies the various slope sections in the TVG
curve.
Length [ms]: This parameter determines the starting point for the TVG curve sections
relative to the start of the ping. Legal values are from 0 to 15,000 ms.
Slope [dB/ms]: This parameter sets the slopes of the gain curves for the TVG. Legal
values are from 0 to 20 dB/ms.

Topics
Topics is accessed from the Help menu. This is the online help
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TRU detect
The TRU detect parameter sheet is accessed from System setup→TRU detect located
under the System tab.

Note

The parameter sheet is visible when a normal User is logged on, but it can only be
edited when Root is logged on.

TRU detect parameters
Detect state: Reports the state of contact between the Operator station and the TRU.
The following states may be reported:
• No TRU detected
• Listening
• TRU detected N – where N is incremented for each time the TRU is sending
• Message error N – where N is incremented for each error message
• Read error N – where N is incremented for each read error
• Detect disabled
Detect OK: TRU broadcast received on port 1999.
System serial number: System serial number
LAN address of TRU: LAN address of the Transceiver Unit
TRU install port: This port is used for the Transceiver Unit installation parameters
TRU setup port: This port is used for the Transceiver Unit setup parameters
TRU runtime port: This port is used for the Transceiver Unit runtime parameters
TRU BIST port: This port is used for the Transceiver Unit Built-In System Test
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CPU version:Software version and date
SISP10 versions: Firmware version and software date
SIHD8 version: Firmware version
Port for TRU broadcasts: This local port listens for TRU broadcasts – always port
number 1999
Timeout for broadcasts: Timeout in ms

User
User is accessed from the LogOn menu.
There can only be one user logged on the system.

Vertical spilt
Vertical split is enabled from the View menu.
Use this if you want to align the echogram areas side by side.

View echogram area 2
Viewing Echogram 2 is enabled from the View menu.
If desired, the status area can be removed from the screen. This is done by un-checking
View→Echogram 2. The checkmark will disappear.
To get the status area back, check View→Echogram 2. The checkmark will return.

View legend area 1 & 2
Viewing Legend 1 or Legend 2 is enabled from the View menu.
If desired, the legend area can be removed from the screen. This is done by un-checking
View→Legend 1 or 2.
To get the legend area back, check View→Legend 1 or 2.
Legend 1 applies to Echogram 1, Legend 2 is for Echogram 2.
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View property area
viewing the Property area is enabled from the View menu.

If desired, the property area can be removed from the screen. This is done by
un-checking View→Property area.

To get the property area back, check View→Property area.

View single trace
Viewing the Single trace is enabled from the View menu.

If desired, the data area can be removed from the screen. This is done by un-checking
View→Single trace.

To get the data area back, check View→Single trace.

View status area
Viewing Status area is from the View menu.

If desired, the status area can be removed from the screen. This is done by un-checking
View→Status area. The checkmark will disappear.

To get the status area back, check View→Status area. The checkmark will return.

View survey warnings
By default this window pops up whenever new information is printed to it.

Note

It is possible to disable the “auto pop-up” feature temporarily or permanently. Think
twice before disabling permanently. These warnings are introduced in response to
unfortunate events.

• If after five minutes of pinging logging is still not activated the following message is
printed in the Survey warnings window:
Survey running without raw data logging!

• If after five minutes of pinging power level is at minimum level the following message
is printed in the Survey warnings window:
Survey running on minimum ping power!
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• When the acquisition delay reaches or is set to a minimum allowed value limited by
the pulse length, the following message is printed in the Survey warnings window:
Minimum acquisition delay reached. Consider reducing pulse length

For chirp and CW pulses the minimum acquisition delay is pulse length plus 8 ms. To
achieve this minimum acquisition delay of 10 ms the pulse length must be reduced to
its minimum of 2 milliseconds.

View system messages
Viewing the System messages is enabled from the View menu.

Use this if you want to view the system messages.

If you want to remove them from the screen you can either select View→System messages
or click the OK button on the dialogue box. The checkmark will disappear.

Zoom buttons
The Zoom buttons are located right above the Echogram area.

These buttons are used for zooming in and out of the Echogram areas and the Data area.
There is one set of buttons for each of the two display areas. Each push on the buttons
zooms in or out of the display by a factor of 1.5.

Note

The zooming is only performed in the vertical time axis.

The Full trace button is located right above Echogram area 1.

This button selects display of the full trace length for both the Echogram areas and
for the Single trace area.
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Software applications

Topics
• Online Monitor on page 150

Online Monitor
Online Monitor is a utility program to SBP 27 used for monitoring and logging of status
of the system hardware. Online Monitor is also useful for troubleshooting of the SBP 27.

Note

Status messages received by the Online Monitor are logged to the directory
Logs in the working directory of the operator software. The full path is typically
C:\ProgramData\Kongsberg Maritime\KM SBP OPU\Logs

Online Monitor is by default launched automatically when the operation station is started.
If Online Monitor is not running it must be started separately from the desktop of your
Operator Station before SBP 27 is started. We recommend that the Online Monitor is
running before the SBP 27 transceiver is started in order to collect all status information
from the transceiver.

Note

SBP 27 will start even if Online Monitor is not started, but if Online Monitor is not
running no status information from the transceiver will be logged.

If the Online Monitor isn't already running, start Online Monitor by selecting the
icon from the desktop of the Operator Station.
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Main window
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The main window of Online Monitor consists of three sub sections:
• Transmitter boards (HD8): Displays status of each channel of the SIHD8 cards.

Depending on system size two, four, or eight SIHD8 cards are installed in the
Transceiver Unit (TRU)
An additional status window shows the max/min values of the following SIHD8
readings:
– Input voltage 12V
– Analog 4.8V
– Analog 5V
– Aux voltage 3.3V
– Digital 1.2V
– Digital 3.3V
– Temperature °C
– High Voltage V

* This is the peak output voltage measured during transmission
• Transceiver Unit: Shows status of the following units of the TRU:

– SISP10, signal processor board interfacing the SIHD8 boards
– SILVPS, Low Voltage Power Supply
– CPU, Interfaces the operator station, SISP10, external sensors and synchronization
– TX power
– LAN Driver
– Motion sensor

• Power Unit: Shows status of the High Voltage Power Units (HVPU) of the Transceiver
Unit:
– Safety Shutdown: Red if enabled by one or more switch knobs in front of the

HVPUs. If enabled, the HVPUs are deactivated and both the “TX power” status of
the Transceiver unit and the “ON” status of the HVPUs will turn red in this case

– ON: Ready to ping
– Synchronization: Green means the switching frequencies of the HVPUs are

controlled by SISP10
– Temperatures
– Voltages
Note

There is only one status common to all HVPUs. If one HVPU has an error, the status
will be red even if all but one unit is OK.

The status will be displayed in green, yellow or red as follows:
• Green – good data received
• Yellow – data is received, but with poor quality
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• Red – no data received
• Light green – no data expected (the above image is from a 32 channel transceiver)
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Detailed readings

Detailed readings are accessed from the View→Details menu.

The Detailed readings displays current values for each channel of each of the HD8
boards as follows:
• Input voltage 12V
• Analog 4.8V
• Analog 5V
• Aux voltage 3.3V
• Digital 1.2V
• Digital 3.3V
• Temperature °C
• High Voltage V

– This is the peak output voltage measured during transmission

In addition, some information from the CPU and SISP10 processing boards is shown.

The Power Unit section is not yet adapted to SBP 27. To retrieve information about the
HVPUs use the Built-in system test of the operator software.
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Log view

Log view is accessed from the View→Log View menu.

The Online Monitor software automatically write messages displayed in the Log View to
text files tagged with date and time.

The Log view window contains two log windows useful for debugging
• BITE Log: All messages related to Transceiver Unit (TRU) hardware status
• Output Log: All messages related to TRU activity

The Log view holds the following buttons:
• Filter setup: Applies to the BITE log only.
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Select the parameters and board(s) you want to register events for. For an SBP 27
with less than eight SIHD8 boards you must uncheck the boards you do not have.

• Clear log: Clear all previous events from the log
• Save log Save events in the log

Log size

Log size is accessed from the View→Log Size menu.

Use Log size to specify the size of your log files in terms of number of survey lines.
When given number of lines are reached and new log file will be generated.
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Technical references

This chapter describes the theoretical background and features relevant for SBP 27
Sub-bottom Profiler.

Topics
• Digital signal processing on page 157
• Main operational modes on page 162
• System operation on page 171
• Transmit waveforms on page 174
• File formats on page 177

Digital signal processing
To enhance the presentation of the information contents in the acquired data, various
processing steps are introduced. The simplest step is an amplitude scaling of the data.
Two scaling function are implemented. The first is in 1 dB steps and is only used for
interpolation between the 6 dB gain-steps selected in hardware. The other scaling
function is a multiplication by a factor which is given as a number between 0% and
100000%. The other main processing steps are described individually in the following
paragraphs.

Bandpass filtering
The SBP 27 system is very flexible regarding selection of output signature. When
operating in a noisy environment it is important to optimize the signal-to-noise ratio.
This can be done by bandpass filtering over a bandwidth that covers the spectrum of
the received signal.

The bandpass filtering is performed in the frequency domain by applying a window
to the complex Fourier transformed time series of the acquired signal and perform a
subsequent inverse Fourier transform. The window characteristic, which is displayed in
Figure 10, is defined by four frequencies: lowstop (LS), highpass (HP), lowpass (LP)
and highstop (HS). These frequencies are defining full stop and full pass points. The
transition between these points has a cosine shape.
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Figure 19 Characteristics of the digital bandpass filter

Deconvolution
There are various ways to increase the signal-to-noise ratio in the SBP 27 system. One
is to transmit coded wavelets. An example of such wavelet is the FM-sweep or chirp
signal. Typical for this wavelet is that the long duration in time increases the transmitted
energy. Without processing, the resolution will be reduced. In order to compress the
signal energy in time it has to go through a deconvolution process or a matched filter.
The filter used is described by the following formula:

F (f) =
W ∗ (f)

[W (f)]2 + c

whereW(f) is the complex Fourier transform of the transmitted wavelet, * indicates the
complex conjugated, and c is a stabilising factor for the filter depending on the power
spectrum of the wavelet and the noise power spectrum. The filter is weighted by the
current bandpass filter envelope. When the Fourier transform of the acquired data trace
is given by T(f) then the output of the filter will be given by

S (f) = F (f) ∗ T (f)

In an ideal case where the received wavelet is identical to an attenuated sample of the
transmitted wavelet and the noise level is negligible, W(f) = T(f) and c = 0. Substituting
into the expression for the deconvolution filter yields S(f) = 1 which is equivalent to a
delta pulse in time domain.

The deconvolution can also be applied to a normal Ricker pulse resulting in reduced
sidelobes around the central peak.
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Variable gain functions
There are two main reasons for using variable gain functions in the processing: Time
Variable Gain (TVG) is used to compensate for spherical spreading losses and signal
attenuation primarily in the sediments, while Automatic Gain Control (AGC) is used
for enhancing low level parts of the data trace on display and hardcopy. TVG maintains
amplitude information in the trace while AGC destroys the real amplitude information.

TVG follows a predefined gain curve as a function of time. Typical gain curves may
be proportional to 10•log R, 20•log R, 30•log R etc. where R is the distance from the
transducer. Time t is R/c where c is the speed of sound. The TVG can also be set up in
automatic mode where the gain curve is calculated based on the average signal level in
several sections along the trace.

AGC is a sliding scaling function where the scaling factor is the inverse of the average
signal amplitude in a window around the point to be scaled. The position in the window
of the point to be scaled can be selected by the operator. The result of this scaling is that
signal level in low level parts of the trace is amplified more than signals in high level
parts of the trace.

Stacking
Trace stacking or trace mixing is a process that is regularly used in multi-channel
seismic processing. In single channel systems, it is basically used to reduced influence of
uncorrelated noise in the trace. The processing is done on trace-by-trace basis where a
sample of the processed trace is the average of corresponding samples in 2 to N of the
previous traces. Sample number i in trace number k is given by the following expression

ski =
1
N

k􏽘

j=k− N
sji

where N is number of traces. Noise reduction is approximately proportional to √√√N. If the
sea floor or sub-bottom structures have steep and abrupt changes, care must be taken
using stacking processing since it tends to smear out such features.
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Swell filtering
Swell filtering is used if no external heave compensation is available, to handle the
influence of vertical vessel or transducer movements caused by the undulations of the
swell. In principle this is done by first performing sea floor detection on the received
data and then adjusts the trace up or down so that the position of the detected sea floor
matches the position detected in the previous trace. In order to allow for variation in
the bathymetry, an average of previous N detected sea floor locations is used as the
location in the trace where the last trace is shifted. Using a large N may result in loss
of details regarding the ability to follow the sea floor whilst a small N may not remove
the swell completely. N is a sort of time constant for the filter, which also depends
on the shot interval.

For a properly configured SBP swell filtering will not be necessary. The beamformer
performs real time heave compensation based on knowledge of transducer lever arms
and sensor input from the MRU.

Attribute calculation
In order to make interpretation of seismic signals easier, attributes can be calculated
based on a complex seismic trace analysis. The attributes of interest are

160 442094/B



Technical references

• Instantaneous amplitude or reflection strength
• Instantaneous phase
• Instantaneous frequency
• Apparent polarity
The complex trace is computed as

F (t) = f (t) + jf∗

where f is the real trace, j = √-1 and * indicates the complex conjugated.
The complex trace is calculated by inverse transforming the real part of the Fourier
transformed real trace multiplied by two. The various attributes are now calculated as
follows:
Instantaneous amplitude is given by

A (t) =
􏼂
f2 (t) + f∗2 (t)

􏼃 1
2 = |F (t)|

Instantaneous phase is given by

Θ (t) = arctan
􏼔
f∗ (t)
f (t)

􏼕

Instantaneous frequency is given by

ω (t) =
dΘ (t)
dt

Apparent polarity is defined as the sign of f(t) when A(t) has a local maximum. Positive
or negative sign is assigned assuming a zero-phase wavelet and a positive or negative
reflection coefficient, respectively.
The significance of the calculated attributes are described in the following:

Instantaneous amplitude
Reflection strength or instantaneous amplitude is independent of phase. It may have
its maximum at phase points other than peaks or troughs of the real trace, especially
where an event is the composite of several reflections. High-reflection strength is often
associated with major lithologic changes between adjacent sediment layers, such as
across non-conformities and boundaries associated with sharp changes in sea level or
decompositional environments. High-reflection strength also is often associated with
gas accumulation.

Instantaneous phase
The instantaneous phase emphasises the continuity of events. It is a value associated
with a point in time and thus is quite different from phase as a function of frequency
as given by a Fourier transform. Because phase is independent of reflection strength,
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it often makes weak coherent events clearer. Phase displays are effective in showing
discontinuities, faults, pinch-outs, angularities and events with different dip attitudes,
which interferes with each other.

Instantaneous frequency

The instantaneous frequency is a value associated with a point in time like the
instantaneous phase. Most reflection events are the composite individual reflections
from a number of closely spaced reflectors, which remains nearly constant in acoustic
impedance contrast and separation.

The superposition of individual reflections may produce a frequency pattern, which
characterises the composite reflection. Frequency character often provides a useful
correlation tool. The character of a composite reflection will change gradually as
the sequence of layers gradually changes in thickness or lithology. Variations, as at
pinch-outs and edges of hydrocarbon-water interface, tend to change the instantaneous
frequency more rapidly.

Apparent polarity

Apparent polarity is very sensitive to data quality. Interference may result in reflection
strength maximum occurring near a zero crossing of the seismic trace so the polarity may
change sign as noise causes the zero crossing of the trace or the location of the reflection
strength maximum to shift slightly. The analysis of apparent polarity assumes a single
reflector, a zero-phase wavelet and no ambiguity due to phase inversion. Bright spots
associated with gas accumulation in sediments usually have lower acoustic impedance
than the surrounding beds and hence show a negative polarity for reservoir top reflections
and a positive reflection for reflections from gas-to-water or gas-to-sediment interfaces.

Main operational modes
The main operational modes are selected by the runtime parameters Transmit mode
and Synchronization.

The various Transmit modes are:
• Off: In transmit mode Off the system is not transmitting (nor receiving). It is in a

standby mode.
• Normal: In Normal mode there will only be one single pulse in the water at a time

(multipath neglected).
• Burst: In Burst mode several pulses are transmitted before the return signal from the

first transmission is returned.
• Single pulse: Single pulse mode is not to be used during surveys. It allows the

transmission of a single pulse whenever this is desired.
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Synchronization mode
Synchronization of SBP 27 to other equipment is provided by external trigger inputs.
The purpose of synchronization is to avoid, or at least have control over, interference
with other acoustic systems.

In Synchronisation mode there is basically the choice between internal trigger (i.e. fixed
rate) and external trigger. Two external triggers inputs are available. One is being
connected to the EM, whilst the other method is to be connected to other external
equipment such as a synchronization unit.

Standard combinations of transmit mode and synchronization are discussed in the
following. But first it is necessary to introduce a few other runtime parameters:

Acquisition window: This parameter (unit milliseconds) specifies the length of the
acquisition window. This observation window must be long enough to collect all
interesting return signals. In order to reduce the amount of data to store during survey, it
may be sensible to reduce this window in areas with poor penetration.

Note that the operator specifies the desired window length after pulse compression.
When chirp pulses are employed, the actual acquisition window used internally by the
system must be lengthened by the amount of the pulse length in order to image the
desired window length properly.

Acquisition delay: This parameter specifies where to position the acquisition window
relative to the time of transmission. The position of the acquisition window should
normally be such that the first bottom return is located somewhere at the first half of
the acquisition window

Tip

If the depth measured relative the transducers is 75 m and the average velocity of sound
in the water column is 1500 m/s, the first bottom return will arrive after t = 2*75/1500
[m/(m/s)] = 100 ms. Note that we are working with two-way travel times! If the
acquisition window length is 40 ms, a suitable acquisition delay could be 90 ms

It is possible to have the acquisition delay calculated automatically either
1 from the depth detected by the bottom tracker of the SBP 27

or
2 from the depth input from EM EM 122/302 or another echo sounder
This feature is enabled by checking the check box Calculate delay from depth. Further
information about this feature is found in Calculate delay from depth on page 170.
To control which depth to use, see the description of the Depth selector on page 86.
Ping interval: This parameter is used to set the minimum/desired interval between
two consecutive pings. The actual ping interval used is displayed next to the
desired/minimum ping interval input by the user. The ping interval used is calculated
taking maximum power duty cycle, acquisition delay, acquisition window, pulse length
and maximum ping rate into consideration.
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Max burst pulses: Used by the operator to specify the maximum number of pulses per
burst. The actual number of pulses per burst is determined by the system, and it is
display beside the maximum number input by the operator.

Burst pulse delay: This parameter is calculated by the system, and it is the interval
between two transmissions in burst mode.

Steering parameters

This is introduced as a generic term for pulse length, acquisition window start and
acquisition window length. These parameters have the highest priority when timing
schemes are composed in the various modes discussed below.

Transmit cycle modes
When the sediment slope angle exceeds the beam width of an SBP the specular return
from sediment interfaces will be weak or even lost. The optional transmit cycle modes
are added in response to this challenge.

To activate one of these modes either select Cycle tilt angle or Cycle beam width from the
drop-down curtain

Each stage of the cycle provides a different way of imaging. To facilitate separation
of these into different echograms (and files) a transmit beam number is defined and
included in the raw file format. Also the number of TX beams (i.e. the number of stages
in the transmit cycle) is written in the raw file.

A SEG Y file will not contain more than one “transmit beam”; the data are split into as
many files as there are combinations of TX and RX beams (if all combinations are
logged). Still the transmit beam number and number of transmit beams are included
in the SEG Y files.

When the transmit cycle mode is “none” (i.e. the system is operated in the standard way)
the transmit beam number will be 0 (zero) and the number of transmit beams will be 1.
When the transmit cycle mode is active the beam numbers are all positive starting at 1.
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Cycle tilt angle

Make a “transmit swath” to cover along track slopes by cyclic scanning of the tilt angle.

Specify the desired number of ping in the cycle and the tilt step. Since the vertical beam
typically is the best you might want to have an odd number of beams symmetrically
around the vertical. A suitable tilt step can be equal to the beam width of transmit beam.
As an example: Using the full array of a 3 degree SBP transmitter with tilt step 3 degrees
and 5 pings in the cycle will cover well slopes in the range ± 3°x5 /2= ± 7.5°.

The transmit beam pointing most to the aft (with the most negative tilt angle) is number
1 and the beam number increases as the tilt angle increases; i.e. the beam with the largest
positive tilt angle will have the highest beam number.

Cycle transmit beam width

Keep the transmit beam vertical while varying the transmit beam width.

The menu above is the one available for a 3 degree SBP 27 system. For a 12 degree
system this transmit cycle mode is not available.

The narrowest beam will be transmit (TX) beam number 1. The TX beam number
increases with increasing TX beam width.

Normal mode and internal trigger
In normal mode, the transceiver unit transmits a single pulse and then wait for the return
signal. A new pulse will not be transmitted until the return signal from the previous
ping is acquired. Depending on the relation between operator specified ping interval
and the steering parameters, the SBP 27 may be considered as operating in one of two
submodes. If the steering parameters allow it, the SBP 27 will be pinging at a fixed
rate with the ping interval specified by the operator. If the user specified ping interval
is too short considering the steering parameters, the system will give the shortest ping
interval possible. In combination with the calculate delay from depth feature, this will
cause the system to be “free running”, which means that the ping rate in normal mode
will be as high as possible.
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Figure 20 Internally triggered normal mode: The SBP 27 allows the user to specify a
minimum ping interval (PIV). If feasible this ping interval will be provided (a). If the
ping interval is too short for the system to collect the desired return signal, the system
will provide the shortest ping interval (PIV) possible (b).

Normal mode and external trigger
The SBP 27 can be triggered from an external source in order to avoid (control)
interference between the SBP 27 and other acoustic systems.

In this mode, the SBP 27 will ping at a fixed rate provided the external trigger is running
at fixed rate. The SBP 27 will possibly ping at a lower, fixed rate than the one given by the
external trigger. This will be the case whenever the next trigger signal comes before the
system has finished acquiring data from the ping initiated by the previous trigger signal.

This is illustrated in figure below where we can see that for a given set of the steering
runtime parameters, increasing the rate of external trigger signal actually causes a
decrease in the ping rate of the SBP 27.
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Figure 21 Externally triggered normal mode: In this case the ping rate is determined
by external equipment (a). Once the SBP 27 has transmitted in response to a trigger
signal, it does not accept a new trigger until it has finished receiving the echo from the
previous transmission. Accordingly the ping rate of the SBP 27 might be lower than one
should expect from the external trigger signal (b)

Burst mode and external trigger
For hydrographic echo sounders, both multibeam and single beam, it should be
acceptable to have the SBP 27 transmit until the first bottom echo is returned. Using
burst mode, it is possible to have several pulses transmitted during this period which
is equal to the acquisition delay. This operational mode is illustrated in next figure.
After the last pulse in the burst is transmitted, the first observation window is returned.
The maximum (or desired) number of pulses in the period is specified by the operator,
and the system tries to squeeze in as many pulses as the steering parameters, power
duty cycle and maximum ping rate permit.

Of course, this will lead to non-uniform sampling of the bottom alongtrack. However,
the alternative in synchronized operation is to have just one ping per trigger pulse. Under
many circumstances this will not be sufficient to image sediments. We believe it is
better to have several short segments of high alongtrack resolution than to have uniform
probing alongtrack with poor resolution.
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Figure 22 Externally triggered burst mode: This mode may be useful when the SBP 27
is synchronized with equipment with long receptions windows; typically a multibeam
echosounder. It is assumed that the SBP 27 is allowed to transmit until the first bottom
return arrives. For each external trigger, the SBP 27 transmits as many burst pulses
as possible under given constraints such as maximum duty cycle of the transmitter and
the length of the reception windows. This gives a piecewise much denser sampling of
bottom than the externally triggered normal mode would.

Burst mode and internal trigger
When the system is triggered internally, there is no need to limit the period of
transmission to the acquisition delay of the first ping in the burst. We can have TX pulses
and acquisition windows interlaced within one burst, as shown in figure (a) below. In
principle the number of pulses requested by the operator can always be provided. In
practice we limit the number of pulses in a burst to the number that fit in the water
columns (which is three in figure (a)). The reason for this will be given shortly.
If we were to finish one burst before continuing with the next, the result would be
non-uniform probing of bottom alongtrack as in the externally triggered burst mode.
Unless runtime parameters affecting timing have been changed, we can continue with
the next burst before the previous burst is finished as shown in figure (b). In this way,
bottom will be probed at a uniform rate provided vessel speed is constant. We refer to
this operation mode as multi-pulse. The multi-pulse mode can provide high alongtrack
sampling rate almost independent of depth and vessel speed.
Sometimes the acquisition delay changes so much that the timing of the burst pulses
has to be changed. In order to avoid collisions between periods of transmission and
periods of reception (which is necessary because we have combined transmitter/receiver
channels), the SBP 27 will have to finish one burst before continuing with the next. This
is illustrated in figure (c), where the burst interval is recalculated during transmission of
burst number N. We see that in this case the system finish burst number N completely
before continuing with burst number N+1.
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To allow this adjustment of the acquisition delay to take effect as soon as possible, the
number of pulses allowed per burst will not exceed the number of pulses that can be
transmitted during one acquisition delay. As a consequence, the transmit period do not
overlap with the corresponding reception period.

Note

Unless depth is input externally, it is recommended not to start pinging in burst mode.
We recommend to start pinging in normal mode, and stay in this mode until bottom is
found. Then switch to burst mode.

Note

There is a chance that the second return from one pulse will arrive in the reception
window of another. Due to strong attenuation of the direct signal sub-bottom, the
strongest parts of the second return may well be stronger than parts of the primary echo.
Hence the second return may appear as sediments with high reflection coefficients.
Generally it may be hard to tell when this happens. The exception is in rough weather,
where these “false” sediments will be undulating because they will not be properly heave
corrected. If the sub-bottom image changes “dramatically” when changing operating
mode to burst mode, this is an indication of a problem with second returns. To get out of
this situation, change the number of burst pulses (or change an essential parameter) in
order to obtain a different burst interval.
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Figure 23 Internally triggered burst mode: In (a) we see how a timing scheme can be
composed so that the period of transmissions can overlap with the corresponding period
of listening. By allowing the next burst to start once the transmissions of the previous
burst has finished, we may have a high uniform ping rate even in deep waters as shown
in (b). If the acquisition delay changes, or the reception window is increased/-decreased,
the timing scheme may have to be changed and the transmissions will halt for an
acquisition delay as shown in (c).

Calculate delay from depth
There is a checkbox with this text on the runtime parameters property sheet, and the
delay this is referring to is the acquisition delay. Once the SBP 27 has detected bottom,
the range found by the bottom tracker can be used to position the acquisition window.
Two user configurable parameters determine how this feature will behave. There is the
delay hysteresis which determines how much the bottom range must change before the
acquisition delay is adjusted, and there is the bottom screen position which is controlling
where to position bottom in the acquisition window.
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Unless external input depth/bottom range is used, the bottom tracker of the SBP 27 must
be locked on to bottom before this feature can be enabled. That is; initially the operator
must manually enter an acquisition delay and an acquisition window length that will
contain the echo from the bottom. Once the bottom tracker is locked to bottom, the
automatic mode can be enabled.

With bottom range input from EM 122/302or another echo sounder, this automatic
adjustment of acquisition window will function instantly.

We recommend to have this option enabled during most surveys. An exception is when
the bottom tracker and/or the externally input depths are unreliable. This may be the case
when the seafloor is changing rapidly or in rough weather conditions when air bubbles
may block the acoustic signals. In such cases it may be necessary to enter the acquisition
delay manually and perhaps also to use a long acquisition window.

Depth selector
The depth selector is used to choose the source to use for automatic adjustment of the
acquisition delay. This selector is found under Data selectors→Depth selector located
under the System tab. The sequence of the depth from items determines the priority of the
depth sources. Further down in the chain means higher priority, i.e. when depth from
NMEA is below depth from bottom tracker, the preferred source of depth information is
depths from the NMEA reader.

System operation

Array geometry and related properties
The smaller the transducer array, the wider the beam width. The transducer arrays of
most sub-bottom profilers have much smaller dimensions and therefore much wider
beam widths than the SBP 27 do. The SBP 27 achieves a small footprint with a Mills
cross configuration just as the EM 122/302 does. In fact, the SBP 27 shares the receiver
array with the EM 122/302.

The beamwidth is inversely proportional to frequency. The SBP 27 operates at about
one third of the frequency of the EM122 and one seventh of the frequency of the EM
302. This implies that a 1° EM 122 receiver array will naturally lend itself to SBP 27
as a 3° receiver and a 1° EM 302 receiver array will naturally lend itself to SBP 27
as a 7° receiver. The hydrophone signals are amplified and bandpass filtered (cut-off
frequencies at 2 kHz and 7kHz) in the EM 122/302 preamplifier, and then routed to
the SBP 27 RX/TX junction box.

Refer to System diagram on page 15

To obtain a symmetric footprint the transmitter array should have a similar length
as the receiver array. The 3° transmitter array of the SBP 27 has 96 transducers in a
32 x 3 configuration. The three transducers acrosstrack must be weighted in order to
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obtain a suitable beam width and to reduce sidelobe levels. We obtain this by using two
transmitter channels per three elements; the centre element has a dedicated channel while
the other channel is shared by the two outer elements.

The footprints of the EM 122/302 and SBP 27 arrays are outlined in figure Footprints on
page 173. The transmitter arrays are large in the alongtrack dimension and consequently
they produce narrow footprints alongtrack. The receiver array is large in the acrosstrack
dimension and consequently the receiver footprint is narrow acrosstrack. The footprint
of the system is the product of the transmitter footprint and the receiver footprint.

Attitude compensation
Echoes are mainly caused by specular reflections which are strong close to normal
incidence. Because of the narrow beamwidths of the SBP 27, attitude corrections are
necessary in order to maintain strong echoes when the ship is pitching and rolling.
Both the transmit beam and the receiver beams are tilted, accounting for the array
installation angles and the ships attitude, aiming at keeping the beams vertically in
global coordinates.

The data are heave corrected, accounting for heave at transmission and reception.

Bottom slope corrections
In sloping terrain it is possible to have the EM 122/302 calculate the bottom slopes
alongtrack and acrosstrack. This information is passed on to the SBP 27 operator unit,
and the operator can choose to use this information to the steer the beams in order to
obtain normal incidence. In this way it is possible to maintain strong specular echoes
from the seabed and sediments parallel to the seabed in spite of the narrow beamwidth
of the SBP 27.

Rough terrain
When a plane is a poor approximation for the sea floor, the bottom slope corrections will
not work well. In such a situation, the SBP 27 offers transmit/receive modes with wide
angles. In these wide beam modes it is more likely that a portion of the transmit beam
will give a specular return, and that the receive beam(s) will be able to detect this return.

Multiple receiver beams
Because the receiver channels are sampled independently, we can generate many receiver
beams for each set of receiver data. This feature may be used in rough terrain, in order
to intercept a specular return from an unknown direction. The operator can specify the
number of beams (max. 11) and a fan width (max. 30°). The beams are spaced equiangle
within the specified fan width.

Also, sediments sub-bottom need not be parallel to the seafloor. Accordingly, a different
receiver beam than the one with normal bottom incidence may receive the strongest
specular return from sub-bottom interfaces.
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We expect this feature to be useful for the detection of buried objects. As shown in
figure Footprints on page 173, the transmit beam is wide acrosstrack. The transmitted
energy will penetrate into bottom over the width of the transmit footprint. If an object
of sufficient target strength is located sub-bottom outside the beam collecting specular
returns, but inside the 30° wide footprint of the transmitter, it should be possible to detect
this object in one of the outer receiver beams.

Note

Above description applies to the largest system configurations.

Figure 24 Footprints
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Transmit waveforms
We can categorize the transmit waveforms into non-chirp signals and chirp signals.
Non-chirp signals have a range resolution given by their pulse length. Chirp signals
(frequency modulated signals) has a range resolution roughly given by the inverse of
the sweep range. To obtain the range resolution in the image, one must use matched
filter (pulse compression) in the processing.

For non-chirp signals we recommend bandpass filtering the data to remove noise outside
the bandwidth used by the signal

In the following the various signals are described in more detail. For an accurate
description of cw and chirp pulses one must also consider the amplitude shaping of the
signals. Amplitude shaping is described in a separate section after a description of the
unshaped signals.

Non-chirp signals

No pulse

Pulse parameters: None

Choosing No pulse enables listening without pinging. This “transmit waveform” is
used for testing. For instance you may use this mode to listen for interference from
other acoustic systems.

Ricker pulse

Pulse parameters: Source power

The Ricker pulse is a short pulse of high bandwidth. There is no matched filter for the
Ricker pulse; the echo directly provides maximum resolution. A bandpass filter (2.5 kHz
to 7 kHz) should be applied in the processing.

CW pulse

Pulse parameters: Source power, centre frequency fc, pulse length T , pulse shape S.

The CW pulse is a signal consisting of a sinusoidal wave of frequency fc enclosed by
an envelope of duration T . Assuming a rectangular envelope and unit amplitude the
CW pulse is

SCW (t) = sin (2πfct) , 0 ≤ t ≤ T

The bandwidth bw of a CW pulse is in principle given by T − 1. The properties of the
electronics and the transducers, and also application of a pulse shape parameter S≠0, will
in practice make bw < T − 1. The shape of the envelope can be manipulated by the pulse
shape parameter S, see Amplitude shaping – and pulse shape parameter on page 176.
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Chirp signals
Pulse parameters: Source power, sweep low frequency fL, sweep high frequency fH ,
pulse length T , pulse shape S.
By sweeping the carrier frequency of a pulse we can make long pulses of high
bandwidth. Compared to short pulse of the same bandwidth and the same amplitude, this
gives an increased signal-to-noise ratio because there will be more energy in each pulse.
Whenever the image shows that the signals are weak, you should first check that the
transmitter is operating at the maximum allowed power level. If that is the case, one may
increase the pulse length to see if this improves the quality of the image. Because of the
movement of the ship during transmission and reception, the pulse shape is distorted and
the matched filter result will be distorted. In practice it is therefore far from guaranteed
that an increased pulse length will provide a better signal-to-noise ratio.
In principle a sweep up and a sweep down should result in identical images. One
might, however, prefer to use one direction rather than the other to reduce interference
to/from other equipment applying chirps in the same frequency range. Also, during
post-processing, if matched filter is applied after time variable gain, frequencies at the
end of the sweep is amplified more than frequencies at the start of the sweep.

Linear chirp up/down
First we define:

α =
fH − fL

2T

fc = fL +
fH − fL

2

Then we write the expression for the linear chirp up/down signals with rectangular
envelopes and unit amplitudes as:

SLMF,Up/Down (t) = cos (2π {fc ± α (t − T )} t) , 0 ≤ t ≤ T

The instantaneous frequency is given by the time derivative of the phase:

f (t) =
d

dt
({fc ± α (t − T )} t) = fc ± α (2t − T ) , 0 ≤ t ≤ T

Hyperbolic chirp up
The hyperbolic chirps are less exposed to Doppler distortion than linear chirps.
Compared to the linear chirps, the hyperbolic sweep up spends more time at the lower
frequencies. This may provide better penetration at the expense of poorer resolution.
We define:

G = 2π
fHfL
fH − fL

T
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The expression for the upsweep hyperbolic chirp signal with rectangular envelope and
unit amplitude is:

SHFM,Up (t) = cos
(
SHFM,Up (t)

􏼁
=

cos
􏼒
− G× ln

􏼒
1 − (fH − fL)× t

fH × T

􏼓􏼓
, 0 ≤ t ≤ T

The instantaneous frequency is given by the time derivative of the phase:

f (t) =
1

2π
d

dt

􏼒
− G× ln

􏼒
1 − (fH − fL)× t

fH × T

􏼓􏼓

=
fHfLT

fLt+ fH (T − t)
, 0 ≤ t ≤ T

Hyperbolic chirp down
We define (as for the hyperbolic upsweep):

G = 2π
fHfL
fH − fL

T

The expression for the hyperbolic chirp down signal with rectangular envelope and
unit amplitude is

SHFM,Down (t) = cos
􏼒
G× ln

􏼒
1 +

(fH − fL) t
fLT

􏼓􏼓
, 0 ≤ t ≤ T

The instantaneous frequency is given by the time derivative of the phase:

f (t) =
1

2π
d

dt

􏼒
G× ln

􏼒
1 +

(fH − fL) t
fLT

􏼓􏼓
=

fHfLT

fHt+ fL (T − t)
, 0 ≤ t ≤ T

Amplitude shaping – and pulse shape parameter
To generate a signal with rectangular envelope would require infinite bandwidth. In
practice the pulse is shaped on transmission by the transfer function of the transmit
transducers. There is also a minor shaping on reception caused by the hydrophones.

In addition to these unavoidable contributions to distortion of the transmit pulse, there is
a built-in minimum rise and fall time in the transmitter in order to protect the electronics
against damage. An effect of the electronic shaping is less deviation between the applied
voltage signal and the acoustic signal because the shaped signal is physically more
realizable.
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The pulse shape parameter
The value of the pulse shape parameter stored with the beam data reflects the electronic
shaping of the transmit signal applied by the transmitter electronics. Its value is in
percent and it specifies how large part of the pulse length will be used for shaping. If
for instance 50 % shaping is specified, the transmitter calculates a Hanning window of
length half the pulse length, an the first half of the Hanning window is used for making a
smooth transition from zero to maximum power level, and the second half is used for
making a smooth transition from maximum to zero power level.
In the runtime menu, the value of the pulse shape parameter can be adjusted automatically
with changing pulse lengths. The value will then be set to the minimum value allowed
by the transmit electronics. Unselecting this automatic adjustment, the operator may
increase the value of the pulse shape parameter. The reason for doing this would be a
desire to reduce sidelobes in range out of the matched filter process. This is achieved at
the expense of reduced range resolution

File formats
Beam data logged by the operator software can be logged either in the TOPAS/SBP raw
file format or in a SEG Y format.

The raw file format
In the following the data structure used for storing SBP 27 data in the RAW format is
shown. The structure contains all necessary information for replaying a file containing
data from a survey line.
The block length in the file varies with number of samples in an acquisition window
(data trace). The size of one ping is:
384 + #samples * 4 bytes
In the table below the following definitions are used:
• byte variables are defined as 1 byte
• short variables are defined as 2 bytes
• int variables are defined as 4 bytes
• float variables are defined as 4 bytes.
• double variables are defined as 8 bytes

Table 12 The raw file format

Bytes Data type Variable name Comment
0 short trace in file starts at 1

2 short format 3

4 short year yyyy

442094/B 177



Kongsberg SBP 27

Table 12 The raw file format (cont'd.)

Bytes Data type Variable name Comment
6 short month

8 short day

10 short hour

12 short minute

14 short sec

16 short msec

18 byte[16] filename
34 byte[18] line number (or line name)
52 byte[20] survey name

72 short channel number 0

74 float power attenuation dB relative maximum

78 float ping interval [ms]

82 short pulse form 0 = no pulse
2 = ricker
3 = LFM
8 = HFM

84 short HRP compensation Always on

86 float sec_Freq

90 float sweep start [Hz]

94 float sweep stop [Hz]

98 float pulse length [ms]

102 short correlated 1 = not correlated
2 = spiked/matched

104 float beam dir along TX tilt angle re MRA

108 float scan sec along TX fan sweep width
112 float scan step along TX beam spacing

116 float beam dir athwart RX roll angle relative MRA

120 float scan sec athwart RX fan width
124 float scan step athwart RX beam spacing

128 double latitude DDMM.mmmm

136 double longitude DDDMM.mmmm

144 double zone lon

152 float heading Vessel heading

156 float speed [m/s] Vessel speed

160 short system 0 = geo. Coord (Lat/Lon)
1 = UTM

162 short zone number UTM zone no.

164 float depth [m] Depth from transducer
168 float TX heave [m] Heave value at transmission

172 float TX roll Roll value at transmission

176 float TX pitch Pitch value at transmission

180 float RX heave [m] Heave value at reception

178 442094/B



Technical references

Table 12 The raw file format (cont'd.)

Bytes Data type Variable name Comment
184 float RX roll Roll value at reception

188 float RX pitch Pitch value at reception

192 float delay Acquisition delay

196 float length [ms] Trace length

200 float sample rate [Hz]

204 float gain Front end gain

208 short spare

210 float hp_filter High pass ( low cut) frequency
214 float lp_filter Low pass (high cut) frequency
218 float roll dir RX roll angle relative vertical

222 float pitch dir TX pitch angle relative vertical

226 float transducer draft
230 short beam width TX 0 = full array

1 = focused
2 = wide 10
3 = wide 20
4 = wide 30
5 = half array
6 = quarter array

232 short beam width RX 0 = full array
1 = focused
2 = wide 10
3 = wide 20
4 = wide 30
5 = half array
6 = quarter array

234 short RX beam number Centre beam is always 0 (neg.
ones to starboard)

236 short number of beams Odd number <= 11
238 short pulse shape [%]
240 float sound speed [m/s]
244 int trace in survey starts at 1 when a new survey

name is given
248 int trace in line reset to 1 when a new line name

is given
252 int TRU ping number ping number since transceiver unit

startup
256 float RX Sensitivity -XX dB re (approx)
260 float source level Maximum for system
264 short External delay From CODA navigation string
266 int Event mark counter From CODA navigation string
270 float External kilometerpoint From CODA navigation string
274 short TX beam number Used in transmit cycle mode

276 short Number of TX beams Used in transmit cycle mode

278 short System serial number For future use
280 short Number of TX channels 16,32 or 64
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Table 12 The raw file format (cont'd.)

Bytes Data type Variable name Comment
282 short Number of RX channels 16,32 or 64

284 float power attenuation target dB re maximum. May differ from
power attenuation (bytes 74-77) if
mammal protection or automatic
power adjustment is enabled.

288 byte Synchronization 0:None, 1:Trig 1, 2: Trig 2

289 byte Transmit cycle mode 0:off, 1:beam width, 2:tilt
290 byte Spare
291 byte Composite beam number >0 for a composite beam
292 short Composite filter
294 byte[78] Spare bytes
372 int trace size N Used when number of samples >=

64k (k=1024)
376 short trace size N Used when number of samples

<64k
378 float[N] Data N

378+4*N byte[6] Sonar model SBP120 or SBP300

The SEG Y file format

SBP 27 use of the SEG Y format
We follow revision 1 of the SEG Y format , but we do not make use of the option of
having variable length of traces within a file. Nor do we make use of the extended textual
headers. The composition of an SBP 27 SEG Y file is as follows:
• A 3200 byte textual file header
• A 400 byte binary file header
• 3. Repeated entries of

a a 240 byte binary trace header followed by
b a data trace

The first 3200 byte Textual File Header record contains 40 lines of textual information,
providing a human-readable description of the seismic data in the SEG Y file. This
information is free form.
The binary file header contains information that applies to the whole SEG Y file.
The binary trace header contains trace attributes, which are defined as two-byte or
four-byte, two’s complement integers.
This revision is described in detail in the document
SEG Y rev 1 Data Exchange Format
SEG Technical Standards Committee
Release 1.0, May 2002
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(c) 2001, Society of Exploration Geophysicist

Editors: Michael W. Norris and Alan K. Faichney

Note

The SEG Y format does not include all of the parameters stored in the native RAW format
(for instance vessel speed, roll, pitch and heave). If this information is of interest, the
raw format described in the previous section must be used.

Note

The SEG Y file extension is configurable to either sgy, segy, or seg in the data loggers.

Note

Several RX beams into a single SEG Y file has to our knowledge NOT been used by SBP
27 users. As a consequence of this the various RX beams are separated into individual
files when logging.

The SEG Y binary file header

Table 13 The SEG Y binary file header

Offset Data type Variable name/Fixed values Comment
3201 int job identification number / 0
3205 int line number / 0
3209 int reel number / 1
3213 short number of beams per ping The number of beams may be 1,

3, 5, 7, 9, or 11
3215 short number of auxiliary traces per

ensemble / 0
3217 short sample interval in microseconds NOTE: Not recommended for use

due to insufficient time resolution.
Use sampling frequency located
at offset 3263

3219 short as above

3221 short number of samples per trace
3223 short as above

3225 short data sample format code / 3 or 5 3 = 2-byte, two’s complement
integer
5 = 4-byte IEEE floating point

3227 short number of RX beams per ping Same as 3213
3229 short trace sorting code / 1
3231 short vertical sum code / 1
3233 short sweep frequency start [Hz], zero if Ricker or ”no pulse”
3235 short sweep frequency end [Hz], zero if Ricker or ”no pulse”
3237 short sweep length [ms] zero (0) if non-chirp signal
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Table 13 The SEG Y binary file header (cont'd.)

Offset Data type Variable name/Fixed values Comment
3239 short sweep type 1: LFM & CW,

3: HFM,
4: Ricker and ”noPulse”

3241 short trace number of sweep channel / 0
3243 short sweep taper length start /0 See pulse shading parameter at

offset 3525
3245 short sweep taper length end /0 See pulse shading parameter at

offset 3525
3247 short taper type /2 2=Hanning (Cosine squared)
3249 short correlated data 1 = no

2 = yes
3251 short binary gain recovered / 2 1 = yes

2 = no
3253 short amplitude recovery method / 1 1 = none

3255 short measurement system / 1 1 = Meters

3257 short impulse signal polarity /2
3259 short vibratory polarity code /1 1 = 337.5° to 22.5°
3261 short spare

3263 int sampling frequency [Hz]

3267 short[116] spare

3501 short SEG Y format revision / 0x0100
3503 short fixed length trace flag / 0 or 1 0 = Variable trace length

1 = Fixed trace length
3505 short number of extended textual

headers / 0
3507 short power attenuation relative

maximum
[dB]

3509 short RX fan width [1/10 of degrees]
3511 short RX beam spacing [1/10 of degrees]
3513 short Number of TX beams
3515 short TX beam number

3517 short Beam width TX 0 = full array
1 = focused
2 = wide 10
3 = wide 20
4 = wide 30
5 = half array
6 = quarter array

3519 short Beam width RX 0 = full array
1 = focused
2 = wide 10
3 = wide 20
4 = wide 30
5 = half array
6 = quarter array

3521 short Number of TX channels 16, 32, or 64

3523 short Number of RX channels 16, 32, or 64

3525 short TX pulse shading % of pulse length
3527 short[37] Spare
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The SEG Y binary trace header

Table 14 The SEG Y binary trace header

Bytes Data type Variable name/Fixed values Comment
1–4 int trace no. in line reset to 1 when a new line name

is given
5-8 int trace no. in file starts at 1 in every file
9-12 int trace no. in survey starts at 1 when a new survey

name is given
13-16 int transceiver ping no. starts at 0 when the transceiver

unit is first switched on and is
incremented by one for every
transmission. Reset of the TRU
will also reset this counter

17-20 int energy source point number /0
21-24 int ensemble number / 1
25-28 int beam number Centre beam is always 0. Legal

values are from –(NB-1)/2 to
(NB-1)/2 where NB is the number
of beams

29-30 short Trace id code / 1
31-32 short number of vertical sum traces / 1
33-34 short number of horz. stacked traces / 1
35-36 short data use / 1
37-40 int distance center src to receiver / 0
41-44 int receiver group elevation / 0
45-48 int surface elevation at src / 0
49-52 int transducer draft unit meter (as given by 3255-3256

in binary file header) divided by
scalar at offset 68

54-56 int datum elevation at recvr group / 0
57-60 int datum elevation at src / 0
61-64 int depth unit meter (as given by 3255-3256

in binary file header) divided by
scalar at offset 68

65-68 int water depth at group / 0
69-70 short elevation scalar / -100 Fixed gain to be applied to values

in bytes 41-68 of the trace header.
(A negative sign means gain =
1/100, a positive sign means gain
= 10)

71-72 short coordinate scalar / -1000 Gain to be applied to values in
bytes 73-88 and 181-188 of the
trace header. Depending on
coordinate units, bytes 89-90. (A
negative sign means gain = 1/100,
a positive sign means gain = 10)
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Table 14 The SEG Y binary trace header (cont'd.)

Bytes Data type Variable name/Fixed values Comment
73-76 int X If the coordinate units are in

seconds of arc, the X values
represent longitude and the Y
values latitude. A positive value
designates east of Greenwich
Meridian or north of the equator
and a negative value designates
south or west.

77-80 int Y

81-88 long 0

89-90 short 1 or 2 1 = length [m], 2 = seconds of arc
91-104 short[7] 0

105–106 short external delay From CODA navigation string
107-108 short 0

109-110 short acquisition delay time in ms from transmission to
start of recording

111-114 int 0

115-116 short number of samples trace length

117-118 short sample interval in microseconds. NOT
RECOMMENDED USED;
USE sample rate found at offset
3263 of the binary file header

119-120 short 1 fixed instrument gain
121-122 short 0 instrument gain [dB] (value

approx. 21)
123-124 short 0

125-126 short correlated 1 = no, 2 = yes

127-128 short chirp start frequency Hz

129-130 short chirp stop frequency Hz

131-132 short chirp length unit milliseconds (will be incorrect
if the pulse length is different from
an integer number of milliseconds)

133-134 short sweep type 1 = linear chirp & CW
3 = hyperbolic chirp
4 = ricker & “no Pulse”

135-138 int 0

139-140 short 3 3 = hanning,
degree of tapering determined by
the pulse length and the pulse
shape parameter.

141-148 long 0

149-150 short 2000 lower cut-off frequency (-3dB) of
preamplifier in Herz

151-152 short 8000 upper cut-off frequency (-3dB) of
preamplifier in Herz

153-154 short 18 low-cut slope (dB/octave)
155-156 short 30 high-cut slope (dB/octave)
157-158 short year
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Table 14 The SEG Y binary trace header (cont'd.)

Bytes Data type Variable name/Fixed values Comment
159-160 short day of year
161-162 short hour

163-164 short minute

165-166 short second

167-168 short time basis code/ 2 2 = GMT
169-196 int[7] 0

197-200 int event mark counter From CODA navigation string
201-202 short 0

203-204 short trace value measurement unit / 2 2 = volt

205-210 byte[6] transduction constant Receiving sensitivity level:
Transduction Constant. The
multiplicative constant used to
convert the Data Trace samples to
the Transduction Units (specified
in Trace Header bytes 211-212).
The constant is encoded as a
four-byte, two’s complement
integer (bytes 205-208) which
is the mantissa and a two-byte,
two’s complement integer (bytes
209-210) which is the power of
ten exponent (i.e. Bytes 205-208
* 10**Bytes 209-210). TO DO

211-212 short transduction units / 1 (= Pascal) trace value unit after multiplication
by the transduction constant.

213-214 short 0

215-216 short time scalar / 1 Scalar to be applied to times
specified in Trace Header bytes
95-114 to give the true time value
in milliseconds

217-218 short source type/orientation / 5 (1) 1 = vibratory vertical orientation
5=impulsive-cross-line

219-222 int RX roll angle re vertical in tenth of degrees
223-224 short 0

225-230 source level / 0
231-232 short measurement unit / 3 3 = Pascal

233-236 int TX pitch angle re vertical in tenth of degrees
237-240 float Kilometer point KP From CODA navigation string

NOTE: Breach of SEG Y standard
that all number should be 2’s
complement integers.
Note: Use of bytes 237-240 is
changed since OPU sw version
1.5.3. Information of TX/RX beam
widths are moved to the binary file
header
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Datagram formats

The communication between the SBP 27 Sub-bottom Profiler and external devices is
performed through an interchange of datagrams. This chapter describes the SBP 27
datagrams.
For more information about the EM 122/302 datagrams, refer to the EM datagram
manual, doc. no. 160692.

Topics
• SBP 27 Datagram formats on page 186
• Navigation input on page 188
• Attitude data on page 194
• Depth – bottom – slope and sound velocity data on page 196
• Remote control datagram on page 198

SBP 27 Datagram formats
Overview
The following datagram type is included:
• Navigation input: Data received from external navigation (positioning) systems.
• Attitude input: Data received by the transceiver unit from an external motion sensor.
• Depth, bottom slope and sound velocity inputs: Data received by the operator station

from the EMs. Optionally, depht may be received from a single beam echo sounder.

Description of the datagrams
The message part of the datagram is divided into several data fields, each consisting of
one or more data bytes. The message part is described according to this form:

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
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Message contents and definitions
1 Description: Short-form description of a data field.
2 Res: Resolution.
3 Units: Defines how to interpret the contents of a data field. The contents are

described either by function or by units of measurement. A field may contain one
or more units.

4 Format:

Note

This document uses a number and a lowercase h to describe a hexa-decimal value.
Example: 02h is equal to 2 in hexadecimal representation.

This data field defines the coding of each unit. Two coding methods are used:
• ASCII
• BINARY

ASCII (American Standard Code for Information Interchange)
ASCII values are transmitted with the most significant byte first, i.e.:
Transmitted value 1234 = 31h32h33h34h
• Byte 1: 31h
• Byte 2: 32h
• Byte 3: 33h
• Byte 4: 34h
ASCII numeric values may be signed or unsigned. A signed value has a + (positive)
or a - (negative) in its first byte. The value is signed if the table field valid range
includes both positive and negative values.
ASCII numeric values may be with or without decimals. Decimal no-tation is either
positional or by a decimal character. The decimal nota-tion is positional if the
maximum valid value, not counting the deci-mal, is equal to the number of bytes
available. Otherwise the value is given with a decimal point (.) included. The
position of the decimal point is given in the field valid range.

BINARY
Binary values are transmitted with the least significant byte first, i.e.:
Transmitted value: 1234 = 04D2h
• Byte 1: D2h
• Byte 2: 04h
Binary values may be signed or unsigned. A signed negative value is given in
two’s complement representation. Unsigned values may use all bits for positive
representation of a number. The value is signed if the field valid range includes both
positive and negative values.

5 Bytes: The bytes field gives the number of bytes for one unit in column marked #,
and the total number of bytes for a field in column marked Σ.
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6 Valid range: The valid range field defines a units valid range in the format defined by
the format field. Text enclosed by <> is used for describing the contents and not the
actual value (i.e. <TEXT> is a text string consisting of any character in the current
format). _ is used as notation for a space.

7 Note: Corresponds to notes applicable to the table.

Navigation input
The SBP 27 Sub-bottom Profiler supports input from a range of positioning systems.
This document describes the datagram formats accepted by the TOPAS series.

Positioning datagrams are accepted on the RS-232 serial line on the multiport connection
box supplied with the Operator Unit.

Recommended serial port setup is 4800 baud, 8 data bits, 1 stop bit, no parity, except
where noted. This baud rate is high enough for the accuracy required and the necessary
throughput, and it is low enough to avoid errors that might occur due to computer
workload.

The following formats are accepted:
• Simrad 90 (Position, heading and speed)
• NMEA 0183

– GLL (Position)
– GGA (Position)
– RMC (Position and speed)
– HTD (Heading)
– VTG (Speed)

• CODA navigation string

Simrad 90 position input
This input format is supported by all systems. It is the recommended format with the
TOPAS sub-bottom profiler.

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address — talker identifier

sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
S90

Old format:
xxxxx

Date 1
1
1
—

DD-days
MM-months
YY-years
field separator

ASCII
ASCII
ASCII

2
2
2
1

7 1–31
1–12
0–99
,
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BytesDescription Res Units Formats
# Σ

Valid range Note

Time 1
1
1
0.01
—

HH-hours
MM-minutes
SS-seconds
hh-seconds

ASCII
ASCII
ASCII
ASCII

2
2
2
1

9 0–23
0–59
0–59
0–99
,

Latitude 1
0.001
—
—

degrees
minutes
North/South
field separator

ASCII
ASCII
ASCII
ASCII

2
7
1
1

11 0–90
0–59.9999
N or S
,

Longitude 1
0.001
—
—

degrees
minutes
East/West
field separator

ASCII
ASCII
ASCII
ASCII

3
7
1
1

12 0–180
0–59.9999
E or W
,

UTM Northing 0.1
—

meters
field separator

ASCII
ASCII

11
1

12 0–xxxxxxxxx.x

UTM Easting 0.1
—

meters
field separator

ASCII
ASCII

9
1

10 0–xxxxxxx.x

UTM zone no 1
—

time zone
field separator

ASCII
ASCII

2
1

3 1–60
,

UTM zone longitude 1
0.001
—
—

degrees
minutes
East/West
field separator

ASCII
ASCII
ASCII
ASCII

3
7
1
1

12 0–180
0–59.9999
E or W
,

1)

System 1
—

—
field separator

ASCII
ASCII

1
1

2 0–2 , 2)

Q factor 1
—

—
field separator

ASCII
ASCII

1
1

2 0–9
,

3)

Speed 0.1
—

m/s
field separator

ASCII
ASCII

4
1

5 0–99.9
,

4)

Heading 0.1
—

degrees
field separator

ASCII
ASCII

5
1

6 0–360.0
,

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Notes
1 The UTM zone longitude field is only valid if East/West is set to E or W
2 Determines which co-ordinate system is valid:

• 0 = lat/long
• 1 = UTM Northern hemisphere
• 2 = UTM Southern hemisphere

3 The Q factor should be related to positioning standard deviation as follows:
• 9 = <1m
• 8 = <3m
• 7 = <10m
• 6 = <30m
• 5 = <100m
• 4 = <300m
• 3 = <1000m
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• 2 = <3000m
• 1 = <10000m
• 0 = not valid position

4 This speed may be used for estimation of horizontal distance in display

NMEA 0183 position input
The GLL, GGA, RMC, HDT and VTG datagrams are supported on all systems.

Table 15 GLL structure

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address —

—
—

talker identifier
sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
GLL
,

Latitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

2
3-n
1

6-n 0-90
0-59.99
,

1)

Hemisphere —
—

North / South
field separator

ASCII
ASCII

1
1

1
1

N or S
,

Longitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

3
3-n
1

7-n 0-180
0-59.99
,

1)

Hemisphere — East / West ASCII 1 1 E or W

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Table 16 GGA structure

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address —

—
—

talker identifier
sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
GAA
,

Time 1
1
1
—
1
—

HH–hours
MM–minutes
SS–seconds
separator
hh–hundreds
field separator

ASCII
ASCII
ASCII
ASCII
ASCII
ASCII

2
2
2
0-1
0-2
1

6-10 0-23
0-59
0-59
.
0-99
,

1)
2)

Latitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

2
3-n
1

6-n 0-90
0-59.99
,

1)

Hemisphere —
—

North / South
field separator

ASCII
ASCII

1
1

1
1

N or S
,
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Table 16 GGA structure (cont'd.)

BytesDescription Res Units Formats
# Σ

Valid range Note

Longitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

3
3-n
1

7-n 0-180
0-59.99
,

1)

Hemisphere — East / West ASCII 1 1 E or W

Quality indicator 1
—

—
field separator

ASCII
ASCII

1
1

2 0-2 2)

Used satellites 1
—

—
field separator

ASCII
ASCII

2
1

3 don’t care
,

2)

HDOP variable
—

—
field separator

ASCII
ASCII

n
1

n+1 don’t care
,

2)

Antenna altitude variable
—
—
—

meters
field separator
Meters
field separator

ASCII
ASCII
ASCII
ASCII

n
1
1
1

n+3 don’t care
,
M,
,

2)

Geoidal separation variable
—
—
—

meters
field separator
Meters
field separator

ASCII
ASCII
ASCII
ASCII

n
1
1
1

n+3 don’t care
,
M,
,

2)

Age of DGPS data variable
—

seconds
field separator

ASCII
ASCII

n
1

n+1 don’t care
,

2)

DGPS station ID 1 — ASCII 4
1

5 0-1023
,

2)

Checksum —
—

delimiter
—

ASCII
ASCII

* 2)

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Table 17 RMC structure

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address —

—
—

talker identifier
sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
RMC
,

Time 1
1
1
—

HH–hours
MM–minutes
SS–seconds
field separator

ASCII
ASCII
ASCII
ASCII

2
2
1
1

6 0-23
0-59
0-59
,

2)

Data status 1
—

—
field seperator

ASCII
ASCII

1
1

2 A or V
,

Latitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

2
3-n
1

6-n 0-90
0-59.99
,

1)

Hemisphere —
—

North / South
field separator

ASCII
ASCII

1
1

1
1

N or S
,
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Table 17 RMC structure (cont'd.)

BytesDescription Res Units Formats
# Σ

Valid range Note

Longitude 1
variable
—

degrees
minutes
field separator

ASCII
ASCII
ASCII

3
3-n
1

7-n 0-180
0-59.99
,

1)

Hemisphere — East / West ASCII 1 1 E or W

Speed over ground variable
—

knots
field separator

ASCII
ASCII

5-n
1

6-n 0-99.9
,

1)

Course made good variable
—

degrees
field separator

ASCII
ASCII

4-n
1

5-n 0-360.0
,

1)

Date 1
1
1
—

dd-day
mm–month
yy–year
field separator

ASCII
ASCII
ASCII
ASCII

2
2
2
1

7 01-31
01-12
00-99
,

2)

Magnetic variation variable
—
—
—

degrees
field separator
East / West
field separator

ASCII
ASCII
ASCII

n
1
1
1

n+3 -180.0-180.0
,
E or W
,

1)
2)

Checksum —
—

delimiter
—

ASCII
ASCII

* 2)

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Table 18 HDT structure – heading datagram

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address —

—
—

talker identifier
sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
HDT
,

Heading variable
—
—
—

degrees
field separator
true
field separator

ASCII
ASCII
ASCII
ASCII

5-n
1
1
1

8-n 0-360.0
,
T
,

1)

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Table 19 VTG structure – speed datagram

BytesDescription Res Units Formats
# Σ

Valid range Note

Start character — Start of Sentence ASCII 1 1 $
Address —

—
—

talker identifier
sentence formatter
field seperator

ASCII
ASCII
ASCII

2
3
1

6 0–9 and A-Z
RMC
,

True track made
good

variable
—
—
—

degrees
field separator

field separator

ASCII
ASCII
ASCII
ASCII

5-n
1
1
1

8-n 0-360.0
,
T
,

1)
2)
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Table 19 VTG structure – speed datagram (cont'd.)

BytesDescription Res Units Formats
# Σ

Valid range Note

Magnetic track
made good

variable
—
—
—

degrees
field separator

field separator

ASCII
ASCII
ASCII
ASCII

5-n
1
1
1

8-n 0-360.0
,
M
,

1)
2)

Speed, knots variable
—
—
—

knots
field separator

field separator

ASCII
ASCII
ASCII
ASCI

5-n
1
1
1

8-n 0-99.9
,
N
,

1)

Speed, km/ hour variable
—
—
—

km/hour
field separator

field separator

ASCII
ASCII
ASCII
ASCII

5-n
1
1
1

8-n 0-360.0
,
K
,

1)
2)

Termination —
—

Carriage Return
Line Feed

ASCII
ASCII

1
1

2 Dh
Ah

Notes
1 The length depends on the precision available.
2 Optional

The fields are not used by the sub-bottom profiler
See NMEA 0183 manual for description.

CODA navigation string
Only the fixed form of the CODA navigation string outlined below is supported.
Data Description Format Note
Start characters CODA Always CODA in capital

letters
Easting x.x 1)
Northing x.x 1)
Kp x.x 2)
Vessel speed x.x In knots, 3)
Vessel heading x.x 4)
Line name A Maximum 18 characters, 5)
Fix number N 0 - …, 6)
Delay x.x 7)
Time hh:mm:ss 8)
Date dd:mm:yy 8)

Checksum *hh 9)

end of sentence <CR><LF> 0Dh 0Ah
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Note

Unlike standard NMEA datagrams this datagram does not start with a ‘$’ and the fields
are separated by space.

Note

Uncheck Single message packet for the UDP port receiving this datagram.

Notes:
1 CODA must be present and prioritized under NMEA readers/Position priority.
2 Kilometer point Kp is written to field “Kilometer point” in raw/seg y files.

See File formats on page 177.
3 CODA must be present and prioritized under NMEA readers/Speed priority.
4 Used if “Use heading from NMEA readers” is checked (located in the Beam reader)

and CODA is present and prioritized under NMEA readers/Heading priority.
5 Line name is written to the raw/seg y files.

See File formats on page 177.
6 Fix number is written to field “Event mark counter” in raw/seg y files; see section

6.2 . The event marks (fix numbers) will also be marked on the display.
7 Delay is written to field “External delay” in raw/seg y files.

See File formats on page 177.
8 Date and time is not used/stored.
9 The checksum is optional. The checksum is calculated as for NMEA datagrams,

except also the first character is included in the checksum.

Attitude data
Attitude data is accepted as roll, pitch, heave and heading on one serial port labelled
Attitude at the bottom plate of the transceiver unit.
The data update rate should be as for the multibeams (typically 100 Hz).
The accepted format is a 10 byte long message originally defined in the EM 1000 for use
with digital motion sensors. It is supported by the following sensors:
• Applied Analytics POS/MV
• Photokinetics Octans
• Seatex MRU
• Seatex SeaPath
• TSS DMS-05
The serial line set-up must be 19200 baud, 8 data bits, 1 stop bit, no parity.
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EM Attitude input format
(From the EM Series Datagram formats)
The EM attitude format is a 10-bytes long message defined as follows:
• Byte 1: Sync byte 1 = 00h, or Sensor status = 90h-AFh
• Byte 2: Sync byte 2 = 90h
• Byte 3: Roll LSB
• Byte 4: Roll MSB
• Byte 5: Pitch LSB
• Byte 6: Pitch MSB
• Byte 7: Heave LSB
• Byte 8: Heave MSB
• Byte 9: Heading LSB
• Byte 10: Heading MSB
where LSB = least significant byte, MSB = most significant byte.
All data are in 2’s complement binary, with 0.01_ resolution for roll, pitch and heading,
and 1 cm resolution for heave.
• Roll is positive with port side up with ±179.99° valid range
• Pitch is positive with bow up with ±179.99° valid range
• Heave is positive up with ±9.99 m valid range
• Heading is positive clockwise with 0 to 359.99° valid range.
Non-valid data are assumed when a value is outside the valid range.
How roll is assumed to be measured is operator selectable, either with respect to the
horizontal plane (the Hippy 120 or TSS convention) or to the plane tilted by the given
pitch angle (i.e. as a rotation angle around the pitch tilted forward pointing x-axis). The
latter convention (called Tate-Bryant in the POS/MV documentation) is used inside the
system in all data displays and in logged data (a transformation is applied if the roll
is given with respect to the horizontal).
Note that heave is displayed and logged as positive downwards (the sign is changed)
including roll and pitch induced lever arm translation to the system’s transmit transducer.
This format has previously been used with the EM 950 and the EM 1000 with the first
synchronisation byte always assumed to be zero. The sensor manufacturers have been
requested to include sensor status in the format using the first synchronisation byte
for this purpose. It is thus assumed that:
• 90h in the first byte indicates a valid measurements with full accuracy
• any value from 91h to 99h indicates valid data with reduced accuracy (decreasing

accuracy with increasing number)
• any value from 9Ah to 9Fh indicates non-valid data but normal operation (for example

configuration or calibration mode)
• and any value from A0h to AFh indicates a sensor error status
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Depth – bottom – slope and sound velocity
data
When operating the SBP 27, it is a great advantage to have external depth input form a
hydrographic echosounder. This input can be used by the operator SW to automatically
position the acquisition window which is necessary when the depth changes. See the
operator manual for details. The depth information can be received in either the SRV or
the DPT format described below.

The multibeams calculate the slopes of the seafloor along track. If desired, the operator
may choose to use this information to obtain normal incidence of the beams. Information
about the bottom slopes are included in the SRV datagram.

The soft ware for the SBP 27 does not perform ray-tracing. For a vertical beam, the
knowledge of the average sound velocity is sufficient for depth calculation. For tilted
receiver beams, the operator specified tilt is the angle of the beam relative to the vertical
at the sea floor. In order to achieve this, we need to know the sound velocity by the
seafloor and the sound velocity at the transducer face. The three sound velocities
mentioned here are given to the SBP 27 by an EM sounder in the SRV datagram.

SRV format

The SBP 27 was originally designed to work together with the EM 122/302, but this
datagram may now be generated by any EM sounder, which is useful in shallow water.
The SRV datagram contains the information listed in the table below:
Data Description Format Note
Start identifier $
Talker identifier, two characters
(KS=Kongsberg Simrad)

aa

Datagram identifier string (Slope, Range,
Velocity)

SRV,

bottom slope alongship [°] BSX=x.x, 1)

bottom slope acrosstrack [°] BSY=x.x, 1)

quality estimate factor[%] QEF=x.x 1)

bottom incidence range re reference point
[ms]

BIR=x.x, 2)

normal incidence range re reference point
[ms]

NIR=x.x,

speed of sound at transducer [m/s] SST=x.x 3)

average speed of sound in water column
[m/s]

SSA=x.x 4)

speed of sound at bottom [m/s] SSB=x.x 5)

Source of SRV information EMX=x- -x 6)

duration of EM transmission [s] EMD=x.x

Checksum *hh

end of sentence <CR><LF>
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Notes:
1 The bottom slope angles are calculated by fitting EM 122/302 data to a plane. The

quality factor QEF is (100 times the standard deviation of the distance between the
detections and the plane) / (bottom incidence range in meters), meaning that if the
data fit the plane perfectly – a very unlikely event – the QEF will be zero. If the
standard deviation is 2 meters and the depth straight down is 200 meters, the QEF =
0.01 = 1.0 %. That is: The lower the QEF, the more reliable are the bottom slope
angles. Note: The detections used are from within a fan of limited width centered
about the vertical. A few pings are needed, the ship must be moving, and EM
122/302 must have information about position in order to calculate the bottom slopes

2 When the automatic adjustment of acquisition window feature is enabled (checkbox
”Calculate delay from depth” on the runtime parameter sheet (found under ”System
setup” located in the tab ”System” in the property area of the OPU sw)), BIR is used
to position the acquisition window according to the parameter ”Bottom screen
position [%]” that is set on the runtime parameters sheet. Note that the ”Delay
hysteresis parameter [ms]”, that is used to prevent the SBP 27 from adjusting the
acquisition delay for every little change in bottom incidence range, should be
somewhat smaller than ”acquisition window” x ”Bottom screen position [%]” / 100
in order for this automatic feature to behave properly.

3 Used for steering of the beams.
4 Used to convert range in [seconds] to range in [meters] and vice versa wherever

necessary.
5 Used for steering of the RX beams. Together with speed of sound at transducer, this

parameter is used in the RX beamformer to get a desired angle of incidence on
the seafloor.

6 SIS can generate SRV messages based on data from any EM sounder, thus valid
values of EMX are i.e. 120, 122, 710, 302

DPT format
Data Description Format Valid range Note
Start identifier = $ Always 24h – –

Talker identifier aa Capital letters –

Sentence formatter Always DPT, – –

Depth in meters from the
transducer

x.x, 0.1 - –

Offset of transducer from
waterline in meters

x.x, 0 - 1

Maximum range scale in
use

x.x – –

Checksum *hh – –

End of sentence delimiter
= CRLF

Always 0Dh 0Ah – –

Notes
1 A negative value implies that the offset is from the keel should not be used.
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Remote control datagram
Partial support for the remote control datagram defined for the EM has been added.
To enable use of remote control datagrams, the checkbox External play control located in
the NMEA parameter sheet must be checked.
The table below summarized the supported fields.
Data Description Format Note
Start identifier $
Talker identifier, two characters , (e.g.
KM=Kongsberg Maritime)

Aa

Datagram identifier string Rxx, 1)

Job name (survey Identifier) SID=aaaaa, Maximum 20 characters

Line name / line number PLL=aaaaa, Maximum 18 characters

Checksum *hh 2)

end of sentence <CR><LF> 0Dh 0Ah

Caution
The NMEA reader used for reception of these datagrams must be configured
so that it does not time out during operation. One or more datagrams will be
lost after a timeout.
The timeout of an NMEA reader is specified in milliseconds; a value of 0
means it will never time out.

1 Rxx defines what action the system is to take with respect to pinging and logging
• R00: System to stop pinging and stop logging
• R10: System to start or continue pinging and stop logging
Note

The system will start pinging in mode Normal. If an R10 is received while
pinging in Burst mode, the system will switch to pinging in Normal mode

• R12 System to start logging
Note
– To enable logging, checkbox External raw logging and optionally checkbox

External pro logging must be checked. They are located in the NMEA readers
parameter sheet.

– To activate pinging and logging, always send R10 before R12 (since R10
will stop logging).

– For logging to start without any user interaction (i.e. no dialogue box will
pop up when R12 is received) the data loggers must be configured to Always
use selected directory.
* see for instance Processed data logger on page 120

2 The checksum is calculated as for standard NMEA datagrams.
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Kongsberg SBP 27

A
About, 75
About this manual, 9
AGC, 77
Application window, 18
Array geometry, 171
Attitude compensation, 172
Attribute calculation, 160
Attribute processing, 75
Audio, 76
Automatic gain control, 77

B
Bandpass filtering, 157
Beam reader, 78
BIST, 39
Bottom filter, 80
Bottom slope corrections, 172
Bottom tracker, 80
Built-in test, 143
built-in tests, 39
Burst mode and external
trigger, 167
Burst mode and internal
trigger, 168

C
Calculate delay from depth, 170
Chirp signals, 175
Hyperbolic chirp up, 175
Linear chirp up/down, 175

Configuration files
Operation, 36

Convert buttons, 81
Convert mode, 17
Buttons, 81

Converter filter, 95
Coordinate selector, 82

D
Data plotter, 84
Data selector, 58
Depth from bottom
tracker, 85
Depth from NMEA, 85
Depth selector, 86
Sound speed from
NMEA reader, 138

Datagram formats, 186
Datagram repeater, 83
Deconvolution, 158
Depth from bottom tracker, 85
Depth from NMEA, 85
Depth selector, 86, 171
Dereverberation, 87

description, 10
Digital signal processing, 157
Display, 28
Echogram, 63, 88
Legend, 101
Single trace, 137

Display tab, 62

E
Echogram, 63
Adjust to current trace
length, 64
Adjust to current
window, 63
Bottom lock, 65
Convert buttons, 81
Displaying two
echograms, 66
Keyboard and mouse, 66
Zoom buttons, 149

Echogram dialog, 88
Exit, 91

F
File conversion, 47
File converter, 59
Converter filter, 95

File format, 177
raw file format, 177
SEG Y file format, 180

File length, 72
File menu, 51
Load installation, 103
Load settings, 102
Save configuration, 136
Save installation, 137

File reader, 92
File writer, 93
Filters, 95
Footprints, 172
Format
datagram, 186
raw file format, 177
SEG Y file format, 180

G
Gain, 96
Gain correction, 98

I
Installation parameters, 99
Instantaneous amplitude, 161
Instantaneous frequency, 161
Instantaneous phase, 161

K
Keyboard and mouse, 66

L
Legend, 70, 101
Load installation, 103
Load settings, 102
Logging data, 35

M
Main operational modes, 162
Multiple receiver beams, 172
Mute, 104

N
Network configuration, 104
NMEA reader 1 to 5, 110
NMEA readers, 107
Non-chirp signals, 174
CW pulse, 174
No pulse, 174
Ricker pulse, 174

Normal mode and external
trigger, 166
Normal mode and internal
trigger, 164–165

O
online monitor, 150
operation
system tests, 39

Operation, 16
Attitude, 32
Basic operation, 33
Configuration files, 36
Convert raw data file, 47
Display, 28
Echogram, 28
External inputs, 32
Installation parameters, 23
Legend, 31
Load configuration, 22
Log on, 20
Logging data, 35
Modes, 17
NMEA readers, 32
Principles, 17
Processing chain, 26, 37
Real-time processing, 26
Run the survey, 34
Runtime parameters, 23
Shut down, 34
Software updates, 37
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SRV datagram, 33
Start, 19
Start pinging, 33
System tests, 22

P
Parameters, 68
Ping number, 72
Printer, 112
Printer configuration, 116
Process writer, 119
Processed data logger, 120
Processing chain, 26, 37, 123
Processing tab, 60
Attribute, 75
Audio, 76
Automatic gain control, 77
Bottom tracker, 80
Data plotter, 84
Dereverberation, 87
Filters, 95
Gain, 96
Gain correction, 98
Mute, 104
Processed data logger, 120
Stacking, 139
Swell filter, 141
Synthetic aperture
processing, 142
Time variable filter, 144
Time variable gain, 145

Property area, 67
Pulse shape parameters, 176

R
Raw data filters, 95
Raw data logger, 124
Raw file format, 177
Readers and writers, 57
Beam reader, 78
Datagram repeater, 83
NMEA reader 1 to 5, 110
NMEA readers, 107
Process writer, 119
Raw data filters, 95
Raw data logger, 124
Repeat reader, 126
Repeat writer, 127
Replay reader, 129

Repeat reader, 126
Repeat writer, 127
Replay buttons, 128
Replay mode, 17
Buttons, 128

Replay reader, 129
Restart, 129

Root, 130
Root user, 60
Rough terrain, 172
Runtime parameters, 131

S
SAS, 142
Save configuration, 136
Save installation, 137
SEG Y file format, 180
Signal envelope, 176
Single trace, 71, 137
Slave buttons, 138
Slave mode, 17
Buttons, 138

Software updates, 37
Sound speed from NMEA
reader, 138
Sound speed selector, 139
SRV datagram, 33
Stacking, 139, 159
Status area, 72
Summary tab, 62, 140
Super, 140
Survey buttons, 141
Survey mode, 17
Buttons, 141

Swell filter, 141
Swell filtering, 160
Synchronization modes, 162
Synthetic aperture
processing, 142
system description, 10
System operation array, 171
System tab, 56
Built-in test, 143
Built—in system tests, 57
Data selector, 85–86
Data selectors, 58
File converter, 59
File reader, 92
File writer, 93
Installation parameters, 99
Network configuration, 104
Printers, 60
Readers and writers, 57
Root user, 60
Runtime parameters, 131
Sound speedselector, 139
System setup, 57
TRU detect, 146

system tests, 39
CPU card test, 41
HD8 card test, 42
High voltage power test, 43
Motion Reference Unit
test, 45

MRU test, 45
MSP CPU card test, 41
Receiver noise test, 44
SIHD8 card test, 42
software version, 40
System Report, 46
Test reply, 46

T
Tab menu, 53
Technical reference, 157
Digital signal
processing, 157
file format, 177
Main operational modes, 162
System operation array, 171
Transmit waveforms, 174

Test, 143
Time variable filter, 144
Time variable gain, 145
Title bar, 62
Topics, 145
Transmit modes, 162
TRU detect, 146
TVF, 144
TVG, 145

U
User, 147
Root, 130
Super, 140

V
Variable gain functions, 159
View echogram area, 147
View legend area, 147
View menu, 52
Vertical split, 147
View echogram area, 147
View legend area, 147
View property area, 148
View single trace, 148
View status area, 148
View survey warnings, 148
View system messages, 149

View property area, 148
View single trace, 148
View status area, 148
View survey warnings, 148
View system messages, 149

Z
Zoom buttons, 149
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